Dear Reader,

Thank you for choosing *Autodesk Revit Architecture 2014 Essentials*. This book is part of a family of premium-quality Sybex books, all of which are written by outstanding authors who combine practical experience with a gift for teaching.

Sybex was founded in 1976. More than 30 years later, we’re still committed to producing consistently exceptional books. With each of our titles, we’re working hard to set a new standard for the industry. From the paper we print on, to the authors we work with, our goal is to bring you the best books available.

I hope you see all that reflected in these pages. I’d be very interested to hear your comments and get your feedback on how we’re doing. Feel free to let me know what you think about this or any other Sybex book by sending me an email at nedde@wiley.com. If you think you’ve found a technical error in this book, please visit http://sybex.custhelp.com. Customer feedback is critical to our efforts at Sybex.

Best regards,

Neil Edde
Vice President and Publisher
Sybex, an Imprint of Wiley
For Stacey, Lucely, and Nathaniel.
—Ryan

For my family, thank you for supporting me.
—Tobias

For Thad, Tabitha, and Thatcher—the other Ts.
—Tessa
About the Authors

**Ryan Duell** is a senior quality assurance analyst for Revit at Autodesk. He holds a bachelor's degree in design computing from the Boston Architectural Center. He started his career with cbt Architects in Boston, Massachusetts, working on a variety of project teams ranging from single-family residential to large commercial projects. Ryan eventually moved into the BIM manager role focusing on managing AutoCAD Architecture and Revit Architecture standards, along with contributing on projects as needed. At Autodesk he spent several years in the product support organization working with Revit. In addition to Autodesk, Ryan teaches Revit at the Boston Architectural College and contributes to the Revit Clinic blog.

**Tobias Hathorn** is a licensed architect and user experience designer for Autodesk Revit. He holds a bachelor's degree in architecture from Kansas State University. He started his career at BNIM architects in Kansas City, Missouri, working on a 1 million square-foot IRS paper-processing center in Revit Architecture. After working as a liaison between BNIM and Moshe Safdie and Associates on the Kansas City Performing Arts Center, Tobias moved to Boston to join the Revit product team in Waltham, Massachusetts. Tobias has honed his knowledge and experience with Revit, especially the graphics and rendering features, over the past six years in the quality assurance and product design groups. In his free time, he likes to teach Revit Architecture at the Boston Architectural College, bicycle, paint, and play Tetris.

**Tessa Reist Hathorn** is a licensed architect and a LEED Accredited Professional with eight years of experience in architecture using Revit. After starting her career at BNIM Architects working on historic renovations and the renowned Kauffman Center for the Performing Arts, she eventually moved to Boston, Massachusetts, to work with Moshe Safdie and Associates, working on high-profile international projects. Tessa currently works in the Boston area at Austin Architects where she helps implement BIM in her office. She also teaches Revit Architecture at the Boston Architectural College and is looking forward to becoming a mom this spring.
Acknowledgments

The thought of creating a list of acknowledgments was daunting to me; there would be no way to cover the scope of importance in the amount of space I have. With that in mind, I first need to thank Autodesk. I appreciate the unique view and access I have to Revit and the amazingly talented people I have the opportunity to work with every day. I need to thank my supportive wife and family, who have always been there along the way of my often demanding day and night activities. And Wiley, this book would never have been possible without your talented staff, editing, and support, so thank you. I also want to thank Tobias and Tessa for the opportunity to coauthor this book.

—Ryan

I’d like to acknowledge some of the individuals who have influenced me in such a way as to make my participation in this book possible. Thanks to Uncle Jim, for those wooden blocks. Thanks to Michael Holtz, for fostering a young designer. Thanks to Shawn Gehle, for introducing me to Form-Z as a college student. Thanks to BNIM, for a forward-looking approach to design documentation. Thanks to Phil Read, for my first Revit Architecture training. Thanks to Eddy Krygiel, for being an advocate and mentor. Thanks to Tatjana Dzambazova, for being a generous connector. Thanks to Steve Crotty and the Revit QA staff, for my second Revit training. Thanks to Frame Demchak, for inviting me into the software design flow state. Thanks to the Revit UX group, for my third Revit training. Thanks to Wiley, for making sure this book happened. Thanks to Ryan, for the solid work. Thanks to Tessa, for everything.

—Tobias

I’d first like to thank the creative team at Autodesk Revit. Because of their software and its ability to document architecture in a fun and forward-thinking manner, I am still an architect. Thank you to BNIM for my first exposure to the software, especially to Eddy Krygiel for taking me under his wing and mentoring me toward licensure. Thank you to my current employer, Austin Architects, for trusting my skills and letting me run with them. Thank you to my co-writers, the talented Ryan and my dear Tobias. Thanks also to our technical editor, Heather Lech, for being a critical eye and trudging through our rough first drafts. And an enormous thanks to our team at Wiley—Alexa Murphy, Rebecca Anderson, and especially Willem—for making everything behind the scenes happen.

—Tessa
## Contents at a Glance

*Foreword*  
*Introduction*  

<table>
<thead>
<tr>
<th>CHAPTER</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introducing the Autodesk Revit Architecture Interface</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>Walls and Curtain Walls</td>
<td>31</td>
</tr>
<tr>
<td>3</td>
<td>Floors, Roofs, and Ceilings</td>
<td>67</td>
</tr>
<tr>
<td>4</td>
<td>Stairs, Ramps, and Railings</td>
<td>99</td>
</tr>
<tr>
<td>5</td>
<td>Adding Families</td>
<td>125</td>
</tr>
<tr>
<td>6</td>
<td>Modifying Families</td>
<td>143</td>
</tr>
<tr>
<td>7</td>
<td>Schematic Design</td>
<td>181</td>
</tr>
<tr>
<td>8</td>
<td>Rooms and Color-Fill Plans</td>
<td>209</td>
</tr>
<tr>
<td>9</td>
<td>Materials, Rendering, and Visualization</td>
<td>227</td>
</tr>
<tr>
<td>10</td>
<td>Worksharing</td>
<td>243</td>
</tr>
<tr>
<td>11</td>
<td>Details and Annotations</td>
<td>267</td>
</tr>
<tr>
<td>12</td>
<td>Creating Drawing Sets</td>
<td>297</td>
</tr>
<tr>
<td>13</td>
<td>Workflow and Site Modeling</td>
<td>329</td>
</tr>
<tr>
<td>14</td>
<td>Repeating Objects, Best Practices, and Quick Tips</td>
<td>349</td>
</tr>
</tbody>
</table>

*Appendix*  

*Index*
Contents

Attaching and Detaching the Top and Base . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
Resetting Profiles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Cutting Openings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Splitting Walls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Swapping Walls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
Creating Curtain Walls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Curtain Grids . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
Adding Mullions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Embedding Curtain Walls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Modifying Curtain Walls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Editing the Elevation Profile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Adding and Modifying Grids and Mullions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
Unpinning and Toggling Mullions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
Modifying Curtain-Grid Segments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
Modifying Curtain Panels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
Going Beyond the Basics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
The Essentials and Beyond . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

Chapter 3
Floors, Roofs, and Ceilings

Creating Floors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
Sketching . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
Editing the Boundary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Creating Sloped Arrows and Floors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
Creating Sloped Floors via Shape Editing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
Creating Openings by Sketching . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
Creating Openings with Shafts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
Picking Walls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
Laying Out Roofs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
Picking Walls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
Creating Slope Arrows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Creating Extruded Roofs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86
Adding Ceilings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89
Creating Automatic Ceilings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
Sketching Ceilings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
Dealing with Bulkhead Conditions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
Adding Lights and Rotating the Grid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96
Changing the Ceiling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
Sloping the Ceiling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
The Essentials and Beyond . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
## Chapter 4  Stairs, Ramps, and Railings

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating Stair Configurations</td>
<td>99</td>
</tr>
<tr>
<td>Creating the Generic Railing</td>
<td>100</td>
</tr>
<tr>
<td>Creating Your Design Stair</td>
<td>103</td>
</tr>
<tr>
<td>Creating a Straight-Run Stair</td>
<td>104</td>
</tr>
<tr>
<td>Creating a Straight-Run Stair with Landing</td>
<td>107</td>
</tr>
<tr>
<td>Creating Multistory Runs</td>
<td>110</td>
</tr>
<tr>
<td>Setting the Host Function for Railings</td>
<td>112</td>
</tr>
<tr>
<td>Designing Ramps</td>
<td>114</td>
</tr>
<tr>
<td>Creating a Straight-Run Ramp</td>
<td>115</td>
</tr>
<tr>
<td>Editing Boundary Conditions</td>
<td>116</td>
</tr>
<tr>
<td>Building Railings for Level and Sloped Conditions</td>
<td>118</td>
</tr>
<tr>
<td>Using the Set Host Function</td>
<td>120</td>
</tr>
<tr>
<td>Editing the Top Rail</td>
<td>121</td>
</tr>
<tr>
<td>From Basics to Creative Art</td>
<td>121</td>
</tr>
<tr>
<td>The Essentials and Beyond</td>
<td>123</td>
</tr>
</tbody>
</table>

## Chapter 5  Adding Families

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding the Model Hierarchy</td>
<td>125</td>
</tr>
<tr>
<td>Assigning Families to Categories</td>
<td>127</td>
</tr>
<tr>
<td>Working with System Families</td>
<td>130</td>
</tr>
<tr>
<td>Loading System Families</td>
<td>130</td>
</tr>
<tr>
<td>Placing System Families</td>
<td>131</td>
</tr>
<tr>
<td>Working with Component Families</td>
<td>132</td>
</tr>
<tr>
<td>Loading Component Families</td>
<td>133</td>
</tr>
<tr>
<td>Using Hosted Families</td>
<td>134</td>
</tr>
<tr>
<td>Using Face-Based Families</td>
<td>138</td>
</tr>
<tr>
<td>Using In-Place Component Families</td>
<td>139</td>
</tr>
<tr>
<td>Finding Content</td>
<td>139</td>
</tr>
<tr>
<td>The Essentials and Beyond</td>
<td>141</td>
</tr>
</tbody>
</table>

## Chapter 6  Modifying Families

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Editing View Display and Detail Level</td>
<td>143</td>
</tr>
<tr>
<td>View Scale and Detail Level</td>
<td>145</td>
</tr>
<tr>
<td>Level of Detail</td>
<td>148</td>
</tr>
<tr>
<td>Changing the Family Category</td>
<td>151</td>
</tr>
<tr>
<td>Editing the Family Category</td>
<td>152</td>
</tr>
<tr>
<td>Editing the Insertion Point</td>
<td>153</td>
</tr>
</tbody>
</table>
## Contents

Modifying Family Geometry ........................................... 158
Editing the Family ..................................................... 158
Editing Profiles ......................................................... 159
Detail Components .................................................... 163
Repeating Details ....................................................... 167
Title Blocks ............................................................... 168
Hosted Components .................................................... 172
Family Tips and Best Practices ...................................... 177
The Essentials and Beyond .......................................... 179

### Chapter 7  
**Schematic Design**  

Working from a Sketch .................................................. 181
Importing Background Images ........................................ 183
Accurately Scaling Images ............................................ 184
Using Reference Planes and Levels ................................ 186
Creating and Placing Groups ......................................... 190
Modeling In-Place Masses ............................................. 193
Modeling the Base Mass ............................................... 193
Modeling the Middle Mass ............................................ 195
Modeling the Upper Mass ............................................. 197
Working in 3D ............................................................. 198
Creating Mass Floors ................................................... 202
Scheduling Mass Floors ................................................ 203
Updating the Massing Study .......................................... 206
The Essentials and Beyond .......................................... 208

### Chapter 8  
**Rooms and Color-Fill Plans**  

Defining Rooms in Spaces ............................................ 209
Room Tags ................................................................. 210
Room Boundaries ....................................................... 213
Room Separation Lines ............................................... 215
Deleting Rooms .......................................................... 217
Generating Color-Fill Room Plans ................................... 219
Adding a Color Legend ................................................ 219
Modifying Color Schemes ............................................. 221
Adding Tags and Fill Colors in Section ............................. 222
The Essentials and Beyond .......................................... 225

### Chapter 9  
**Materials, Rendering, and Visualization**  

Using Materials .......................................................... 228
Editing Material Properties of Walls ................................. 228
Chapter 10  
Worksharing  
Enabling Worksharing  
Preparing the Central File  
Creating Central and Local Files  
Creating the Central File  
Creating the Local File  
Adding Worksets  
Workset Visibility  
Assigning Elements to Worksets  
Saving to the Central File  
Creating New Elements  
Opening and Closing Worksets  
Worksharing Display Modes  
Editing Requests  
Worksharing Best Practices  
The Essentials and Beyond  

Chapter 11  
Details and Annotations  
Creating Details  
Detail Line  
Region  
Component  
Creating a Detail  
Insulation  
Detail Groups  
Linework  
Annotating Your Details  
Dimensions  
Tags  
Text  
Using Legends  
The Essentials and Beyond  

CHAPTER 12 Creating Drawing Sets 297
Creating Schedules ......................................................... 297
Understanding Schedules ................................................. 298
Making Schedules .......................................................... 305
Creating a Window Schedule ............................................. 305
Creating a Room Schedule ............................................... 307
Creating a Sheet List ....................................................... 309
Placing Views on Sheets ................................................... 313
Adding Floor Plans to the Sheet ......................................... 313
Adding the Schedules ...................................................... 319
Printing Documents ....................................................... 321
Exploring the Print Dialog Box ........................................... 321
Exploring the Print Settings ................................................ 322
Exploring the Print Range ................................................ 325
The Essentials and Beyond ................................................. 327

CHAPTER 13 Workflow and Site Modeling 329
Understanding a BIM Workflow .......................................... 329
Staffing a BIM Project ..................................................... 332
Project Roles Using Revit Architecture ................................. 332
Adding Team Members to Fight Fires .................................. 336
Modeling a Site ............................................................. 337
Using a Toposurface ........................................................ 338
Creating a Building Pad .................................................... 340
Performing Quality Control on Your Model .......................... 342
Keeping an Eye on File Size ............................................... 342
Dealing with Warnings .................................................... 345
The Essentials and Beyond ................................................. 347

CHAPTER 14 Repeating Objects, Best Practices, and Quick Tips 349
Repeating Objects .......................................................... 349
Optimizing Performance .................................................... 352
Utilizing Best Practices ..................................................... 355
Using Quick Tips and Shortcuts .......................................... 359
Finding Additional Resources ............................................ 365
The Essentials and Beyond ................................................. 366

Appendix: Autodesk Revit Architecture 2014 Certification ............ 367

Index ................................................................................. 377
Foreword

Congratulations!

You are beginning your foray into the world of Autodesk® Revit® Architecture and building information modeling (BIM)!

My original journey into BIM began like most, with a large project commission mandating the use of BIM in architecture. In the months and years that followed, I witnessed the benefits an architectural team could leverage well beyond simply meeting requirements and then delved into full project team collaboration and coordination after spending time using each of the BIM platforms available to us in the industry. When I finally landed on using and mastering Autodesk Revit Architecture, I began to understand that the implications of each tool’s use in a program can reach far downstream in the construction process and that a successful and well-thought-out implementation can affect everyone on a building project: owner, architect, engineer, contractor, and so on, right down to each member of a subcontractor’s team. It was with this knowledge that I found my current niche, handling the Revit Architecture implementation for an integrated design/build architecture and construction company, the Beck Group. Here I spend each day looking for more ways to leverage Revit Architecture in design, analysis, construction, procurement, fabrication, installation, and occupation.
When I was learning Revit Architecture in my first office, there were no BIM managers, training courses, or wealth of seasoned users to turn to with questions about strategies and implications. Instead, we leaned heavily on the Internet Revit Architecture communities, learning from other veteran users and their experiences and building and teaching one another through online forums.

As you begin this learning process, keep in mind that your skill set and level of usage complexity will increase as the challenges present themselves and that the correct techniques might not always be obvious on your first attempt. Learning what methods are the most beneficial to you is sometimes about failing more than succeeding because you will remember what you weren’t satisfied with.

My first Revit Architecture project was a multiphase renovation, in version 8.1 (2006). As I focused on learning about worksharing and detailing, I hadn’t yet ventured into assigning real materials with render appearances to the model. There were components made that simply had symbolic lines in the plans, while I learned about the Family Editor from the AUGI forums. (Truth be told, by the third phase we had learned so much we decided to completely rebuild the model!)

A short time later, I began to understand the importance of custom content and the power of the Revit Architecture Family Editor. The first parametric family I made was a skylight (a photo sits on my desk still), and with it came the immediate realization that I would want to carefully plan out and organize an office library.
Rest assured, this library originally started off as modified content that shipped with Autodesk Revit Architecture. As the days went on, one by one my semi-custom content was edited on the fly, during real billable projects. Eventually I would need something highly custom, and I would create a new ‘group’ of families, furthering the level of the modeling. As you develop your custom content, however, always focus on delivering the best information strategically, for producing the best building. It isn’t about creating the most intricate 3D model.

A year later I was slowly adding to the library, tweaking the project template with each lesson learned on a project. Doing interior design in Revit Architecture? Have filters set up for finishes. Modeling a lot of custom millwork? Learn to use very simple (but flexible) line-based families.

The most important thing I learned (as I got in to more complex projects) is that consistency is the key. A lot of times you won’t pick the best method the first time you try something, but keeping the process consistent means team members are able to dissect what each other has done. Remember that—in the modeled world—the end “shape” is important, but so is how you got to that shape. Predictability will allow each of your colleagues to edit efficiently and move quickly.
As the complexities in design and level of detail desired in models advanced, I became a fan of the “think first, think together” philosophy. When an important modeling decision needs to be made, have the right people present, but have the whole team there. Pick the direction, and go with it. That way, as a project (and project team) grows, no one is relearning how to edit things that are similar on different parts of the project.

The benefits of consistency and simplicity multiplied once I found myself immersed in the world of both design and construction. A predictable approach meant fabricators and estimators could dive into design models and leverage the data and/or geometry they needed to further our initiative downstream.

With that, I find myself at the Beck Group, watching Revit Architecture models used on a day-to-day basis for not only architectural design but also for model-based field layout by subcontractors, shop drawing production from model data by collaborators, sequencing and scheduling by automated data associations in Revit Architecture parameter fields, and so on.
Whether your goal is to deliver a design and documentation project on time and on budget or to reach beyond and watch the model become the deliverable of the future, Autodesk Revit Architecture can take you there, with the tutelage of the experienced user base behind you.

With *Revit Architecture 2014 Essentials*, you will now benefit from learning this software from people who are immersed in it every day, and you will learn not just the commands and the tools but the reasons (not rules) of why each tool benefits you and when. This book has information that can't be learned from an instruction manual but only from seasoned users working in the industry who are putting this software to the test on a daily basis. There are times in all applications when the best solution isn't always the obvious one, and learning from the experienced users who wrote this book is your key to opening those doors.
Our industry finds itself in precarious yet exciting times, with slim margins and tough competition making design and construction difficult but also presenting new opportunities: to innovate, to collaborate, and to restore efficiencies that the current market and economic climate now mandate. This is your opportunity to be part of (and influence) meaningful change.

As you embark on this journey, remember the goal. At Beck, we call it “Better Buildings, Better Built.” As you jump into Revit Architecture and BIM, remember that it’s not about documenting design the way you always have; it’s about documenting design for better buildings. Keep that in mind, leverage this great book, and join us in the Revit Architecture community online!

Good luck with your practice!

Aaron Maller
BIM manager, the Beck Group
Dallas, Texas

Twitter: @twiceroadsfool
**Introduction**


We have shaped the focus and content of this book from our diverse experience as Revit Architecture teachers, Revit Architecture users, Revit Architecture customer support and Revit Architecture designers. We have tailored the content to what we think is the most valuable combination of topics. Because we teach Revit Architecture, we feel the included content is of most value to our students learning the program for the first time. This book should benefit new Revit Architecture users, as well as long-term users who may not use every aspect of the program on a daily basis.

Revit Architecture 2014 includes a number of valuable new tools. While each tool may not be considered “essential,” we have made an effort to mix new tools, tips and tricks, and established features into the context of the text. The book follows real-life workflows and scenarios and is full of practical examples that explain how to leverage the tools within Revit Architecture. We hope you’ll agree that we’ve succeeded.

**Who Should Read This Book**

This book is written for architects, designers, students, and anyone else who needs their first exposure to Revit Architecture or has had an initial introduction and wants a refresher on the program's core features and functionality. We've designed the book to follow real project workflows and processes to help make the tools easy to follow, and the chapters are full of handy tips to make Revit Architecture easy to leverage. This book can also be used to help prepare for Autodesk's Certified User and Certified Professional exams. For more information on certification, please visit [www.autodesk.com/certification](http://www.autodesk.com/certification).

**What You Will Learn**

This book is designed to help you grasp the basics of Revit Architecture using real-world examples and techniques you'll use in everyday design and documentation. We'll explain the Revit Architecture interface and help you find the tools you need as well as help you understand how the application is structured. From there we'll show you how to create and modify the primary components in a
building design. We’ll show you how to take a preliminary model and add layers of intelligence to help analyze and augment your designs. We’ll demonstrate how to create robust and accurate documentation and then guide you through the construction process.

As you are already aware, BIM is more than just a change in software; it’s a change in architectural workflow and culture. To take full advantage of both BIM and Revit Architecture in your office structure, you’ll have to make some changes to your practice. We’ve designed the book around an ideal, integrated workflow to aid in this transition.

Once you’ve mastered the content in each chapter, you’ll find a section called “The Essentials and Beyond” where you can continue to hone your skills by taking on more challenging exercises.

**What You Will See**

For Revit Architecture 2014, there are two flavors of Revit: the first is a “one-box” solution that has Revit Architecture, Structure, and MEP inside the same application, and the second is the Revit Architecture software you may be used to using. There are some small differences between the applications, but the majority of the user interface is the same.

We want you to be aware that we have based the book and the screen captures on Revit, the combined version. If you notice those small differences, we apologize, but it would be very confusing to base the book on both applications noting all the small differences along the way. However, whichever version you have, you’ll still be able to follow the lessons in the chapters of this book with ease.

**What You Need**

To leverage the full capacity of this book, we highly recommend you have a copy of Revit Architecture installed on a computer strong enough to handle it. To download the trial version of Revit Architecture, go to [www.autodesk.com/revitarchitecture](http://www.autodesk.com/revitarchitecture), where you’ll also find complete system requirements for running Revit Architecture.

From a software standpoint, the exercises in this book are designed to be lightweight and not computationally intensive. This way, you avoid long wait times to open and save files and perform certain tasks. That said, keep in mind that the Autodesk-recommended computer specs for Revit Architecture are far more than what you need to do the exercises in this book but are *exactly* what you need to work on a project using Revit Architecture.
Free Autodesk Software for Students and Educators

The Autodesk Education Community is an online resource with more than five million members that enables educators and students to download—for free (see website for terms and conditions)—the same software used by professionals worldwide. You can also access additional tools and materials to help you design, visualize, and simulate ideas. Connect with other learners to stay current with the latest industry trends and get the most out of your designs. Get started today at www.autodesk.com/joinedu.

What Is Covered in This Book

Revit Architecture is a building information modeling (BIM) application that has quickly emerged as the forerunner in the design industry. Revit Architecture is as much a change in workflow (if you come from a 2D or CAD environment) as it is a change in software. In this book, we’ll focus on using real-world workflows and examples to guide you through learning the basics of Revit Architecture 2014—the essentials.

Autodesk Revit Architecture 2014 Essentials is organized to provide you with the knowledge needed to gain experience in many different facets of the software. The book is broken down into the following 14 chapters:

Chapter 1, “Introducing the Autodesk Revit Architecture Interface,” introduces you to the user interface and gets you acquainted with the tools and technology—the workflow—behind the software.

Chapter 2, “Walls and Curtain Walls,” helps you build on that initial learning by establishing some of the basic building blocks in architecture: walls.

Chapter 3, “Floors, Roofs, and Ceilings,” introduces you to the other basic building blocks: floors, roofs, and ceilings. By the end of the first three chapters you will begin to see how easy it is to create the core elements of your building.

Chapter 4, “Stairs, Ramps, and Railings,” explains the basics of stairs, ramps, and railings. These core components are versatile and using them can be a bit tricky, so we’ll guide you through the process of creating several types of stairs and railings.
Chapter 5, “Adding Families,” shows you how to add a core element to your project: families. You use families to create most of your content, and Revit Architecture by default comes with a robust supply.

Chapter 6, “Modifying Families,” shows you how to take these families and modify them or create your own, making the library of your content limitless.

Chapter 7, “Schematic Design,” introduces you to situations that would happen on a real project: say a designer has given you a sketch, and now you need to take this building design and model it in Revit Architecture.

Chapter 8, “Rooms and Color-Fill Plans,” shows you how to add room elements to your spaces, assign information to them, and create colorful diagrams based on space, department, or any other variable you need.

Chapter 9, “Materials, Rendering, and Visualization,” introduces you to visualization tools and techniques. You prepare presentation-quality views of your design in elevation, 3D Axonometric, and perspective views.

Chapter 10, “Worksharing,” discusses how to take your Revit Architecture file into a multiperson working environment. Worksharing allows several people within your office or project team to work on the same Revit Architecture file simultaneously.

Chapter 11, “Details and Annotations,” focuses on adding annotation to explain your designs. You’ll learn how to add detail to your model in the form of dimensions, text, keynotes, and tags, and how to embellish your 3D model with additional detailing.

Chapter 12, “Creating Drawing Sets,” shows you how to take all this information and place those drawings and views onto sheets so they can be printed and distributed to your project stakeholders.

Chapter 13, “Workflow and Site Modeling,” provides the basics on how to take your office from a CAD environment to one that works with BIM. This chapter explores tools for every level of the project team—from the new staff to project managers. Understanding the process and workflow will be key to the success of your first Revit Architecture project.

Chapter 14, “Repeating Objects, Best Practices, and Quick Tips,” covers different approaches to repeat objects throughout your project along with optimizations, best practices, and tips to use along the way.
The Essentials Series

The Essentials series from Sybex provides outstanding instruction for readers who are just beginning to develop their professional skills. Every Essentials book includes these features:

▶ Skill-based instruction with chapters organized around projects rather than abstract concepts or subjects.
▶ Suggestions for additional exercises at the end of each chapter, where you can practice and extend your skills.
▶ Digital files (via download) so you can work through the project tutorials yourself. Please check the book’s web page at www.sybex.com/go/revit2014essentials for the companion downloads.

NOTE Should you choose to browse the book’s companion web page, it will look like a site to purchase the book, which it is. But if you pan down just a bit, you’ll see three gray tabs. The third one is the book’s companion downloads.

Contacting the Authors

We welcome your feedback and comments. You can find the three of us on Facebook at Mastering Revit. We hope you enjoy the book.
Introducing the Autodesk Revit Architecture Interface

After one decade in the architecture, engineering, and construction (AEC) space, the Autodesk® Revit® Architecture software continues to be unique in its holistic building information modeling (BIM) approach to design integration. Sure, there are other BIM-ish tools that allow you to design in 3D. And 10 years ago, 3D might have been a differentiator, but today 3D is a commodity!

Revit Architecture provides the unique ability to design, manage, and document your project information from within a single file — something no other BIM tool allows you to do. Because all your data resides in a single project file, you can work in virtually any view to edit your model — plan, section, elevation, 3D, sheets, details, and even a schedule. To begin the journey in learning Revit Architecture, we’ll help you become comfortable with the user interface and the basic principles of a Revit Architecture project.

In this chapter, you learn the following skills:

▶ Understanding the interface

▶ Understanding the interface workflow

▶ Using common modifying tools
Understanding the Interface

The user interface (UI) of Revit Architecture is similar to other Autodesk products such as the Autodesk® AutoCAD®, Autodesk® Inventor, and Autodesk® 3ds Max® products. You might also notice that it’s similar to Windows-based applications such as Microsoft Word and Mindjet’s MindManager. All of these applications are based on the “ribbon” concept: toolbars are placed on tabs in a tab bar, or ribbon, and are contextually updated based on the content on which you’re working. We’ll cover the most critical aspects of the UI in this section, but we won’t provide an exhaustive review of all toolbars and commands. You’ll gain experience with the common tools as you read the chapters and exercises in this book.

Figure 1.1 shows the Revit Architecture UI. To illustrate some different project views, we’ve tiled four different view windows: plan, elevation, 3D, and camera.

Let’s begin by examining a few important parts of the UI. As you progress through this book, you’ll gradually become more familiar with the other basic parts of the UI.

**Properties Palette**

The Properties palette is a floating palette that can remain open while you work in the model. The palette can be docked on either side of your screen, or it can be moved to a second monitor. You can open the Properties palette in one of three ways.
Click the Properties icon in the Properties panel of the Modify tab in the ribbon.

Select Properties from the right-click context menu.

Press Ctrl+1 on your keyboard, as you would in AutoCAD.

As shown in Figure 1.2, the Properties palette contains the Type Selector at the top of the palette. When you’re placing elements or swapping types of elements you’ve already placed in the model, the palette must be open to access the Type Selector.

When no elements are selected, the Properties palette displays the properties of the active view. If you need to change settings for the current view, simply make the changes in the Properties palette, and the view will be updated. For views, you may not even need to use the Apply button to submit the changes.

Finally, you can also use the Properties palette as a filtering method for selected elements. When you select a large number of disparate objects, the drop-down list below the Type Selector displays the total number of selected elements. Open the
list, and you’ll see the elements listed per category, as shown in Figure 1.3. Select one of the categories to modify the parameters for the respective elements. This is different from the Filter tool in that the entire selection set is maintained, allowing you to perform multiple modifying actions without reselecting elements.

**Figure 1.3** Use the Properties palette to filter selection sets.

**Project Browser**

The Project Browser (Figure 1.4) is a virtual folder tree of all the views, legends, schedules, sheets, families, groups, and links in your Revit Architecture project. You can collapse and expand the tree by selecting the + or – icon. Open any view listed in the Project Browser simply by double-clicking it.
The Project Browser can also be filtered and grouped into folders based on any combination of user-defined parameters. To access the type properties of the Project Browser, right-click Views at the top of the tree, and select Browser Organization. Check any of the items in the list or create your own.

**Status Bar**

The status bar provides useful information about commands and selected elements (Figure 1.5). In addition to the worksets and design options toolbars, the status bar displays information about keyboard shortcut commands and lists what object you’ve selected. It’s also particularly useful for identifying when you’re about to select a chain of elements.

![Figure 1.5](image)

**FIGURE 1.5** The status bar is located at the bottom of the Revit Architecture application window.

**View Control Bar**

The View Control Bar is at the bottom of every view. It displays different icons depending on the type of view in which you’re working (Figure 1.6).

![Figure 1.6](image)

**FIGURE 1.6** The View Control Bar gives you quick access to commonly used view properties.

From left to right, you have Scale, Detail Level, Visual Style, Sun Path (On/Off), Shadows (On/Off), Rendering Show/Hide (only in 3D views), Crop On/Off, Show/Hide Crop, Lock 3D View (only in 3D views), Temporary Hide/Isolate, Reveal Hidden Elements, Temporary View Templates, Show Analytical Model, and Highlight Displacement Sets. Note that some of these buttons access view properties that you can also set in the Properties palette.

**ViewCube**

As one of several navigation aids in Revit Architecture, you’ll find the ViewCube in 3D views. You can orbit your model by clicking and dragging anywhere on the ViewCube. You can also click any face, corner, or edge of the ViewCube to orient your view.
Hovering over the ViewCube reveals the Home option (the little house above the ViewCube), which brings you back to your home view. Right-clicking the ViewCube opens a menu that allows you to set, recall, and orient your view, as shown in Figure 1.7.

**Figure 1.7** Right-click the ViewCube to access more view-orientation options.

**Options Bar**

The Options Bar is a context-sensitive area that gives you feedback as you create and modify content. This is an important UI feature when you're creating model content. For example, when you use the Wall command, the Options Bar displays settings for the height, location line, offset, and chain-modeling options, as shown in Figure 1.8. Even when you place annotations, the Options Bar provides you with choices for leaders and other additional context.

**Figure 1.8** The Options Bar provides immediate input of options related to a selected object or command.

**Understanding the Interface Workflow**

In this section, you’ll dive into the workflow of the Revit Architecture interface with some basic modeling exercises. You can apply these lessons to just about every tool and function throughout the program.
Activating a command in Revit Architecture is a simple and repeatable process that takes you from a tool in the ribbon to options and properties and into the drawing window to begin placing an element. In the following exercise, you’ll create a simple layout of walls using some critical components of the UI as well as a few common modifying tools.

**Creating a Simple Layout**

Begin by downloading the file c01-Interface-start.rvt from this book’s companion web page: www.sybex.com/go/revit2014essentials. You can open a Revit Architecture project file by dragging it directly into the application or by using the Open command from the Application menu. You can even double-click a Revit Architecture file, but be aware that if you have more than one version of Revit installed on your computer, the file will open in the last version of Revit you used.

Once the project file is open, notice in the Project Browser that the active view is {3D}. This is the default 3D view, which you can always access by clicking the icon in the Quick Access toolbar (QAT; it looks like a little house). Note that the view name of the active view is always shown as bold in the Project Browser.

Let’s begin by placing some walls on some predetermined points in a plan view.

1. In the Project Browser, locate the Floor Plans category, expand it, and double-click Level 1. This opens the Level 1 floor plan view.

2. From the ribbon, select the Architecture tab, and click the Wall tool.

3. In the Options Bar located just below the ribbon, change Height to Level 2 and set Location Line to Finish Face: Exterior. Also make sure the Chain option is checked.

4. At the top of the Properties palette, you see the Type Selector. Click it to change the wall type to Basic Wall: Exterior – Brick on Mtl. Stud. Also find the parameter named Top Offset and change the value to 3'-0" (1000 mm).

Before you begin modeling, notice the Draw panel in the ribbon (Figure 1.9). You can choose from a variety of geometry options as you create 3D and 2D elements in the drawing area.
5. You’re now ready to begin modeling wall segments. In the drawing area, click through each of the layout markers from 1 through 6. Note how you can use automatic snapping to accurately locate the start and end of each segment. At point 3, place your mouse pointer near the middle of the circle to use the center snap point.

6. After you click the last wall segment at point 6, press the Esc key once to stop adding new walls. Notice that the Wall command is still active, and you can continue adding new walls if you choose. You can even change the wall type, options, and properties before continuing.

7. Press the Esc key again to return to the Modify state. You can also click the Modify button at the left end of the ribbon.

Your layout of walls should look like Figure 1.10.

![Figure 1.10](image)

**Using Filter, Mirror, and Trim/Extend**

As you continue the exercise, you’ll use a few common modifying tools to further develop the layout of walls. You’ll also learn how to select and filter elements in the model. Let’s begin by mirroring part of the layout and connecting the corners with the Trim tool.
1. Using the mouse pointer, click and drag a window from the lower left to the upper right to select only the wall segments running east-west, as shown in Figure 1.11.

![Figure 1.11 Drag the cursor from left to right to select some of the walls.](image)

2. You'll probably have selected more than just walls when you use this method. To reduce the selection to only walls, click the Filter button in the ribbon, and clear all the check boxes except Walls, as shown in Figure 1.12.

![Figure 1.12 Filter your selection to include only walls.](image)

3. From the Modify tab in the ribbon, click the Mirror – Pick Axis tool, and then click the dashed line representing the reference plane in the plan view. Mirrored copies of the selected walls appear opposite the reference plane, as shown in Figure 1.13.
4. Again from the Modify tab in the ribbon, click the Trim/Extend To Corner tool. In the plan view, pick each of the north-south walls and then the respective wall that was mirrored in the previous step. The resulting closed perimeter wall should look like the image in Figure 1.14.

5. Save your project file before continuing to the next exercise.
Adjusting Datums

In Revit Architecture, project datums consist of reference planes, grids, and levels. These elements are usually visible only in a 2D view, but they establish control of all model elements in your file. In the next exercise, you’ll examine how levels affect the modeled elements and how you can adjust their graphic representation in a 2D view:

1. In the Project Browser, locate the Elevations (Building Elevation) category, and double-click the South view. You may need to click the + symbol to expand the tree.

2. Zoom in to the right side of the view, and you see the graphic representation of the levels that are defined in this project (Level 1 and Level 2). Select the level line, and notice that both the name of the level and the elevation turn blue. This indicates they can be directly edited.

3. Click the elevation value for Level 2, and change it from 10'-0" (3000 mm) to 15'-0" (4500 mm). Notice how the walls you created in the first exercise maintain their relationship with Level 2 because you specified that datum in the Options Bar before placing the walls.

   Let’s suppose you want to modify the design and add a third level along with a roof. You need to add two more levels and adjust the heights of the exterior walls. We’ll show you two different methods for creating new levels.

4. Go to the Architecture tab in the ribbon, and find the Datum panel. Click the Level command, and make sure the Make Plan View check box is selected in the Options Bar. Click in the elevation view exactly 10'-0" (3000 mm) above the left end of Level 2, using the temporary dimension as a guide. Notice the end of the new level snaps into alignment with the end of the existing level. Click the end of the level above the right end of Level 2 to complete the command.

   If you need to adjust the elevation or the name of the level you just created, select the level, click the elevation value, change it to 25'-0" (7500 mm), and make sure the name is Level 3. Next you’ll create another level by copying an existing one.

5. Select Level 3 in the elevation view, and click the Copy tool on the Modify tab in the ribbon. Click anywhere in the elevation to specify
a start point for the Copy command, and place the mouse pointer in the upward direction. Type 12'-0" (3600 mm), and then press Enter to complete the command. Note that you can also press and hold the Shift key to force Copy or Move commands to operate in 6" increments.

6. Select the newest level, and change the name to Roof. Also make sure the elevation value is 37'-0" (11100 mm).

   Note that when you copied the last level, a corresponding floor plan wasn’t created. This is indicated by the graphic level symbol being black instead of blue. You can double-click the blue level markers to activate the associated plan view of that level. In addition, you can double-click any blue view symbol such as a section, an elevation, or a callout.

7. From the View tab in the ribbon, find the Create panel, click Plan Views, and then click Floor Plan (Figure 1.15). By default, you’ll see only those levels that don’t already have floor plans created. In this case, you see Roof. Select Floor Plan from the list, and click OK.

![Figure 1.15](image)

**Figure 1.15** Use the View tab in the ribbon to create new floor plans.

The new floor plan for the Roof level is activated, so you need to switch back to another view to continue the exercises. Go to the View tab in the ribbon, locate the Windows panel, and then click Switch Windows, as shown in Figure 1.16.
8. Save your project file before continuing to the next exercise.

You might notice as you continue to work through the chapter exercises in this book that many views are opened as you activate plans, sections, elevations, schedules, and so on. Having too many windows open at one time may affect the performance of Revit Architecture, so be sure to close some view windows when you don’t need them anymore. There is also a Close Hidden Windows command in the View tab of the ribbon and the QAT; use this command to close all but the active window. If you have more than one project open, this command leaves open only one view from each project.

### Changing Element Types

Next you’ll change the properties for some of the elements you’ve already created using the Properties palette. You’ll also change some walls from one type to another. In the previous exercise, you created additional levels, thus increasing the overall desired height of your building. In the following steps, you’ll adjust the top constraint of the exterior walls and swap a few walls for a curtain wall type:

1. Activate the default 3D view. Remember, you can click Default 3D View in the QAT or double-click the (3D) view in the Project Browser.

2. Click the Close Hidden Views button in the QAT, and then activate the South view under Elevations (Building Elevation) in the Project Browser.

3. From the View tab in the ribbon, locate the Windows panel, and then click the Tile button. You should now see the two active views (default 3D view and South elevation) side-by-side.

4. In either view, find the Navigation bar, click the drop-down arrow under the Zoom icon, and then click Zoom All To Fit, as shown in Figure 1.17.
In the 3D view, you need to select all the walls to change the properties. To do this, you must use the *chain-select* method.

5. Hover the mouse pointer over one of the walls. Press the Tab key once. The status bar should indicate “Chain of walls or lines.” Click to select the chain of walls. You should see an indication in the Properties palette that eight walls have been selected, as shown in Figure 1.18.
6. In the Properties palette, find the parameter Top Constraint. Change the value to Up To Level: Roof, and then click Apply. Notice how the walls all change height in both the 3D view and the elevation view. Also note how the offset is maintained relative to the level of the top constraint (Figure 1.19).

![Figure 1.19](image1.png)

**Figure 1.19** Tiled windows show the result of modifying the top constraints of the walls.

In the final steps of this exercise, you'll change a few wall segments from one wall type to another. Making these kinds of changes in Revit Architecture is similar to changing the font of a sentence in Microsoft Word, where you select the sentence and then choose a different font from the font selector.

7. In the 3D view, select the wall at the west (left) side of the layout. Press and hold the Ctrl key, and select the wall segment at the east (right) side as well (Figure 1.20).

![Figure 1.20](image2.png)

**Figure 1.20** Use the Ctrl key to manually select multiple items in your model.
8. At the top of the Properties palette is the Type Selector. Click it to open the list of available wall types in the project. Scroll down to the bottom of the list, and select the type Curtain Wall: Exterior Glazing. You may get a warning when you make this change; if so, just select Unjoin Walls or whatever the recommended action is. Your result should look like Figure 1.21.

![Figure 1.21 Wall segments have been changed to a different type.]

9. Remember to save your project file before continuing with subsequent lessons.

**Using Common Modifying Tools**

Now that you’ve been introduced to the basic workflow of the Revit Architecture user interface, you’ll examine some common tools used to modify your designs. These exercises won’t expose you to every available tool; rather, they’re designed to introduce you to the ones you’ll most likely use every day.

You’ll be guided through a series of exercises that show how to create a simple interior layout; you will continue to use the project file from the previous section. In these exercises, you’ll learn how to effectively copy, move, and rotate elements as well as create basic constraints to preserve design intent. You’ll also learn how to use dimension strings not just as annotations but also as interactive modifying tools.

**Using Dimensions for Modifying Designs**

In this exercise, you’ll create a simple layout of interior partitions to explore the use of dimensions in establishing and preserving your design intent. Follow these steps:
1. Activate the Level 1 Interior floor plan from the Project Browser.

2. From the Architecture tab in the ribbon, click the Wall tool and then change the wall type to Interior – Partition Type A2.

3. In the Options Bar, set Location Line to Finish Face: Interior. In the Properties palette, make sure Top Offset is set to 0.

4. In the Draw panel in the ribbon, click the Pick Lines icon, as shown in Figure 1.22, and then click each of the red lines indicated in the floor plan.

5. With the Wall command still active, change Location Line to Wall Centerline, and switch the Draw mode back to Line.

6. Draw two walls inside the area at the right of the layout, as shown in Figure 1.23. Note that you may need to press the Esc key once at the end of each segment to continue the command for the next segment. Don’t worry about the exact placement of these walls; you’ll get to that next.
7. From the Annotate tab in the ribbon, locate the Dimension panel, and click the Aligned tool. In the Options Bar, notice that the default placement is Wall Centerlines. You can change the default placement any time you use a dimension tool; however, you’ll need multiple placement methods in the next step, so leave it as is.

8. In the plan view, click each of the two interior walls you just created. You see one dimension appear between the two walls, but the command is still active. Keep going to the next step.

9. Hover the mouse pointer over one of the two exterior walls, and notice that the centerline of the wall is the default reference. Press the Tab key until you see the inside face of the wall highlight, as shown in Figure 1.24, and then click to add the dimension. Repeat this process for the exterior wall on the other side.

![Figure 1.24](image)

**Figure 1.24** Use the Tab key to toggle between wall references before you place a dimension.

10. When you’ve selected all four walls and you want to complete the Dimension command, click in the view window where you’d like the dimension string to be placed. It’s important that you don’t click another model object or press the Esc key.
11. After the dimension string has been placed, press the Esc key to exit the command, and select the dimension you just created. You’ll see an EQ symbol with a slash indicating that the dimensions along the string aren’t equal. Click this symbol, and the dimensions — along with the wall spacing — become equal.

Try moving one or both of the exterior walls the dimension string is referencing. You see that the interior walls remain equally spaced as long as the dimension string retains its EQ constraint.

12. Select the dimension string again, and click the EQ symbol to remove the equality constraint.

13. Select one of the two interior walls, and the dimension values to either side turn blue. Click the dimension between the interior wall and the exterior wall, and change the value to 12'-0" (3.6 m). Repeat this process for the other side.

14. With the dimension string selected, click the lock symbol below each 12'-0" (3.6 m) dimension to establish a constraint, as shown in Figure 1.25.

---

**Figure 1.25** Lock dimensions along a string to preserve design intent.
Now try moving each of the exterior walls again. Observe how the constrained dimensions are preserving your intent to keep the outer rooms at their defined dimension.

**Aligning Elements**

In the following exercise, you’ll use dimensions to precisely place two more walls. You’ll then learn how to use the Align tool to preserve a dimensional relationship between two model elements. The Align tool can be used in just about any situation in Revit Architecture and is therefore a valuable addition to your common toolbox.

To begin this exercise, you’ll use temporary dimensions to place a wall segment. Elements in Revit Architecture can be initially placed in specific places using temporary dimensions, or you can place them and then modify their positions using temporary or permanent dimensions as you learned in the previous exercise.

Before you begin this exercise, you need to adjust the settings for temporary dimensions. Switch to the Manage tab in the ribbon, and click Additional Settings and then Temporary Dimensions. Change the setting for Walls to Faces and the setting for Doors And Windows to Openings, as shown in Figure 1.26.

**FIGURE 1.26** Modifying the settings for temporary dimensions

Now, follow these steps:

1. Add a wall to the main layout area using the wall type Interior – Partition Type A2. Continue to use the Finish Face: Interior location line option; however, use a temporary dimension to place each wall exactly 8'-0" (2.5 m) from the nearest wall intersection, as shown in Figure 1.27. Repeat this process for the opposite side.
2. Press the Esc key or click the Modify button in the ribbon to exit the Wall command. Select one of the walls you created in step 1. A string of temporary dimensions appears. Drag the grip on the far left of the dimension string so that it aligns with the outside edge of the other wall, as shown in Figure 1.28.

3. Click the dimension icon just below the length shown in the temporary dimension to convert it into a regular dimension string. Select the dimension string and click the lock symbol to establish a constraint, as shown in Figure 1.29.
4. Zoom out so you can see both new interior wall segments. From the Modify tab in the ribbon, select the Align tool.

5. As illustrated in Figure 1.30, click the face of the wall that has been constrained in step 3 (a), click the corresponding face of the other new wall (b), and then click the lock to constrain the alignment (c).

Once you've completed this exercise, try moving the central interior wall to see how the two flanking walls maintain their dimensional and aligned relationships. Note that the constrained dimension can be deleted while preserving the constraint, as shown in Figure 1.31.
FIGURE 1.31 Try moving the main wall to observe how the flanking walls behave.

Rotating, Grouping, and Arraying

Out of all the basic modifying tools we could address in this chapter, the Rotate tool is perhaps the most unique. Rotating elements in Revit Architecture isn’t quite the same as in other applications like AutoCAD. For that reason, you’ll step through a simple exercise to explore the various ways of rotating content.

1. Activate the Level 1 Furniture floor plan from the Project Browser.

2. From the Architecture tab in the ribbon, click the Door tool. Place a few doors within walls in a variety of places throughout the interior layout. Use the spacebar to flip the rotation of the doors before you place them.

3. From the Architecture tab in the ribbon, click the Component tool, and select Desk: Type D1 from the Type Selector.

4. In the floor plan, place one desk in the main central space. Press the spacebar once to rotate the desk, and place another desk in one of the spaces in the east wing, as shown in Figure 1.32.
5. Use the Component tool again, and choose Chair-Desk from the Type Selector. Press the spacebar until the chair orients properly with the desk (Figure 1.33).

6. Repeat this process for the desk in the east wing, but add two additional chairs on the opposite side of the desk (Figure 1.34).
7. Select the desk and chair in the main space, and click the Create Group command in the Create panel of the contextual ribbon. Name the group `Desk-Chair-1`.

8. Repeat the process for the desk and chairs in the east wing. Name the group `Desk-Chair-3`.

9. Select the group `Desk-Chair-3`, and click the Copy command in the ribbon. Set the Constrain and Multiple options in the Options Bar, and place a copy of the group in the three perimeter spaces as shown.

10. With the Copy command still active, uncheck the Constrain option, and place a copy of the group in the space at the north side of the layout. Your copied furniture should look like the image in Figure 1.35.
11. Select the last copied group, and click the Rotate tool in the Modify panel of the ribbon.

12. Drag the rotation center icon to the lower-right corner of the desk.

13. Point the mouse pointer in the east direction and click. This is the reference angle.

14. Move the mouse pointer in the south direction (Figure 1.36) and click. This is the final rotation.

15. Select the Desk-Chair-1 group in the main space, and click the Array tool in the Modify panel of the ribbon. In the Options Bar, uncheck the Group And Associate option, and set Number to 4.

16. In the plan view, click somewhere near the group, point the mouse pointer in the east direction, and then enter 8'-0" (2.5 m). You see four copies of the group.

17. Use any combination of Copy, Array, and Rotate to complete the layout of the desk-chair groups, as shown in Figure 1.37.
In this exercise, you created a simple group of furniture elements. Groups can be a powerful tool for managing repeatable layouts in a design, but they can cause adverse performance if they’re abused. There are far too many opinions and best practices for using groups to list in this chapter; however, you need to be aware of a few important tips. Groups should be kept as simple as possible, and they shouldn’t be mirrored. You should also avoid putting hosted elements in groups — but you’ll learn more about these types of elements throughout this book.

**Aligned Copying and Group Editing**

One powerful and essential tool in Revit Architecture is the copy-to-clipboard command known as Paste Aligned. As you’ve seen throughout this chapter so far, this is yet another tool that can be used on just about any kind of model or drafting element. In the following exercises, you’ll take the interior content you developed in the previous exercises and replicate it on other levels in the building. Here are the steps:

1. Activate the Level 1 Furniture floor plan from the Project Browser.
2. Select all the interior walls, doors, and furniture in the floor plan.
3. In the Clipboard panel of the ribbon, click the Copy To Clipboard tool. You can also press Ctrl+C on your keyboard.

4. Also in the Clipboard panel of the ribbon, click the Paste drop-down button, and select Aligned To Selected Levels. You’re prompted with a dialog box to select levels to which the selected content will be copied in exactly the same position (Figure 1.38). Select Level 2 and Level 3 using the Ctrl key to make multiple selections.

![Figure 1.38](image)

**Figure 1.38** Use Paste Aligned To Selected Levels to create duplicate floor layouts.

5. Activate the 3D Cutaway view from the Project Browser to view the results of the aligned copying (Figure 1.39). Note that instructions for creating floors are in Chapter 3 of this book. Figure 1.39 is taken from the “finished” Revit file available for download from the companion website.

![Figure 1.39](image)

**Figure 1.39** The 3D Cutaway view uses a section box to display the inside of a building.
Now that you’ve created many copies of the furniture group on several levels, you can harness the power of the group by making changes to the group and observing how the overall design is updated.

1. Activate the Level 2 floor plan from the Project Browser.

2. Select one of the Desk-Chair-1 furniture groups in the main space. Click the Edit Group button from the contextual ribbon. The view window turns a light shade of yellow, and a temporary toolbar appears at upper left in the view area.

3. Select the chair in the group, and from the Type Selector, change it to Chair-Executive.

4. Rotate the chair 20 degrees using the Rotate tool (Figure 1.40).

5. Click the Finish button in the Edit Group toolbar, and observe how the changes you made are propagated to all the group instances on all levels. Save your changes, and then activate the Level 1 and Level 3 floor plans to see the extent of the changes.

**Figure 1.40** The view window enters a temporary group-editing mode.
The Essentials and Beyond

The Revit Architecture interface is organized in a logical manner that enforces repetition and therefore increases predictability. Almost every command can be executed by selecting a view from the Project Browser, choosing a tool from the ribbon, specifying settings in the Options Bar, and then placing an element in the drawing window. Although we covered only the most basic tools in the preceding exercises, you’ll be able to apply what you’ve learned in this chapter to the many exercises exploring other tools in subsequent chapters.

Additional Exercises

▶ Use the Window and Door tools to place some hosted elements in the walls.
▶ Create copies of these elements on other levels using the Copy-Paste Aligned tools.
▶ Experiment with various ways to organize the Revit Architecture interface that support your preferred working method. Try tiling windows and undocking the Properties palette or the Project Browser.
▶ Try a radial array of furniture by changing the Array tool settings in the Options Bar.
Walls and Curtain Walls

Walls in the Autodesk® Revit® Architecture software can range a great deal in complexity. Early in the design process, walls and curtain walls can be more generic, essentially serving as vertical containers for space and function. They can also be associated to masses in order to create incredibly complex shapes. As the design progresses, these generic walls and curtain walls can be swapped out for more specific vertically compound walls that indicate a range of materials as well as geometric sweeps and reveals.

In this chapter, you learn the following skills:
▶ Understanding wall types and parameters
▶ Creating numerous wall configurations
▶ Modifying walls
▶ Creating curtain walls
▶ Modifying curtain walls
▶ Going beyond the basics

Understanding Wall Types and Parameters

Revit Architecture has three fundamental types of walls: basic, stacked, and curtain walls. In this section, we will cover some of the important aspects of each. This is not intended to be an exhaustive guide to creating and editing each wall system but rather an overview to provide some background knowledge before we continue with the exercises throughout this chapter.
Basic Walls

The Revit Architecture default template includes several wall types. The most basic wall types have no detailed structure and are named with the prefix Generic for easy identification. Other wall types have highly detailed structures known as layers. Each layer is assigned a function, material, and thickness. The function of a wall layer determines how it will join when multiple wall types intersect or when a wall intersects another element such as a floor.

On the Architecture tab in the ribbon, click the Wall tool. In the Type Selector at the top of the Properties palette, select the Generic – 8" (140 mm) Masonry wall type, and then click Edit Type just below the Type Selector. Click the Preview button at the lower left in the Type Properties dialog to see a graphic sample of the wall type. In Figure 2.1, the structural region of this wall is defined by a diagonal crosshatch pattern. This is a basic wall with only one pattern defining the wall’s material.

![Type Properties dialog](image)

**Figure 2.1** Masonry structural region of a basic wall
Basic walls can be modified to contain far more structural detail. With the Type Properties dialog still open, go to the Type drop-down and select the wall type Exterior – Brick On Mtl. Stud, and you’ll see the difference (Figure 2.2).

Click the Edit button in the Structure parameter, and notice the numerous values that control the function, material, and thickness for this wall type. These values help you coordinate your project information across views and schedules.

Basic walls can even have profiles applied to them that are used to add or remove geometry in your walls. If you’re still examining the structure of the previous wall, click the Cancel button, and select the wall type Exterior – Brick And CMU On MTL. Stud. In the Preview pane, switch the view to Section. If you zoom into the top of the wall sample shown in the preview, you’ll see a parapet...
cap at the top of the wall (Figure 2.3). This is a profile associated to the basic wall type. Although you can manually add profiles to walls in your project on a case-by-case basis, we think you’ll find that adding them to the wall definition makes creating and updating wall types easy and quick.

Stacked Walls

Stacked walls consist of basic wall types but are combined vertically in a single defined type. Any basic walls can be used to create a stacked wall.

To find the stacked wall types, start the Wall tool, access the Type Selector, and go to the bottom of the list. Select the wall type Exterior – Brick Over CMU w Metal Stud, and click the Edit Type button. As shown in Figure 2.4, this wall type is defined by two different basic walls, but you can add more if necessary. Note that you can’t combine stacked walls or add curtain walls to your stacked wall.
One of the stacked wall segments must be of variable height to accommodate the vertical constraints of the wall instances you place in a project. If all the segments were a fixed height, it would conflict with varying datum geometry in your project. In addition to specifying the height of the segments, you can also adjust the horizontal offset or set a segment to flip its orientation (inside or outside).

Stacked walls have a unique option available (select and then right-click) called Break Up. When a stacked wall is broken up, the segments are reduced to individual basic walls. The basic walls represent the same dimensions specified in the stacked wall. Keep in mind there is no method to convert the basic wall segments to the original stacked wall.

**Curtain Wall Types**

Curtain walls are more complex than basic walls or stacked walls. They consist of four elements: a simple wall-segment definition, curtain grids, panels, and mullions. Curtain wall types can be completely instance based (allowing each to vary) or can be driven entirely by the wall type properties that set grid spacing, panels, and mullion types for interior and border conditions (Figure 2.5).
Creating Numerous Wall Configurations

Let’s start adding some walls to the current project. First, open the Level 1 floor plan view, and click the Wall command. Notice in the ribbon on the Draw panel that a number of configurations are available for creating walls (Figure 2.6). You can see a variety of options for sketching wall segments as well as two icons with arrows that indicate options you can choose from to pick line segments on which to place walls.
Creating Numerous Wall Configurations

Sketching Walls

You can sketch walls in various configurations by using the options in the Draw panel of the ribbon, as shown in Figure 2.6. In the following steps, you will perform some free-form wall-sketching exercises to become familiar with the Draw options:

1. Activate the floor plan named Sketching Walls.
2. Start the Wall tool, and practice creating segments of walls using each of the first six configurations in the Draw panel (from Line through Center-Ends Arc). Don’t worry about where you create these walls; it’s just practice.
3. Take note of the settings available in the Options Bar prior to wall placement. Chain, for example, automatically starts the next wall segment connected to the previous. Others such as Inscribed Polygon and Circle are exclusive to more complex configurations. You can apply different settings to the geometry, such as the number of polygon sides or the radius of a circle, before sketching the wall segment.

Creating Elliptical Walls

Because the need for elliptical walls may occur in your designs, we’ll address them now. You should know two things. First, elliptical walls can’t be sketched using the Draw tools. Second (and more important), they can be created via other workarounds (such as creating an elliptical mass and then picking the face of the mass from which to create an elliptical wall).

So, what’s a better way? Create elliptical wall layouts from a series of tangent arcs. Doing so will give you an approximation that is indistinguishable from an actual ellipse, and you’ll be able to guide the walls’ construction more accurately in the field.
In the following steps, you will use the Tangent End Arc and Fillet Arc configurations to append wall segments to existing wall elements:

1. Activate the floor plan named Tangent-Fillet Walls. Your goal is to complete the layout of the walls according to the dashed lines shown in the floor plan.

2. In the upper-right corner of the layout, the two perpendicular walls must be joined with a radius wall segment.

3. Select either one of the wall segments, right-click, and select Create Similar from the context menu.

4. On the Draw panel, in the ribbon, select the Fillet Arc option.

5. Click one wall segment and then the other perpendicular segment. After you click the second wall segment, a curved segment appears.

6. Place the curved segment near the layout line. Before you continue, click the radial dimension value and change it to 6-0 (2000 mm).

7. The Wall command should still be active, so select the two perpendicular walls in the lower-right corner of the layout, and repeat steps 3 through 6. Notice the difference in using the Fillet Arc option to either close the gap on two wall segments or trim back two walls that are already connected.

8. With the Wall command remaining active, return to the Draw panel in the ribbon, and select the Tangent Arc option.

9. Click the left end of the wall segment at the bottom of the layout, and then click the left end of the wall segment at the top to complete the tangent arc wall. Your results should look like the plan shown in Figure 2.7.
Picking Walls

You can also create walls by picking lines. This approach is helpful if you have a CAD file that needs to be converted to BIM or if a preliminary layout was created in another tool such as SketchUp.

In this exercise, a preliminary layout has been drawn with detail lines in the sample project. You will use these lines to generate walls.

1. Activate the Picking Walls floor plan, and then start the Wall tool.

2. Choose the Pick Lines option in the Draw panel in the ribbon. On the Options Bar, set the Location Line to position the wall in relation to the picked path.

3. In the first set of lines in the sample file, pick each individual line segment to place walls.

4. On the second set of lines, use the chain-select method to place all the wall segments at once. Hover your mouse pointer over one of the line segments, and press the Tab key once. When the chain of lines is highlighted, click the mouse button to place the complete chain of walls. Your results should look like the plan shown in Figure 2.8.
Hosting Elements in Walls

Walls can host other types of elements that are meant to create openings. As long as the walls exist, the elements they are hosting exist as well. Doors and windows are examples of commonly used hosted elements.

Placing a door in a wall is very easy and can be done in plan, elevation, or 3D view. In this exercise, you’ll place doors from the Level 1 view. You’ll use the very first wall you created at the beginning of this chapter. On the Architecture tab, select the Door tool on the Build panel.

You may notice that you can place doors only in walls. This is because door families are hosted elements and cannot exist without a host. Because of this relationship, hosted elements are automatically deleted if you delete a host element such as a wall. As you are placing doors in walls, you’re shown temporary dimensions that will help you place the door closer to its correct location. Follow these steps:

1. Activate the Sketching Walls floor plan, and place two doors, as shown in Figure 2.9.
2. Select the Window tool on the Architecture tab’s Build panel. Hover over the same wall, and place a window as shown in Figure 2.10. As with any hosted element, you can place it only within a host.

![Figure 2.9](image1.png) Hosting doors in a wall

![Figure 2.10](image2.png) Hosted window

---

**Modifying Walls**

Now that you’ve created a few wall configurations, it’s important to understand how you can modify them. Sometimes this is done simply by selecting the wall and dragging a wall end or a shape handle to a new position. In other cases, you want to be more exact and assign a specific value.

Your approach depends on where you are in the design process. Just remember that you can update design decisions, and all your views, schedules, tagging, and so forth will update — don’t get concerned with being too exact early in your design. Let’s work through a quick exercise for modifying walls.

1. Create a new project using the default project template. Sketch a straight segment of a wall, but this time as you draw the wall, type 40 (or 12 m). Depending on the default units, typing 40 creates a 40' segment.

   Notice that you didn’t have to indicate the units as feet. If you wanted to indicate inches, you’d only have to put a space between the first and second values. Thus, 40'-6" can easily be entered as 40(space)6.
2. Press the Esc key twice, or click the Modify button in the ribbon. Select the segment of wall you just created.

3. There are two options to modify the length, as shown in Figure 2.11. You can type in a new value by selecting the temporary dimension, or you can simply drag either wall end to a new location.

![Figure 2.11 Modifying the wall length](image)

4. Go to the default 3D view, and look at some other options. The highlighted areas of Figure 2.12 are called shape handles. You can click and drag them to adjust the top and bottom locations of a wall. As you drag the shape handle, the new location is shown, whereas the existing location is “ghosted” until you release the shape handle.

![Figure 2.12 Wall shape handles](image)
Instance Parameters

In many cases, you’ll want to enter more exact values or have more specific control over a particular wall instance. You can do this by adjusting the instance parameters in the Properties palette (Figure 2.13). Select the wall, and look at the properties.

![Properties palette](image)

**FIGURE 2.13** Instance parameters displayed in the Properties palette

**Location Line** The location line is the origin of the wall. If you swap one wall for another, the location line will be maintained. In other words, if you create an exterior wall and the location line is the inside face, then when you change the properties or select a thicker wall, it will grow to the outside — away from the location line.
Base Constraint  The base constraint is the bottom of the wall. Be careful! Deleting a datum (in this case, Level 1) to which an object is constrained also deletes what is associated to the constraint. The base constraint can be changed at any time, and the wall will move to reflect the change.

Base Offset/Top Offset  The Base Offset or Top Offset is the value above or below the respective constraint. If you wanted the bottom of a wall associated to Level 1 but 3'-0" (1 m) below, the value for Base Offset value would be -3'-0".

Base Is Attached/Top Is Attached  The Base Is Attached or Top Is Attached value indicates whether the bottom or top of a wall is attached to another wall, floor, or roof. Note that this check box only reports the current state and cannot be changed via the Properties palette.

Top Constraint/Unconnected Height  Top Constraint is the method by which you determine the height of a wall instance. The Unconnected Height value is the height of the wall when you do not use a specific datum for Top Constraint. If you try to change the Top Constraint value to Up To Level: Level 2, the Unconnected Height parameter becomes inactive.

Room Bounding  The last value you should be aware of is the Room Bounding option. By default, walls will be set as room bounding. However, if you have a situation where you don’t want walls to define a space, you can deselect this option, and the room will ignore the wall.

Editing Profiles

Of course, not all walls are rectilinear in elevation. For these situations, you can edit the profile of a wall. Note that you’ll be able to edit the profile of a straight wall only, not a curved wall.

When you edit a wall’s profile, the wall is temporarily converted to an outline sketch in elevation. Because the sketch is not plan-based, you can edit a profile only in a section, an elevation, or an orthogonal 3D view. You can draw as many closed-loop sketches as you like within the wall’s profile, but each loop must be closed.

Follow these steps:

1. Continuing with the wall you created in the previous exercise, select the 40’ (12 m) wall, and click Edit Profile on the Modify | Walls tab.

2. From the South Elevation view, create the sketch, as shown in the top illustration in Figure 2.14. (Don’t worry about following the exact dimensions in this illustration — we’re just showing them for
reference.) Delete the top line, and trim the two side sketch lines. Note that the reference lines indicating the extents of the original wall remain, as shown in the bottom illustration in Figure 2.14.

![Figure 2.14 Adding new sketch lines](image)

Use the Trim tools as necessary to clean up the sketch so that it remains as one closed loop. If you have crossing lines or open segments, you will receive an error when you attempt to finish the sketch in the next step.

3. When you are done, click Finish Sketch Mode.

### Attaching and Detaching the Top and Base

We’ve previously discussed the ability to use a project datum as the base constraint or top constraint of a wall, but walls can also be attached to the top or bottom of other objects — even other walls. Let’s do this with a copy of the wall from the “Editing Profiles” exercise.
1. Select the wall, and then use the Copy tool in the ribbon to create a copy off to the side.

2. Select the copied wall, and click Edit Profile. Modify the exterior sketch as shown in Figure 2.15. Don’t forget to trim and delete unnecessary sketch lines. Then finish the sketch.

3. Return to your Level 1 floor plan, and sketch another wall right on top of the same location as the wall you just edited. In this case, use a Generic 12" (300 mm) wall, and set the height in the Options Bar to 3-0 (1000 mm). The walls may overlap, but that’s OK.

4. Open the default 3D view to complete this step. Select the thicker wall, click Attach Top/Base, and confirm the Options Bar setting is correct for Top or Base (Figure 2.16). Now select the wall with the profile that you just edited. (Note that this may be a little tricky because the thinner, edited wall is likely completely inside the thicker wall.) This attaches the top of the thicker wall to the underside of the upper wall, as shown on the right side of the figure.
The great thing about this technique is that the relationships between the two walls are maintained if you edit the elevation profile of the upper wall. Performing these steps is a lot faster than having to edit the elevation profile of both walls! And remember, the most common use of this technique is to attach walls to sloped elements such as the underside of roofs.

**Resetting Profiles**

If you need to remove the edited condition of a wall, don’t reenter Edit Profile mode and manually remove the sketches. Select the wall, and click Reset Profile in the Mode panel on the Modify | Walls tab. Doing so will reset the extents of the wall and remove any interior sketches.

Another scenario for using Reset Profile would be when attempting to use Attach Top/Base. Depending on how the wall profile was originally edited, Revit could display a join error when attempting to attach the wall. This is most likely to occur if the top of the wall profile was edited previously. Reset the profile first, and then attempt to attach the wall to the roof as needed.
Cutting Openings

Openings can be cut in both straight and curved walls. The command tends to be used in curved walls because you already have the option to edit the elevation profile in straight walls. And when you cut an opening, you cannot sketch beyond the extents of the wall boundary or create shapes that are not rectilinear. Here are the steps to create a rectilinear opening in a curved wall:

1. Create a curved wall segment, and then go to your default 3D view and select the wall.

2. The Wall Opening option appears on the Modify | Walls tab, as shown in Figure 2.17 on the left. Select this command, and then hover over the wall; you are prompted to create a rectilinear opening, as shown on Figure 2.17 on the right.

FIGURE 2.17 Creating wall openings
When the wall opening is selected, the Properties palette will display constraints such as Top Offset and Base Offset. This allows input for exact dimensions to modify the opening size and location. To delete an opening, hover over the opening, select it, and then press the Delete key. Use the Tab key to toggle between selecting the wall and opening if needed.

**Splitting Walls**

Sometimes, after you’ve created walls, you realize that you don’t need an inner segment — or you need to change a segment to another wall type. The process of deleting and re-creating walls would be tedious work; however, Revit Architecture offers a Split tool that allows you to divide walls, effectively breaking them into smaller pieces. This can be done along both horizontal and vertical edges of either curved or straight walls.

Let’s experiment with this technique by creating a plan configuration of walls, as shown in Figure 2.18. The dimensions are shown for reference.

![Figure 2.18 Configuration of walls](image)

In this case, the section of wall between the two parallel walls is not needed. But rather than delete the wall and create three new walls, let’s split the wall twice and delete the inner wall.
1. Select the Split Element command from the Modify tab.

2. Hover over the location of the wall that you intend to split. You are prompted with a reference line that helps indicate which wall you’re splitting. Split the wall twice, once at each intersection.

3. Delete the inner segment. Your wall layout now resembles Figure 2.19.

![FIGURE 2.19 Using the Split Element command](image)

**Swapping Walls**

Swapping walls for different types prevents the rework of deleting them and creating new ones. Doing so is as easy as selecting a wall and then selecting the new type from the Properties palette.

1. Use the wall from the section “Attaching and Detaching the Top and Base.” Select the lower wall, and then go to the Type Selector at the top of the Properties palette.

2. Change the lower wall to Generic – 12” (300 mm) Masonry. Once you select the new wall type, the result resembles the wall in Figure 2.20. Note that the patterns of the individual CMU courses are shown on the wall’s surface in accordance with the new wall type’s material properties. Profile edits, attachments, and instance properties of the wall will also be maintained for the new type.
Creating Curtain Walls

Curtain walls are created in much the same way as regular walls: by selecting the type of curtain wall and then sketching the desired shape. Despite this similarity, the available parameters for curtain walls are rather different. In this section, you will create a curtain wall using manual techniques for adding curtain grids and mullions to give the wall a more detailed definition. You can continue to use the project file created for the “Modifying Walls” exercise, or you can create a new project using the default template.

Begin the exercise by creating a 40'-0" (12 m) segment, using Curtain Wall 1 as the wall type from the Type Selector. Most of the following exercise steps are easier to accomplish in the default 3D view: activate it from the Quick Access Toolbar (QAT) or by double-clicking the 3D view named (3D) in the Project Browser. You’ll continue in the following sections.
Curtain Grids

Before adding mullions, you need to add curtain grids to the wall. These grids will subdivide the wall into smaller panels and allow mullions to be added. Follow these steps:

1. Select the Curtain Grid tool from the Build panel on the Architecture tab of the ribbon.

2. As you hover over the edge of the curtain panel, you are prompted with a dashed line that indicates the grid location. Also notice that the grid location becomes somewhat “sticky” at the midpoint and at one-third lengths along the edge.

3. Place two evenly spaced curtain grids along the horizontal and vertical edges. When you're finished, the curtain panel looks like Figure 2.21.

FIGURE 2.21 Completed curtain grids
Adding Mullions

Now that you've added curtain grids, you can add mullions to the curtain panel.

1. Select the Mullion tool from the Build panel. You're given three different options to place the mullions: continuously along a grid line, on a segment of a grid line, or on all empty grids including the boundary. Select the third option (Figure 2.22).

![FIGURE 2.22 Selecting the Mullion tool's All Grid Lines option]

The default mullion is fine for this exercise, but note that there are several mullions in the default template. You can even create mullions with user-defined profiles.

2. Hover over the curtain wall, and left-click. The mullion is assigned to all empty grids. Press the Esc key once, or click Modify to exit the command.

3. To modify any element in the curtain-wall segment, hover over the location and press and release the Tab key (don't just hold down the Tab key). Doing so sequentially selects the mullion, the grid line, the nearest panel, or the entire curtain wall.

4. Selecting the grid line and temporary dimensions allows you to enter exact values (or even click and drag to move the grid), as shown in Figure 2.23.
Curved curtain-wall segments that you create will appear flat until you add the vertical grid lines. But specifying exact grid locations during the design process is often tedious — and difficult to correct. To help, you can create a design panel from a specially created wall that is very thin and transparent. Use this wall to figure out the design, and then swap it out for a curtain wall later. The wall can even have a pattern file associated to it that visually helps it to read as a curtain panel. You can find an example of this type of wall in c02-Curtain Walls.rvt, which is available with this chapter’s exercise files.
Embedding Curtain Walls

Curtain walls can also be embedded in walls. Follow these steps:

1. Create a 40'-0" (12 m) segment of a generic wall.

2. Using the Storefront curtain-wall type, sketch a 30'-0" (9 m) segment directly in line with the generic wall segment (Figure 2.24). Note that this curtain wall type has grid spacing and mullions defined in the type properties.
As you can see, the curtain wall automatically embeds itself in the generic wall. This behavior is controlled by the Automatically Embed parameter in the curtain wall’s type properties.

**Modifying Curtain Walls**

It’s very seldom that your design ends up exactly where you started. So, let’s experiment with modifying the embedded curtain wall. This is a very important step not only in grasping how certain functionality works but also in understanding the flexibility in your workflow and how Revit Architecture will accommodate it.

**Editing the Elevation Profile**

In this exercise, you will continue to use the project file you started in the “Creating Curtain Walls” exercise. The commands and tools you will use are similar to those you learned in the “Editing Profiles” exercise. Complete the following steps to modify the elevation profile of a curtain wall — even one embedded in another wall:

1. Select the entire embedded curtain-wall segment by hovering over the outer edge of the curtain panel and selecting it. Make sure you have the whole curtain wall segment selected and not just a panel, mullion, or grid segment.

2. In the ribbon, click Edit Profile, and modify the sketch of the curtain wall as shown in Figure 2.25. Remember, you need to switch to an elevation or 3D view to edit the sketch of a wall.
3. Trim the side sketch lines and delete the top sketch line before finishing the sketch. Then click OK.

4. When you attempt to finish the sketch, Revit Architecture warns you that some of the mullions in the original system can’t be maintained. This is fine, because some of the mullions are outside the sketch area. Click Delete Elements to continue.

The outer generic wall has already been healed to match the new boundary condition.

**Adding and Modifying Grids and Mullions**

Continuing the “Modifying Curtain Walls” exercises, you will now add some additional grids that are not part of this defined system.

1. On the Architecture tab in the ribbon, select the Curtain Grid tool. Hover over the curtain-wall segment, as shown in Figure 2.26.
2. When the grid line is evenly spaced between the first and second horizontal mullions, place the new grid line. Because this curtain wall type already has a defined mullion type, the mullions are automatically added when you place the grid line.

**Unpinning and Toggling Mullions**

When a curtain-wall type contains defined spacing and mullions, you can still modify an individual segment of curtain wall to meet the needs of your design. As you continue this exercise, you will need to *unpin* some the elements before
you can modify them. The *unpinning* action means you are removing a system constraint so that an element can be customized.

In the following steps, you will remove two mullion segments and swap two of the curtain panels for door panels:

1. Zoom into the curtain-wall segment, and hover over one of the mullions you created in the previous exercise. You may need to press the Tab key momentarily to cycle through the choice of elements at the mouse pointer. When it highlights, select the mullion.

2. Notice the pin icon just above the mullion in Figure 2.27. Click the pin icon to unpin the mullion.

3. Repeat step 2 for the mullion directly below the one you just deleted (at the base of the wall). This clears the way for you to place the curtain-wall door.
Modifying Curtain-Grid Segments

Before you swap out the glazing panel for a door, you need to “weld” these two panels into a single panel. To do this, one segment of the curtain grid must be removed. Follow these steps:

1. Click the Modify button in the ribbon, hover the mouse pointer over the curtain grid that is bisecting the two panels, and select the line shown in Figure 2.28.
2. In the ribbon, click Add/Remove Segments, and then select the grid line that separates the two curtain panels. Now you have a single panel rather than two panels, because the two panels have been welded together.

After you remove the curtain-grid segment that was splitting the panel in two, notice that the curtain grid looks like it is still there. The curtain grid is expressed across the entire length of a curtain-wall segment, but you can add or remove segments of the grid to customize your design. To add a segment back to an existing grid line, do not use the Curtain Grid tool. Instead, use the Add/Remove Segments tool, and follow the same steps you learned in this exercise.

Modifying Curtain Panels

In the final exercise of this section, you will place a door in the curtain wall. This process is different from placing a door in a basic wall because the curtain-wall door must be built and placed as a curtain panel. You will change one of the defined panels in the curtain wall segment into a door, but you won’t use the Door tool.

Before you swap out the glazed panel for curtain-wall doors, you need to load the appropriate family into the project. There’s little point in getting ready to exchange the panel if you don’t have the new panel ready to go.

1. On the Insert tab, select the Load Family option on the Load From Library palette. From the Doors folder, select the Curtain Wall Dbl Glass family. The family is now loaded into your project, and you can exchange it for the default curtain panel.

2. Select the panel you want to replace. Right away, you can see that the panel is pinned because it’s being defined by the type properties for the curtain-wall system — just like the mullions. As you’ll recall, pinned elements can’t be exchanged until they’re unpinned. The same holds true for this panel.

3. Select the panel, and click the pin icon. Now you can select a new panel type from the Type Selector palette. Choose Curtain Wall Dbl Glass, and the panel appears in the wall segment, as shown in Figure 2.29.

Note that you can place only curtain-wall doors in curtain walls. Any other type of door won’t work.
The curtain-wall doors panel automatically expands to fill the space of the entire panel that preceded it. These are special doors that are really a curtain panel category. If you want a real door, you can swap out the curtain panel for a wall (even a wall made only of glass) and then place the door in the wall.

**Going Beyond the Basics**

Walls and curtain walls can be far more complex than the examples you’ve created in this chapter. If you want to examine all the types, go to the Chapter 2 folder at this book’s web page at www.sybex.com/go/revit2014essentials and download c02-Walls-and-Curtain-Walls.rvt.

First, there’s the option to create walls by picking a face. Essentially, you create a mass and then assign walls to the face of the mass. If the mass is modified, you can reassign walls to the modified faces. As you can see in Figure 2.30, the results can be complex.
Not only can you create walls in this manner, but you can also create complex curtain systems. These mass-based curtain types can contain very complex panel configurations. In some cases, the results may not even resemble a typical glazed system (Figure 2.31).

Once again, the important thing is to understand the basics. Resolve your design intent. Don’t get hung up on modeling when you can sketch. Get feedback from someone who’s a Revit Architecture expert and is willing to share.
The Essentials and Beyond

Creating complex wall conditions is possible but takes time and patience. In more complex conditions, walls can also be embedded into other walls. But for an essential understanding of Revit Architecture, this is a great start; you’ve created walls of many types, added hosted elements, and even edited their profiles.

Additional Exercises

Create the following curtain wall condition. Note that the mullions are angled. You’ll need to modify the Type, Instance, and Grid Layout properties to come up with the most flexible solution.
The curved wall in the next graphic has a complex star-shaped opening that is being filled by another curved wall that is star-shaped (and fits exactly inside that opening). You can’t create nonrectilinear openings in curved walls with the Wall Opening tool. You’ll need to use an in-place family.

If you get stuck, both of these walls are in this chapter’s sample project (c02-Walls-and-Curtain-Walls.rvt) at the book’s web page.
Floors, Roofs, and Ceilings

We’ve approached this chapter by grouping together horizontal host elements that make up your building. Although the process of creating a floor, roof, or ceiling is somewhat different, the tools used to edit each initial design element have a lot of overlap and similarity. In this chapter, you learn the following skills:

- Creating floors
- Laying out roofs
- Adding ceilings

Creating Floors

There are quite a few ways to create floors in the Autodesk® Revit® Architecture software. But we honestly don’t have the space to dig deep into all these variations! Quite frankly, they’re not important for early design iteration.

What’s important is that you understand what the various approaches to a single floor type will do and what kind of relationships they’ll make. So, let’s get started! Begin by downloading the file c03_Floors_Roofs_and_Ceilings-start.rvt from this book’s companion web page: www.sybex.com/go/revit2014essentials.

Sketching

First, let’s create floors by sketching the desired shape in the Level 1 floor plan view. The floor type you’ll be using is Generic – 12’. Follow these steps:

1. Select the Floor tool on the Build panel of the Architecture tab.
2. Enter Sketch mode, which will allow you to create a sketch that will eventually be used to define the boundary of your floor.
3. Create a simple sketch for the floor, 15’ × 30’ (4.5 m × 9 m). The dimensions are for reference only; even though this is a simple shape, what’s more important is how you can manipulate the shape.

4. Finish the sketch, and select your default 3D view. Select the Floor tool, and your floor resembles the one shown in Figure 3.1.

![FIGURE 3.1 The finished floor](image)

**Editing the Boundary**

You can see a couple of things right away in the instance properties: metadata about the floor (location, area, volume, and so on) as well as the ability to revise the geometry via sketching or spot elevations. Continue the example with these steps:

1. While the floor is still selected (reselect the floor if necessary), select Edit Boundary from the Modify Floors tab, and return to the Level 1 floor plan.

2. Add additional sketch lines to generate the shape at the lower right in Figure 3.2. Don’t forget to trim back any intersecting lines.
3. Finish the sketch by clicking the green check button. Select the floor, and notice that the options and metadata have already updated, as shown in Figure 3.3.
4. Create another floor of the same type and same initial dimensions, 15' × 30' (4.5 m × 9 m), just above the first floor. Leave some space between the two floors.

5. Offset the floor 1'-0' (300 mm) above Level 1 by entering this distance into Height Offset From Level in the Properties palette.

6. Finish the sketch to complete the floor (Figure 3.4).

Creating Sloped Arrows and Floors

Not all floors are flat, and many have large openings. Let’s investigate both options. You’ll begin by bridging another sloped floor between the first two from the previous section.

1. Sketch another floor between the two previous floors, filling the gap between the two (Figure 3.5).
2. If you were to finish the sketch like this, the floor wouldn’t connect the upper and lower sections. You need to add a slope arrow. Do so by selecting the Slope Arrow tool on the Draw panel.

Sketch the arrow as shown in Figure 3.6. The first location that you pick is the tail of the arrow; the second location is the head.
3. Select the slope arrow, and modify the parameters as shown in Figure 3.6 so they match the location of the upper and lower floors. Be sure to specify the heights of the tail and head.

4. Finish the sketch, and return to your default 3D view (Figure 3.7), which shows the finished condition. Now the sloped floor connects the lower and upper floors.

---

Creating Sloped Floors via Shape Editing

You could create slightly sloped floors and depressions with slope arrows and separate floors, but this approach would probably be too complex because you’d have to create a lot of separate pieces of geometry. For these kinds of conditions, you have the Shape Editing tools.

Continue the example with these steps:

1. Return to Level 1, and select the upper floor. Now you can see the Shape Editing tools in the Shape Editing panel on the Modify Floors tab.

2. Let’s suppose that this entire floor is at the correct level, except for one small portion that needs to be slightly depressed in order to accommodate a loading area.

   Define the upper and lower boundaries of this depressed area by selecting the Add Split Line option on the Shape Editing panel. Add the lines as shown in Figure 3.8. Dimensions are shown for reference.
3. Now that you’ve added the proper locations to break the slope, you need to modify the points at the ends of the lines to change the slope of the floor. Start by returning to your default 3D view. As you hover over the endpoint of the line, Revit Architecture highlights the shape handles. Press the Tab key to highlight a specific handle, and then select it (Figure 3.9).

4. Adjust the elevation of the shape handle as shown in Figure 3.9. In this case, you’re depressing the floor, so the value must be negative. But you could also increase the elevation in a small area by using a positive value.

5. Do the same for the shape handle to the right. When you’re done, the depressed area resembles Figure 3.10.
Creating Openings by Sketching

For the occasional or irregular opening in a floor, it’s easy to add a secondary opening using the Opening tool. Using the same example file, follow these steps:

1. From the Architecture tab on the ribbon, select the By Face tool on the Opening panel. Select any edge of the sloped floor slab you created to initiate Sketch mode.

2. Sketch an opening 10’ × 3’ (3 m × 1 m) in the center floor panel. The result resembles Figure 3.11.

   There’s no limit to the number of interior sketches you can create. Click the green check to finish editing when complete. You can also edit previously created sketches by selecting the opening and clicking Edit Boundary from the ribbon.

   An opening of this type remains perpendicular to the slope of the floor, roof, or ceiling. On the other hand, a vertical opening remains perpendicular to the level on which it was created.

3. Select the Vertical tool from the Opening panel, and sketch a new opening of the same size and dimensions above the first one. The result resembles Figure 3.12.
FIGURE 3.11 The finished opening

FIGURE 3.12 Sketch a new opening of the same size and dimensions
The differences are subtle but very important. By creating a section through both openings, you can see the difference in an opening that remains perpendicular to the floor compared to one that remains perpendicular to the level (Figure 3.13).

Keep in mind that from a project-management standpoint, if you have a number of openings that are predictably shaped (circular, rectilinear, and so on), highly repetitive, and scattered throughout your project, you’re better off creating a host- or face-based opening (with parameters for options) as a family component and then loading it for use in your project.

**Creating Openings with Shafts**

For openings that occur from level to level and are vertically repetitive (such as a shaft or an elevator core), you can use the Shaft tool. This tool allows you to create openings in numerous floors, roofs, and ceilings quickly and easily. Continue the example as follows:

1. Add a few more levels to your project so you have 10 levels that are evenly spaced.

2. Select all three floors on Level 1, and copy them by pressing Ctrl+C. Now the geometry is ready to be pasted to each of the levels. The best way to do this is by using the Paste tool, which allows you to select all the levels to which you intend to paste the floors.
3. Select Paste from the Clipboard panel of the Modify | Floors tab, and then select Aligned To Selected Levels. You’re given the option to select all the levels: select Levels 2–10 (Figure 3.14). The resulting floors are shown in the same figure.

**FIGURE 3.14** Pasted geometry
4. Return to the Level 1 view, and select the Shaft tool from the Opening panel. Once again, you enter Sketch mode. Create a new $20' \times 3'$ (6 m $\times$ 1 m) rectangle perpendicular to the last two you drew. Be sure to modify the top constraint so the shaft goes up to Level 10. Also be certain to assign a Top Offset value, because the upper floor is slightly above the level (Figure 3.15).

**Figure 3.15** Creating a multistory shaft

Figure 3.16 shows the resulting shaft in 3D. All the floors were cut automatically. Any ceilings, roofs, and additional floors that may be added in the future will be cut automatically as well.
 FIGURE 3.16  The finished multistory shaft
Picking Walls

Pan a bit toward the right of the floors in the previous exercise. Start the next exercise by creating a series of walls on Level 1 that resembles Figure 3.17. Then, continue with these steps:

1. Select the Floor tool on the Build panel of the Architecture tab to enter Sketch mode. This time, you don’t want to sketch the boundary of the floor manually. There’s an easier way: select the Pick Wall tool from the Draw palette. Doing so allows you to select an individual wall or an entire chain of walls.

2. Hover over one of the wall edges, and then press and release the Tab key. Your selection cycles from one wall to the series of walls. When all of the walls highlight, select them with one pick.

   Note that the edge of the new floor is constructed where your mouse clicks when you pick the wall in reference to the interior or exterior of the wall. The floor goes to the outside of the wall; to do that, you have to pick the outside edge of the wall — otherwise, the floor aligns with the interior. The entire chain of lines is created that corresponds to all the walls.

   When using the Pick Wall tool, note the setting on the Options Bar for Extend Into Wall (To Core). By default when you pick a compound wall with multiple layers, the floor sketch will extend to the
Laying Out Roofs

There are two primary methods for creating a roof, which you will explore in this chapter: Roof by Footprint and Roof By Extrusion. You create a Roof by Footprint roof much like you do floors: from a sketch resulting from either drawn lines or picked walls. And as with floors, if you pick the exterior walls as a reference, then moving the walls will move the corresponding edges of the roof. Roofs can be created in elevation using the Roof By Extrusion tool (which we’ll get to in a bit).

Roofs tend to slope, for a lot of good reasons. Let’s create some roofs and investigate a few slope options.

Picking Walls

Let’s start by adding a roof to the same walls you used in the previous floor exercise. Follow these steps:

1. Return to your Level 1 plan view. Select the Roof tool on the Architecture tab, and choose Roof by Footprint. At this point, Revit Architecture automatically asks you to select the level with which this roof is associated; select Level 3. Don’t worry; you can change the level at any time later.

2. Again, you don’t have to pick all the walls individually or sketch all the roof boundary lines. Select the Pick Walls option on the Draw panel of the Modify Create Roof Footprint tab. Then hover over one of the exterior walls, and press the Tab key to select the entire chain. All the roof boundary lines are created.

   Note the icon with double arrows on the sketch lines for the roof: clicking it flips the boundary lines to the inside or outside of the wall face. Click this icon to move all the boundary lines to the inside of the wall’s faces.
3. Because this will be a sloped roof, you can make the slope perpendicular to the left edge by deselecting the Defines Slope check box located below the Modify panel for all the other lines.

4. Define the slope from the sketch line for the roof of the left edge with a 1/12 rise over run (about 8 percent).

5. Finish the sketch, and look at the project in 3D. Although the roof begins at Level 3 and has the proper slope, it's immediately obvious that the walls don't extend beyond the roof.

   Revit Architecture excels at helping your team during the design process with issues like this one. You can identify conflicts earlier rather than later so you can resolve them before other design issues create circular conflicts.

6. Select all the walls (using the Tab key to select the entire chain), and set Top Constraint to Level 4 in the Properties palette. The results resemble Figure 3.18.

   ![Figure 3.18](image)

   **Figure 3.18** Adjusting the wall height

**Creating Slope Arrows**

You can determine the slope of a roof using slope arrows. Slope arrows let you specify a slope, and they also allow you to specify the levels of the arrow at both the head and tail. Continue the example with these steps:
1. Select the roof, and click Edit Footprint on the ribbon to enter Sketch mode.

2. The tail of the slope arrow must reside on the boundary of the sketch, but the head of the slope arrow may point in practically any direction. Select the Slope Arrow tool on the Draw panel, and add a slope arrow as shown in Figure 3.19. Note that the Height Offset at Head value is set to 6' (2 m). Make sure you uncheck the Define Slope option for the edges of the roof to see the full effect of using the slope arrow.

![Slope Arrow](image)

**FIGURE 3.19** Sloping the roof

3. Finish the sketch. Notice that a single slope proceeds across the roof. A single slope in this direction would be nearly impossible to specify without slope arrows.

You can also create roof slopes using multiple slope arrows. This technique is incredibly helpful when you want to create sloped conditions where two perpendicular slopes must meet at exactly the same location. Again, this is something that’s difficult to do without slope arrows.

Let’s explore this topic by reentering Sketch mode with the previously created roof.
1. Delete the existing slope arrow by editing the sketch.

2. Sketch two new slope arrows along the north–south and east–west roof boundary edge so that the heads of the arrows meet at the upper-left corner. The slope arrow should have the following properties:
   
   - Set Height Offset at Tail to 0".
   - Set Height Offset at Head to 6" (2 m).

   Make sure Height Offset is the same for both Tails and Heads.

3. Finish the sketch. The results resemble the roof in Figure 3.20.

Another common condition in residential-styled roofs is multiple slopes that are perpendicular to their many edges. To create this condition in the example, follow these steps:

1. Reenter Sketch mode for the previously created roof, and delete both slope arrows.

2. Select all the lines that represent the roof sketch. You can do this by holding down Ctrl and selecting the lines individually or by clicking one line and pressing Tab to highlight the rest of the lines.

3. With the lines selected, in the Options Bar, enter 3' (1 m) for the overhang. The overhang direction will move positive in relation to the side of the wall picked (exterior or interior). Positive or negative
dimensions can be entered if needed. Also keep in mind that the overhang option is available only for roof sketch lines created using the Pick Walls option.

4. Select the Defines Slope option for all the boundary edges from the Properties palette. Also modify the Slope property for a slope of 9/12. The roof should look like Figure 3.21.

5. Finish the sketch. Initially, the edges of the wall extend beyond the overhang of the roof. Select all the exterior walls (use the Tab key), and then select the Attach Top/Base option on the Modify | Wall tab. The result resembles Figure 3.22.
6. The great thing about attaching walls is that if the roof’s angle or slopes change, the walls will automatically react to the new condition. To test this, reenter Sketch mode, and remove the Defines Slope option for one of the edges.

7. Finish the sketch, and the results resemble Figure 3.23. Because the walls were previously told to attach to the roof, the gable condition is already updated.

8. Reenter Sketch mode, and enable Defines Slope for the same gable sketch line. Select the sketch line, and locate the option for Plate Offset From Base in the Properties palette. Change the value to 6'-0" and finish the sketch. Notice the roof edge is offset from the base and the slope starts at the offset dimension. This is another powerful approach to modify the roof shape. You can reenter Sketch mode and reset the offset to 0'-0" for the next exercise.

Creating Extruded Roofs

In addition to being able to create roofs in a plan or footprint orientation, you can extrude roofs from vertically planer surfaces. To do so, follow these steps:

1. Select the Roof By Extrusion command from the Roof flyout on the Architecture tab. You’re immediately prompted to select the plane from which the extruded roof will spring. Select the roof face highlighted in Figure 3.24.
2. You’re prompted to associate the roof to the appropriate level. This step is important for scheduling purposes; you can modify the value later. For now, select Level 3 because it’s closest to the base of the extruded roof.

Next you’ll create the sketch for the extruded roof. The sketch line isn’t a closed loop; it’s just a line (or series of connected lines) that defines the top of the extruded roof. For this example, you’ll create an arc.

3. Select the Arc tool from the Draw panel.

4. Create the arc approximately as shown in Figure 3.25. The important detail is that you set Extrusion End in the Properties palette to 20'-0" (6 m).
5. Finish the sketch. The roof springs from the arc you created, but it’s not reaching back and connecting to the roof face. This issue is easy to resolve.

6. Select the roof, and then select the Join/Unjoin Roof option on the Geometry panel.

7. Hover over the rear edge of the extruded roof, as shown in the left image of Figure 3.26.

8. Select the face of the previously created roof that you want to connect to the extruded roof. The extruded roof now extends back to meet the face of the other roof (Figure 3.27). If either roof is modified, Revit Architecture will do its best to maintain this connected relationship.
We could talk about many other complex areas with regard to roofs, from point elevations to more instance and type parameters. But once again, this is beyond the space limitations for an introduction to Revit Architecture. Learning how to use Revit Architecture organically is a better approach: begin with the basics of design iteration and then build on these concepts as the need arises.

Adding Ceilings

Ceilings in Revit Architecture are easy to place as well as modify. As you move the walls, the ceiling associated to those walls will stretch to fit the new conditions.

The example in this section returns to the Level 1 floor plan of the previous exercise. Add 10'-0" (3 m) high walls and doors to create individual, shared, and open spaces (Figure 3.28). You’ll continue in the sections that follow.

FIGURE 3.28 Level 1 with walls
Creating Automatic Ceilings

The Ceiling tool is on the Build palette of the Architecture tab. When you select the tool, the default condition is Automatic Ceiling. This means as you hover over a space, Revit Architecture will attempt to find the boundary of walls. Follow these steps:

1. Let’s do this for the space at the bottom of the image (Figure 3.29). As you hover over the space, Revit Architecture indicates the boundary with a broad, red line.

![Figure 3.29](image)

2. As you can see from the Properties dialog, Revit Architecture offers four default ceiling types: one basic type and three compound types. Select the 2’ 2” (600 mm × 600 mm) system.

3. As you place the first ceiling in the floor plan view, you get a warning. This happens frequently and for good reason: you’ve placed the ceiling, but you can’t see it. As a rule, you shouldn’t ignore warnings. We’ve seen people click and click only to find that they’ve repeatedly placed ceilings in the same space.

   Go to the proper view in the Project Browser to see the ceiling — in this case, the ceiling plan for Level 1. Now you can plainly see the ceiling you’ve created.

4. Select the Ceiling tool on the Architecture tab, and pick inside the rooms to automatically place the remaining ceilings, as shown in Figure 3.30. Notice that Revit Architecture centers the grid based on the space you’ve selected.
Sketching Ceilings

Next you’ll place ceilings in the upper-left corner of the ceiling plan for Level 1, but this time you’ll share the ceiling between the two spaces. This practice is common in interior projects. The partitions extend only to the underside of the ceiling (rather than connect to the structure above). Follow these steps:

1. Selecting Sketch Ceiling on the Ceiling panel of the Modify Place Ceiling tab. Add sketch lines as shown in the first image in Figure 3.31. The result is shown in the second image.

2. Place a ceiling at the upper right in the plan, but this time sketch a 2' × 4" (1.2 m × 600 mm) system (Figure 3.32). Choose this new system from the Type Selector before you finish the sketch of the ceiling.
3. Create a GWB on Mtl. Stud Ceiling for the area shown in Figure 3.33.

By default, the GWB material doesn’t have a surface pattern. Although this material would be too graphically busy for walls, it’s fine for ceilings. So, let’s create a new material for GWB associated to ceilings and give it a pattern. For a more detailed overview of
materials, feel free to review to Chapter 9, “Materials, Rendering, and Visualization.”

4. Select an edge of the ceiling, and click Edit Type from the Properties palette.

5. Click the Structure Edit button from the Type Properties dialog to open the Edit Assembly window.

6. Locate the Finish layer, and then under the Material column, click in the cell for Gypsum Wall Board. Click the ellipsis (…) button that appears in the cell to open the Material Browser. Right-click and duplicate the existing material. Rename the new material Gypsum Ceiling Board.

7. Under the Material Editor section, locate Surface Pattern, and associate the surface pattern called Sand to the material.

8. Click OK until you close all the dialog boxes and return to the ceiling plan view. The result is shown in Figure 3.34. You can now distinguish the ceiling from the open areas that have no ceiling.

![Figure 3.34: Assigning materials to a ceiling](image-url)
Dealing with Bulkhead Conditions

Creating a bulkhead to separate two ceilings is straightforward.

1. Place the walls that will act as the bulkhead, as shown in Figure 3.35. Be sure to set the Base Offset value in the Properties palette of the walls to 7'-9" (2.3 m) and the Unconnected Height value to 2'-3" (700 cm). This creates two walls above head height.

2. The easiest method to edit a ceiling is to select a grid line and choose Edit Boundary from the Mode panel on the Modify Ceilings tab. If the ceiling type does not contain grid lines, you can hover over the edge of the ceiling and use the Tab key to cycle through options until the edge of the ceiling is highlighted. Modify the ceiling as shown in the first image in Figure 3.36.
3. Sketch a new GWB ceiling that is 9'-0" (2.7 m). The second image in Figure 4.36 shows the final ceiling shape before you will click Finish Edit Mode.

4. To get a better idea of the finished configuration in 3D, go to a 3D view and orient a section box of the Level 1 plan view. Right-click the ViewCube, and from the Floor Plans flyout of the context menu, select Level 1. Orbit the view or use the ViewCube to choose the desired angle. Then use the grip arrows to pull the boundaries of the section box to resemble Figure 3.37. You’ll find that working this way is helpful because having both 2D and 3D views aids in communicating any design issues.

![Figure 3.37 Orienting the section box to the 3D view](image-url)
Adding Lights and Rotating the Grid

Adding lights is easy, and because they're hosted by the ceiling, lights will often create openings for you. Let’s begin the next example by loading one of the lighting families using the file from the previous example.

1. On the Insert tab, select Load Family on the Load from Library panel. Browse and open the Lighting\Architectural\Interior folder, and double-click the family Ceiling Light – Linear Box.rfa.

2. Place a component, and the ceiling light family should be the default. Select the 2' × 4" type from the Type Selector. You’ll place lighting fixtures into the 2' × 4" ceiling in the upper-right ceiling plan.

3. The insertion point for the light is the center of the light. Place the first light, and then use the Align tool to move it into the right spot.

4. Use the Copy tool on the Modify panel to copy the first light based on the intersection of the ceiling grid. All the lights are shown in Figure 3.38 on the left.

5. To rotate the grid, select any grid line, and use the Rotate tool on the Modify panel to rotate it. In this case, specify a 10-degree angle. Notice that the lights rotate as well.

6. Click and drag the ceiling grid lines to better center the lights in the overall space. Again, the lights move with the grid. The Move, Align, and Rotate tools are all available to modify ceilings when a grid line is selected.

This technique is incredibly helpful for maintaining design coordination. The finished condition is shown on the right in Figure 3.38.
Changing the Ceiling

Ceiling types often change during the design process. In Revit Architecture, the ceiling type can be updated to reflect design changes at any time. Continue the previous example with these steps:

1. Select a ceiling grid line or the edge of the ceiling.

2. Pull down the Type Selector in the Properties palette, and select the GWB type for this ceiling (Figure 3.39). The result is shown in the left image in Figure 3.39.

Sloping the Ceiling

You can even slope the ceiling by placing a slope arrow while editing the boundary of the ceiling. This is basically the same process as sloping a floor or a roof.

1. Select a grid line or edge of the ceiling, and choose Edit Boundary on the Mode panel on the Modify Ceilings tab.

2. Place a slope arrow as shown at the left in Figure 3.40. Set the Height Offset values for the Tail and Head to 0 and 3’ (1 m), respectively.

3. Finish the sketch. The result (on the right in Figure 3.40) is shown in 3D using a section box. The lights even follow the revised ceiling slope!
**The Essentials and Beyond**

In this chapter, you learned to create floors, lay out roofs, and add ceilings.

**Additional Exercises**

- Create a mass and intersecting levels, and then create mass floors from those levels. Use the mass floors to create floors using the Floor By Face tool.
- Modify the mass from the previous exercise, and update the floors created with the Floor By Face tool.
- Create a shaft opening, and intersect it with all the floors created by the Floor By Face tool from the previous exercise.
- Create a roof or floor, and then use the Shape Editing tools to model slopes for drainage.
Stairs, Ramps, and Railings

*The Autodesk® Revit® Architecture* software is capable of creating wonderfully complex and elegant railings, stairs, and ramps. In Revit Architecture, these elements are created and controlled with separate tools, but they can be just as easily combined to form elegant design solutions.

In this chapter, you learn the following skills:

- Creating stair configurations
- Designing ramps
- Building railings for level and sloped conditions
- From basics to creative art

Creating Stair Configurations

Stairs contain many, many parameters, but not all of the parameter controls are equally important during the design process. Design is often about the intent of what something is as well as where it is meant to go. Once the intent is resolved, it’s necessary to go back and revise the specifics of how something will be carefully assembled.

Revit Architecture 2013 introduced a new stair tool. This tool allows you to divide your stair into *assemblies* to better define and break down the various elements that make up the stair. This tool is a big departure from the original stair tool in Revit Architecture. Fortunately, if you’re working
with experienced teams, Revit Architecture includes both the new and old stair tools to provide maximum flexibility for your design process. Revit Architecture 2014 expands on the assembled stair tool, focusing on additional usability enhancements. You’ll learn how to use both tools to create a set of stairs.

Because the tools for railings, stairs, and ramps are somewhat separate, you’ll begin the stair by first creating a simplified railing. This way, when you create a series of stair configurations, you’ll have a new, default railing to apply to each of them.

Creating the Generic Railing

Begin by opening the default architectural template and expanding the Family tree in the Project Browser. You’ll start by creating a railing that is useful from a design standpoint. Too much specificity too soon can cause a lot of confusion, so you’ll simplify the geometry. You’ll do this by duplicating a railing definition that’s close to what you need and then modify it to suit your purposes.

Here are the steps for duplicating and creating your own custom handrail that you’ll use for designing stairs:

1. Open the default 3D view by selecting the small house icon on the Quick Access toolbar (QAT). Select the Architecture tab, and choose the Railing flyout from the Circulation panel. Select the Sketch Path option to enter Sketch mode.

2. Before you draw a railing, let’s create a new type. Select Edit Type from the Properties palette, select Handrail – Rectangular, and click Duplicate in the Type Properties dialog box. Name the new railing Handrail – Design, and click OK to exit all the dialog boxes.

3. Draw a line approximately 30' (10 m) long. This line will define your railing.

4. Click the green check in the Mode panel to finish the sketch and create the railing. This is the default rail in Revit Architecture (Figure 4.1).

Because railings (such as walls and floors) are system families, you have to modify the ones that Revit Architecture gives you rather than create your own in the Family Editor. To create your railing, you’ll modify the one you just created.
1. Select the railing, and choose Edit Type from the Type Selector to open the Type Properties dialog, as shown in Figure 4.2.
2. Click Edit for the Rail Structure (Non-Continuous) parameter. In the resulting dialog box, shown in Figure 4.3, delete Rail 1 through Rail 5 by selecting each line (such as Rail 2) and clicking the Delete button. Doing so eliminates all the horizontal rails under the top rail. Close the dialog box by clicking OK. Since Revit Architecture 2013, the top rail is controlled by its own parameter in the main Type Properties dialog box.

![Figure 4.3 Deleting railing types](image)

Next you need to edit the balusters.

1. In the Type Properties dialog box, click the Edit button for the Baluster Placement parameter.

2. In the resulting dialog box, find the Main Pattern panel, select the second line (Regular Baluster), and set its Baluster Family value to None.

3. In the Posts panel, set the Baluster Family value for the Start Post, Corner Post, and End Post To None parameters (as shown in Figure 4.4). This effectively eliminates any balusters from your railings.
4. Click OK to close the Edit Baluster Placement dialog box, and click OK again to close the Type Properties dialog box.

Now you’ll create the “design” stair.

Creating Your Design Stair

As mentioned earlier in this chapter, Revit Architecture has two stair tools. The tools are located on the Architecture tab on the Circulation panel.

The more recent stair tool is called Stair By Component. As the name suggests, this tool will help you create stairs that can be broken down into their individual components for quicker detailing. In Revit Architecture 2014, this is the default stair tool on the ribbon. The original stair tool, Stair By Sketch, is located in the Stair drop-down.

It is important to note that the Stair By Component tool is relatively new and may not provide the breadth of design options that the original stair tool does. Because of this, it is important to understand how to create a stair using both tools. Depending on your project, you may find that one stair tool is better suited for a particular condition.
Creating a Straight-Run Stair

Let’s begin with the classic Stair By Sketch tool. Select this tool, and you’ll enter Sketch mode, similar to what you saw with the railing. Before you draw a stair, rename the default stair: click Edit Type in the Type Selector, click the Duplicate button in the Type Properties dialog box, and name the new stair Stair-Design. This is the stair you’ll use to create numerous configurations.

Swapping Out Family Types Is Easy

Note that stairs, railings, and ramps, like other system families, can be changed dynamically using the Type Selector. This process works the same for Revit Architecture component families. Suppose your design changed or you haven’t yet determined the exact stair type you will be using. At any point during the design process you can swap out one family type for another, and your stair as well as all your views will update accordingly. This is useful early on when you might know the location and dimensions of a stair but not necessarily the final specifications.

You’ll start by creating a straight-run stair.

1. From the Level 1 plan view, start the stair tool using the Run component. Pick a point to the left, and then move your cursor to the right. As you do, Revit Architecture tells you how many treads remain to complete a stair that starts on Level 1 and goes through Level 2 (Figure 4.5).

2. Select the Railings Type option in the Tools palette. Specify the Handrail – Design type you created earlier (Figure 4.6), and click OK. Revit Architecture will use this default handrail whenever you create this stair, until you specify another type.
3. Close Sketch mode by clicking the green check in the Mode panel. The resulting stair is shown in the default 3D view in Figure 4.7.

With the stair created, you’ll create another with the component stair tool. Begin by opening the Level 1 plan view and selecting the Stair by Component tool on the Circulation panel. Then continue as follows:

1. Before you pick a point to start constructing the stair, set the Location Line on the Options Bar. In this example, you’ll use
Exterior Support: Left. This will align the outside edge of the stair with your pick points.

2. From the Level 1 plan view, pick a point to the left and then move your cursor to the right as you did in the previous exercise. The tool behaves just like the Stair By Sketch tool, telling you how many treads remain to complete the stair.

3. The stair looks slightly different from the one created with the previous tool. Revit Architecture gives you the start stair count and the end stair count (Figure 4.8).

![Figure 4.8 Sketching the straight-run stair with the Stair By Component tool](image)

One of the nice features of component stairs is the ability to dynamically change the stair. Select the stair, and you see the familiar blue arrows (shape handles) used to drag objects. Select the bottom one, and drag it down to change the width of the stair. Also note the stair run shape handles correspond to the side you chose for the Location Line (Figure 4.9).

![Figure 4.9 Dragging the stair to change the width](image)

4. Click the green check to finish the stair, and open the default 3D view. You see your two stairs side by side.
Select the stair to see one of the other differences: you can select the classic Revit Architecture stair only all as one element. The component stair allows you to select the stringers separately from the treads by using the Tab key to cycle the selection. This type of stair allows you to change the properties and style of the stringers as part of their own family type (Figure 4.10).

![Image of stair component](image1)

**Figure 4.10** Modifying the stair stringer

### Creating a Straight-Run Stair with Landing

You just created the most basic type of stair: a straight run with a pair of railings. However, it’s important to understand how to create a variety of stair types, including stairs with landings.

1. You’ll start the sketch using the classic stair tool. In the Level 1 plan view, select the Stair By Sketch tool. Draw a straight run, but stop nine risers in — about halfway through the run.

2. Start the second run of stairs, as shown in Figure 4.11. When you finish the second run of stairs, Revit Architecture creates the landing between the two runs automatically.

![Image of stair with landing](image2)

**Figure 4.11** A second run of stairs and landing
3. You’ll now modify the width of these stairs. The green boundary line that runs perpendicular to the risers represents the stringer location and can be modified to change the width or shape of the stair. In this stair, assume that the lower run is a different shape than the upper run. Select the lower green boundary line. You see round, blue grips. Choose the one at the base of the stair, and drag it downward to create a triangle-shaped run. As you drag, notice that the black lines (which represent the treads and risers) lengthen with the boundary edge. If any of these lines does not connect to another line, your stair can’t be created. In Figure 4.12, each of the boundary lines is stretched except the first one.

![Figure 4.12 Modifying the stair boundary](image)

4. Resolve this gap by choosing the Trim tool from the Modify panel and selecting the boundary line and the black riser line. Doing so closes the stair. Click the green check to finish the stair.

5. Finish the sketch. The stair resembles Figure 4.13 in the default 3D view.

![Figure 4.13 Complete stairs with a middle landing](image)
Creating this same stair with the Stair By Component tool uses a slightly different approach. Open the Level 1 plan view again, and select the Stair By Component tool. The Components panel offers a toolkit that differs from that used for the classic stair. You have components for straight runs (default) but also full-step spiral, center-ends spiral, L-shape winder, and U-shape winder stairs. Follow these steps:

1. Because the stair you're creating is a straight run with a landing, leave the default selected. Before picking the start point, locate Actual Run Width on the Options Bar. You can specify a width for each run component. Let's change the dimension to 4'-0".

2. Start the stair similarly to the last run by clicking and then moving the mouse to the right until you've placed nine risers. Click again to end that run.

3. By moving the mouse further right, you can define the landing. Set Actual Run Width to 6'-0" (this will set the second run width only). Click to begin the second run of stairs, and click again to end it after you've placed all the risers. The full stair in Sketch mode so far looks like Figure 4.14.

4. Before finishing the stair, you'll adjust the size of the landing Revit automatically created. Select the landing, and notice shape handles are available for each edge. Drag the landing edge shape handle, and notice Revit adjusts the landing size while maintaining the run dimensions.

5. Click the green check to finish the stair.
6. For the last step, let’s add a stair tread/riser number annotation. Click the Annotate tab, and select Tread Number. Move the mouse over each of the recently created stair runs, and notice that a location line for the numbering appears. Click to add the numbers (these can be added in plan, elevation, and section views), as shown in Figure 4.15.

![Finished component stair](image)

**FIGURE 4.15** Finished component stair

### Creating Multistory Runs

For multistory runs, Revit Architecture is able to take a stair that goes between two levels and repeat it continuously. This will work only if all the level-to-level heights are identical. Create a multistory stair by following these steps:

1. You need to create some additional levels. As shown in Figure 4.16, open the South elevation, and click the Level tool on the Datum panel of the Architecture tab. Click the elevation and drag the mouse from left to right to place the level, taking care that the heights are equally spaced.

![Adding additional levels to the model](image)

**FIGURE 4.16** Adding additional levels to the model
As discussed earlier, you can change the level heights by clicking the blue elevation text. For this example, repeat the levels at 10'-0" (3 m) increments — up to 40'-0" (15 m). Figure 4.16 shows several stair types, including the ones you’ve created.

2. Creating a multistory stair works the same for each of the stair tools. Select one of the tools, and create a U-shaped stair. Select a start point for the stair, and mouse to the right. Click to select the top of this run. Now, move the mouse down, and create a run from right to left, parallel to the first run (Figure 4.17).

3. Before you complete the stair, you need to change the stair properties. In the Properties palette, each stair has a Base Level parameter and a Top Level parameter. Below those settings is the Multistory Top Level parameter. Because your stairs run from Level 1 to Level 2 and then repeat for the floors above, you need to change the Multistory Top Level parameter to Level 4 — or whatever your highest level is (Figure 4.18).
4. Once you complete the multistory stair, the stair quickly propagates across all levels (Figure 4.19). If you edit the stair or railings associated to the multistory stair, the entire multistory configuration changes as well.

![Image of completed multi-story stair](image)

**Figure 4.19** The completed multi-story stair

**Setting the Host Function for Railings**

By now you’ve noticed that railings have special relationships to stairs. By default, Revit Architecture creates railings at the same location as the boundary sketch of the stair. You can then select the railing and modify its sketch to suit a particular condition. It’s important to understand that railings are hosted by stairs, and this relationship allows railings to follow the path of the stair.

So, let’s create another stair that’s wider than the stairs you’ve created thus far to work with the railings a bit more. Also, remember to use the Pick New Host tool to host the railing to the stair. Here are the steps:

1. Create the stair shown in Figure 4.20 using either stair tool. Notice the landing as well as the extra width that will easily allow traffic in both directions. Finish the sketch by clicking the green check on the Modify tab of the ribbon.
2. Add two separate railing sketches using the Sketch Path tool: one for the lower run and another for the upper run. Choose the Handrail – Design railing you created earlier in this chapter. Each of these railings is created out of three separate line segments: the railing and the railing extension at either end.

In Figure 4.21, each dimension represents a different line segment. Because railings must be created as continuous lines, each set of lines must be created separately. Once you’ve created the set on the left run, finish the sketch and create the right side.
3. Once you’ve created the railing and completed the sketch, you need to host the rail to the stair. Select either rail, and click the Pick New Host icon on the Tools palette; then select the stair. It highlights when you hover over it.

4. In Figure 4.22, notice the railing under the stair. This is the unhosted railing. The railing running down the center of the stair is the first railing you’ve hosted to the stair. Select the upper rail and, using the Pick New Host tool, host it to the stair as well.

One final note—not only is hosting important for railings and stairs, but it’s also something you’ll deal with when creating ramps and sloped floors.

**Designing Ramps**

Now that you’re familiar with designing a number of stair configurations, ramps will come easily since they are based on the Stair By Sketch tool. It’s the same basic process of sketching a desired shape and then completing the sketch, with one major difference: far more frequent landings and a shallower slope.

You access the Ramp tool on the Circulation panel on the Architecture tab. Keep in mind that ramps have different constraints than stairs based on slope and length. Understand that the maximum length of a ramp in one section is 30'-0" (9 m) with a 1:12 slope (8 percent). These parameters can be changed, but by default they correlate to common code requirements.
Creating a Straight-Run Ramp

Let’s start by creating a ramp in a straight run. Because you’re traversing Level 1 to Level 2 (and they are 10’ [3 m] apart), this will require a ramp length of 120’ (36.5 m) at a maximum 1:12 slope, not including landings. You’ll be limited to runs of 30’ (9 m) in length. So, you know that four runs will be required, with three landings.

1. Sketch the straight runs as shown in Figure 4.23. To get all the landings and ramps into the right location, you can select them as if they were linework and move them using the Move tool on the Modify panel.

![Figure 4.23 Straight runs of ramps](image)

Note that the run lines that indicate slope vs. landings are different. Blue lines indicate slope, whereas black lines indicate level landings.

2. Apply the Design – Handrail railings using the Railing tool, and then finish the sketch. You see something like Figure 4.24, which displays the results in 3D.
The process is the same as that for all the other stair configurations you’ve created. Multistory rules are permitted, and you must use the Set Host function when creating additional railings.

**Editing Boundary Conditions**

Editing boundary conditions of both stairs and ramps typically modifies the railings associated with those elements. Let’s test this now with the ramp you just created.

1. Return to Level 1, select the ramp, and enter Sketch mode by clicking the Edit Sketch button on the Modify context tab.

2. Delete the three green boundary lines that represent the outside edge of the landings, as shown in Figure 4.25.
3. Select the Boundary tool on the Draw palette, and then choose the Tangent Arc tool on the Draw panel.

4. Create the new boundaries shown in Figure 4.26 by picking one boundary edge and then the other. Then finish the sketch.

The finished ramp is shown in 3D on the right in Figure 4.26. Revit Architecture has already modified the railings to accommodate the new boundary.
Building Railings for Level and Sloped Conditions

Sketches for railings must consist of a series of connected lines — sketches with gaps or overlapping lines aren’t permitted. Sketches that cross or fail to intersect properly will also produce an error message. Both sketches shown in Figure 4.27 will generate errors and will not be completed.

![Figure 4.27](image)

**Figure 4.27** A doesn’t join; B crosses itself

If you attempt to complete railings like either of the ones in Figure 4.27, you’ll get the warning shown in Figure 4.28.

![Figure 4.28](image)

**Figure 4.28** Error for railings that can’t complete
Like ramps, floors can also be sloped, so you’ll create this condition as well.

1. Open the floor plan, Level 2, and create a floor using the Floor: Architectural tool on the Build panel of the Architecture tab. Create the floor boundaries shown in Figure 4.29. If you need to review how to create floors, please refer to Chapter 3, “Floors, Roofs, and Ceilings.” Don’t complete the sketch just yet.

![Figure 4.29 Creating a floor](image1)

2. Select the Slope Arrow tool on the Draw panel, and then pick two points: first to the left and then to the right in the center of the floor sketch.

3. In the Properties palette, set the Height Offset At Tail value to 0'-0".

4. Set the Height Offset At Head value to 3'-0" (1 m). Your floor should resemble the one shown in Figure 4.30 with the associated slope arrow.

![Figure 4.30 Adding the slope arrow](image2)

5. Finish the sketch by clicking the green check in the Mode panel. This creates a floor with a 3' (1 m) slope.
Using the Set Host Function

Next, you’ll add a curved railing that follows the slope of the floor.

1. Select the Railing ➞ Sketch Path tool on the Architecture tab, which places you in Sketch mode.

2. Select Pick New Host on the Modify tab, and then select the floor you just created. You’ll need to select the edge of the floor to pick it.

3. Create a curved sketch for the railing, as shown in Figure 4.31. Then finish the sketch by clicking the green check.

The railing now follows the path of the floor, even if you change the configuration of the railing sketch or the floor’s slope direction. You can also swap out different railing types using the Type Selector; Figure 4.31 shows one of the other default railing types in Revit Architecture.
Editing the Top Rail

For the last exercise in this chapter, you'll edit the top rail path at one side of the multistory stair you created earlier.

1. Hover over the rail, press the Tab key once, and then click. You should see the Continuous Rail panel on the ribbon.

2. Click Edit Rail on the ribbon, and select Edit Path.

3. Choose a draw panel shape.

4. Then sketch any desired shape at either the start or end of the railing, as shown in Figure 4.32. When that's complete, click the green check to finish editing.

If you want to download the completed Revit Architecture file created during this chapter, it's available from the book's companion web page. The file is named c04_Stairs_Ramps_Railings_End.rvt.

From Basics to Creative Art

Keep in mind that what you start with can be quickly and easily swapped out with more complex configurations and designs later. The important thing during design is that you resolve what something is and where it is. Then, after the initial design is approved, you can return to your intent and begin to specifically resolve the details and how it will be assembled.
Revit Architecture can be used to create incredibly complex and compelling stairs and railings! Creating these types of system families is discussed in depth in *Mastering Autodesk Revit Architecture* (Sybex, 2012).

Again, don’t get ahead of yourself. Concentrate on the basics. Once you have those down, you’ll be able to create far more detailed stairs, ramps, and railings.

Stairs and railings can be architectural works of art, and Revit Architecture gives you the tools to be really creative with them. The following is an example of what you can create if you stretch the limits of the stair tools. Your stairs can be elegant and versatile. The image at the bottom left is a very creative use of the stair tool — an elevated railing system! The bollards hold up the track (which is the railing).
The Essentials and Beyond

You can use the default stairs, railing, and ramp tools to create the vast majority of standard conditions during your early design processes. Because this book is about “getting started,” we don’t want to get too far ahead of ourselves. One day at a time!

Additional Exercises

▶ Try to create any of the stair configurations shown in the following graphics. Everything you need is in the default file; you won’t have to load any external content. Just create and modify new stair types.

▶ The stair in the first graphic is actually two separate stairs that share half a landing, but they appear to be a single stair that splits at the landing. They’re a combination of straight and curved sections. In some cases, you’ll need to sketch boundary and riser locations manually as well as reconfigure railing sketches.

(Continues)
Adding Families

*What is a family* in the Autodesk® Revit® Architecture software? In the simplest terms, a family can be thought of as repeatable geometry for use in a project. You will now take a step back from the modeling exercises in the previous chapters to develop a better understanding of the basic building blocks that make up a Revit Architecture project.

In this chapter, you learn the following skills:

- Understanding the model hierarchy
- Working with system families
- Working with component families

**Understanding the Model Hierarchy**

In Chapters 2 (“Walls and Curtain Walls”), 3 (“Floors, Roofs, and Ceilings”), and 4 (“Stairs, Ramps, and Railings”), you learned about some basic model elements such as walls, floors, and roofs. These types of objects are known as *system families* in the Revit Architecture software. To better explain what a family is and how it relates to your workflow, let’s explore how data is organized in the Revit Architecture platform.

One of the unique characteristics of the program is its inherent model hierarchy. In a simple description, this hierarchy can be expressed as (from broad to specific) project, category, family, type, and instance.

**Project**  This is the overall container for the model geometry and information.

**Category**  This is the structure of the content that will be placed in the project. This is how the Revit Architecture software ensures consistency and manages the behavior of elements such as how a door interacts with a wall. You also use categories to manage graphic display and visibility of elements.

**Family**  Similar to blocks in AutoCAD, families are the basis of geometry you create in a Revit Architecture project. An example might be a six-panel door family (you can find this family in the default Imperial Library in the Doors folder as Single-Panel 4.rfa).
**Type**  This is a repeatable variation within a family. For example, each type in a six-panel door family could have size or material variations without duplicating geometry. For example, the door panel extrusion could adjust size based on the door type width.

**Instance**  This is an actual element you place in the project model. For example, door 607 may be the 25th instance you’ve placed in the project of the 36 × 80 Wood type of the 6-panel door family.

Let’s take a quick look at this hierarchy by examining a sample Revit Architecture project file. First download and open the file c05-Model-Hierarchy.rvt from this book’s web page at www.sybex.com/go/revit2014essentials. In the following exercise, you will modify some display properties throughout the entire project using Object Styles, then change the settings of one view using the Visibility/Graphics dialog, and lastly change the settings of one instance using Override Graphics in View By Element:

1. Go to the Manage tab’s Settings panel, and click Object Styles. The categories you see in the Object Styles dialog box (Figure 5.1) are those that are established by the software and cannot be changed. You can use these categories to modify the display characteristics of elements, but you cannot edit the names of categories.

![Object Styles dialog box](image)

**Figure 5.1** Categories are listed in the Object Styles dialog box.
2. On the Model Objects tab, find the Walls category, and click in the Line Color field to open the Color dialog box. Set the line color to Red, and click OK.

3. Click OK to close the Object Styles dialog box. All walls in the project (even in the Level 2 floor plan) are now displayed with red lines instead of black.

4. Activate the Level 1 floor plan, and press VG on your keyboard (this is the keyboard shortcut for the Visibility/Graphics command, located on the View tab of the ribbon).

5. In the Visibility/Graphics dialog box on the Model Categories tab, find the Doors category, and place a check under the Halftone column.

6. Click OK to close the dialog box. Doors are now displayed in the Level 1 floor plan as halftone, yet they are still displayed normally in other views.

7. Select one of the halftone doors, right-click, and select Override Graphics In View ➤ By Element.

8. Uncheck the box for Visible, and click OK to close the dialog box. This door instance is no longer visible in the Level 1 floor plan, yet other door instances are still visible in this and other views.

**NOTE** Use Reveal Hidden Elements to view the door and set visible again if needed.

In the preceding exercise, you made changes to objects on three levels. Object Styles is a project-wide change for the selected category. The Visibility/Graphics dialog is a view-specific override for the selected category. Override Graphics in View ➤ By Element is a view-specific override for an instance of the selected category.

### Assigning Families to Categories

So, how do families get assigned to specific categories? A family's category is determined when it is created. To explore this without an actual lesson on creating families, let's walk through the first few steps to gain an understanding of the fundamental concepts.

1. From the Application button, click New ➤ Family. The New Family – Select Template File dialog box opens (Figure 5.2).
The list of family templates is consistent with the list of categories you saw in the project environment (Object Styles, Visibility/Graphics). Each of the available family templates is preconfigured for a specific category in terms of properties, basic materials, and reference planes.

2. Select Plumbing Fixture.rft, and click Open. The Revit Architecture user interface changes slightly to what is known as the Family Editor. Although some training materials may use this term, we must clarify that the family-editing mode is still within the main Revit Architecture application.

3. Go to the Create tab’s Properties panel, and click the Family Category And Parameters button. The Family Category And Parameters dialog box opens (Figure 5.3); it shows the category to which the family is assigned (Plumbing Fixtures).
Note that you have the option to change the category of a family before loading it into a project; however, we do not recommend frequent manipulation of a family's category. Such changes may have adverse effects on both the family and the projects into which it may be loaded. For example, it wouldn't make much sense to change a plumbing fixture family to the Doors category, because the template geometry and parameters are quite different and you may disrupt style and visibility settings in the project environment.

Revit Architecture uses two main types of families: system and component. System families exist only in the project file, whereas component families are created and stored as RFA files outside the project environment. A third type of family, known as an in-place family, should be used only for unique, one-of-a-kind objects for which you require nearby geometry as a reference to design. We will further discuss in-place families later in this chapter. There are both 2D and 3D types of system and component families; in the following sections, we will explore these family types in greater detail.
Working with System Families

The best way to characterize system families is to consider them the hosts for other types of geometry. 3D elements such as walls, floors, ceilings, and roofs allow other elements such as doors and windows to exist on them or in them. Other 3D elements, such as stairs and railings, are also system families.

System families are unique in that they create geometry by using a set of rules applied to guiding geometry. If you think about a simple wall, for example, its thickness is defined by a series of structural layers (framing, sheathing, and finishes), its length is expressed by a linear path, and its height is established by some set of horizontal boundaries (either a datum or another element like a roof). As another example, a floor’s thickness is defined by a series of structural layers, its vertical location is determined by a datum (level), and its boundary extents are defined by a series of lines. In the project, these rules are the instance and type properties.

Some system families are 2D. These types of system families include text, dimensions, and fill regions. Although the 2D variety of families are still considered system families, we think they are better referred to as project settings to avoid confusing them with the more common understanding of families.

Loading System Families

Because system families exist only in the project environment, there are only a few ways you can load them between projects. The first method is to use the Transfer Project Standards command. This method transfers all the families and types in a selected category between projects.

A more informal method of transferring system families is to use the Windows clipboard functions and copy/paste content between projects. This method is useful if you want to load a limited number of specific families into your active project.

Although it isn’t an active loading method, the final technique to manage system families is to include them in your project templates. After you establish a level of comfort with working in Revit Architecture, you will begin to customize your own templates, thus minimizing the amount of loading required throughout the design and production process.

Let’s explore the Transfer Project Standards command with the following exercise. You should already have the file c05-Model-Hierarchy.rvt open. If not, download it from the book’s website. Then follow these steps:
1. Keep the c05-Model-Hierarchy model open, and create a new project using the default architectural template.

2. In the new project, go to the Manage tab's Settings panel, and click Transfer Project Standards.

3. In the Select Items To Copy dialog box, click the Check None button, and then select Text Types and Wall Types from the list, as shown in Figure 5.4. Make sure c05-Model-Hierarchy.rvt is shown in the Copy From drop-down in this dialog box. It is important to verify this if you have more than two project files open.

4. Click OK, and choose Overwrite if prompted to close the dialog box and complete the transfer.

5. Start the Wall tool from the Home tab in the new project, and locate the transferred wall types that begin with c05. Create some wall segments with these types.

Placing System Families

Whether you are working with system or component families, we must clarify that you don’t ever place a family. You always work with types, whether you are
choosing an element in the Type Selector or using any other method. System families really don’t lend themselves to being placed. Instead, they are the result of using unique commands such as Wall, Floor, and Ceiling. That said, there is an alternative method for placing any kind of family—system or component.

Follow these steps to explore placing a system family:

1. In the Project Browser, toward the bottom of the list, expand the Families heading.
2. Expand the Walls category, and you see three values: Basic Wall, Curtain Wall, and Stacked Wall. These are the three families of walls contained within a project.
3. Expand the Basic Wall list, and you see all the wall types in the Basic Wall family. Using the mouse pointer, drag the wall type named Exterior – Brick on CMU from the Project Browser into the view window. Alternatively, you can right-click the wall type and select Create Instance.
4. The Wall command has been activated using the selected wall type. Draw some wall segments, and then press the Esc key to exit the command.

Working with Component Families

The second type of family you need to understand is the component family. These types of families live outside the project environment in RFA files and consist of everything from doors and windows to furniture and equipment. You might think of component families as anything that would be manufactured away from the job site and delivered for installation. This is in contrast to the aforementioned system families, which can be thought of as anything that is assembled at the job site.

Similar to system families, there are also 2D view–specific versions of component families including tags, symbols, detail components, and profiles.

Tags These component families are scale-dependent annotations that contain what are known as labels (the equivalent of block attributes in AutoCAD). Labels are special text elements that report information from model elements. Remember, the information (number, name, keynote, and so on) is stored in the component — not in the tag. Tags are attached to system or component families in the project.
Symbols (Generic Annotations) These component families are scale-dependent annotations that can also contain labels (similar to a tag). The main differentiator between symbols and tags is that symbols can be placed freely and do not need a host in the project. Symbols can also be loaded and used in other families such as tags.

Detail Components Used in drafting views or to embellish model views, detail components can be used as a more intelligent alternative to simple drafting lines. These components can be tagged or keynoted as if they were model components. You will find much more information on detailing in Chapter 11, “Details and Annotations.”

Profiles Profile families consist of a simple outline of a shape. They are used only in conjunction with other system families such as railings, wall sweeps, and curtain-wall mullions. After you create a profile family, it must be loaded into a project and then associated with a respective system family. A profile’s function must be defined in the family parameters (Figure 5.5).

![Figure 5.5](image)

**Figure 5.5** Defining a profile’s function

Loading Component Families

You can use several techniques to load component families into a project. The first method is to launch the Load Family command from the ribbon. When you activate any component-based command such as Door, Window, or even Component, the Load Family command will be available toward the right end of the ribbon. You can also find the Load Family command on the ribbon’s Insert tab. Remember, you can select multiple files in the Load Family dialog box (Figure 5.6) by using the Ctrl key when selecting files. If you choose to load multiple files during a component command, you may need to select a family and type from the Type Selector before placing the content in your project.
Another method to load families is dragging and dropping from any folder on your computer into the Revit Architecture window. For example, download the c05_Face-Based_Box.rfa file to your computer, and then drag and drop it into the c05-Model-Hierarchy project. (This family will be used in the next exercise.) Like with system families, you can also use the Windows clipboard functions and copy/paste component families between open projects.

Finally, you can load component families into your project templates the same way you loaded system families. Once families are loaded into a project, you can place them by starting one of the component commands or simply by dragging them out of the Project Browser and into a view window.

Using Hosted Families

For 3D component families, one key distinction you should understand is whether a family is hosted. How do you know whether a family is hosted or unhosted? A simple way to find out is to observe the mouse pointer when a component command is activated. Let’s explore this with a quick exercise.
1. Open the c05-Model-Hierarchy.rvt file, and activate the Level 1 floor plan.

2. From the Architecture tab, select the Door tool, and select any door from the Type Selector.

3. Hover the mouse pointer anywhere in the view window, but not near a wall. The mouse pointer displays an icon indicating you cannot place a door without an appropriate host: a wall.

4. Go back to the Architecture tab, and select the Component tool. From the Type Selector, choose Chair-Stacking.

5. Move the mouse pointer to any location in the Level 1 floor plan. The Chair-Stacking family can be placed anywhere because it is unhosted.

The main limitation to a hosted family is that it cannot exist without its host. Certain component families, such as doors and windows, must be hosted because their behavior dictates that they cut their host geometry when placed. For example, you can see this when creating a new door or window family. Notice when opening the family there is also a system family wall, which serves as the host.

Other components, such as furniture, plumbing, and light fixtures, may not need to be modeled as hosted components. These types of objects are placed in a model and almost always maintain a reference to the level on which they were placed. Notice in Figure 5.7 that the selected chair has a Level property designated as Level 1.

**Figure 5.7** Examining an object’s level assignment
In the following exercise, you will observe the consequences of using hosted components and an unhosted alternative:

1. Open the `c06-Model-Hierarchy.rvt` file, and activate the Level 2 floor plan. Also download the files `c05-WC-Hosted.rfa` and `c06-WC-Unhosted.rfa`.

2. On the Architecture tab, select the Component tool, and then click Load Family in the ribbon. Navigate to the location of the downloaded family files, and load the `c05-WC-Hosted.rfa` file.

3. In the room at the upper right in the layout, place two of the `c05-WC-Hosted` families on the wall at the left side of the room (Figure 5.8). Notice that you can place these components only on a wall.

![Figure 5.8 Placing hosted components in a model](image)

4. Click the Modify button on the ribbon or press the Esc key to exit the command, and then move the host wall to the left and right. Observe how the components move with the wall.

5. Delete the wall segment where you placed the components in step 3 (indicated in Figure 5.8).

   The hosted plumbing fixtures are automatically deleted when the wall segment is deleted. Let’s continue the exercise, but you’ll use an unhosted version this time.
6. Start the Component command again, and click the Load Family button. Navigate to the c05-WC-Unhosted.rfa file, and load it into your project.

7. Place two c05-WC-Unhosted families along the southern wall of the same room, as shown in Figure 5.9.

![Figure 5.9: Placing unhosted components in a model](image)

8. Click the Modify button on the ribbon, select the two fixtures, and then move them 3" (75 mm) away from the wall.

9. With the two fixtures still selected, go to the Options Bar and select the Moves With Nearby Elements setting.

10. Move the host wall in the north-south direction, and observe that the fixtures display the same behavior as the hosted versions.

11. Delete the wall segment where you placed the components in step 7 (indicated in Figure 5.9). The fixtures remain.

We realize that you may not fully understand how to convert a hosted family into an unhosted family; however, with this introductory knowledge, we hope you will continue to model effectively and efficiently as you develop your skills. You can find more detailed skill-building exercises related to families in Mastering Revit Architecture 2014 (Sybex, 2012).
Using Face-Based Families

A slightly different version of a hosted family is known as a *face-based family*. These types of families can be placed on virtually any surface or work plane, but they don’t suffer the same limitations as hosted families. Face-based families can exist without a host element even after a host is deleted.

Let’s experiment with face-based families. Continue to use the c05-Model-Hierarchy.rvt file from the previous exercise.

1. Activate the default 3D view, and you see the extents of the sample project, including a sloping roof. On the Architecture tab in the ribbon, select the Component tool.

2. The c05_Face-Based_Box family should already be loaded in your project from a previous exercise. If you can’t find it in the Type Selector, click Load Family and load it into the project.

3. Place a few instances of the face-based box family around the project — on the roof and on vertical wall faces. Notice in the ribbon that the default placement method is Place On Face. If you try to place an instance on the ground plane (Level 1), you are not allowed to do so.

4. In the ribbon, change the placement method to Place On Work Plane, and then try placing some instances outside the building envelope (Figure 5.10).

![Figure 5.10 Placement of face-based families](image-url)
Using In-Place Component Families

In-Place component families are a special type of component family unique to the current project. They are created in the project environment vs. the Family Editor, so project geometry can be used as a reference. They do not exist outside of the current project. The command is located on the Architecture tab’s Component drop-down; it’s called Model In-Place.

The major difference between in-place component families and component families is in regard to multiple instances. When component families have multiple instances in the project, updating the family geometry will update all instances. In-Place component families do not support multiple instances of the same family. For this reason, they should be used only for unique geometry since a copy of an in-place component has no relationship to the original (and will not update with changes to the original instance).

Finding Content

Now that we have reviewed the fundamentals of Revit Architecture families, we’ll discuss one of the most important issues you may face as you start designing: the discovery of suitable content. The best place to begin is with the content installed with Revit Architecture. These default families are created with relatively simple geometry and should be sufficient as a basis for the most common building types. If you installed Revit Architecture with the default settings, you will be able to access the default library whenever you use the Load Family command.

On the Insert tab, click the Load Family tool. In the Load Family dialog box (Figure 5.11), the default libraries are shown as shortcuts on the left side.

![The Load Family dialog box](image)
In addition to the default Revit Architecture families, various online resources provide content either free or for a fee. We have created a listing of the latest content websites on our blog, with descriptions of the content you might find on each site: www.architecture-tech.com/2011/12/bim-content-for-revit.html.

Autodesk has created an online resource called Autodesk Seek to provide content for its design software (http://seek.autodesk.com). You can search for families on Autodesk Seek directly from Revit Architecture. Let’s explore this option.

1. Go to the Insert tab’s Autodesk Seek panel.

2. In the search bar, type chairs, and press the Enter key.

3. Your default web browser opens to the Autodesk Seek website. The results displayed match the search criteria of chairs and are filtered to show only content that offers Revit Architecture families (Figure 5.12).

![Autodesk Seek](image_url)

**Figure 5.12** Content search results in Autodesk Seek
You will note on Autodesk Seek that you can choose from generic or manufacturers’ content. The generic content is similar to that found in the installed library. Other content should be used with a level of care. Although an exhaustive review of such criteria is outside the scope of this book, here are some aspects you should understand about component families:

**Avoid Imported Geometry**  Component families should not be created by simply opening an RFA file and importing 3D geometry from other modeling software. Content with imported geometry may also adversely affect functions such as rendering. For example, a light-fixture family using an imported CAD model might not have the correct material transparency to allow a light source to render properly.

**Watch for Over-Modeling**  Families should contain only the geometry necessary to document the component. That said, this level of modeling will be slightly different depending on whether you want to create a photorealistic rendering or a construction document. Excessive modeling such as fasteners, switches, knobs, dials, and so on, should be avoided.

**Use Appropriate Repetition**  A Revit Architecture family should have a moderate level of repetition built into it. The repetition should not be too complex (all possible variations in one family) or too simple (a separate family for each variation). Reasonable content will offer a family for each set of common geometry (for example, one model line of a light fixture) with types for subtle variations (the various lamping and size options of that light fixture model).

---

**The Essentials and Beyond**

Adding families to your project is easily done either by using the default family library that is provided with Revit Architecture or by creating your own. Now that you have a better understanding of how families work and the different family types, you can create a host of new elements for any project.

**Additional Exercises**

▶ Open a Generic model template. Modify the family category. What are some of the categories to which you cannot change the Generic model?

▶ Try loading other types of content, such as different window and door types. Tag these objects, and observe the difference in behavior.

▶ Locate all the instances of a particular family type by using Select All Instances.

▶ Try using copy/paste to transfer system families and component families between projects. Observe the differences in behavior.
Now that you have added a number of families to your project and the design has progressed, you’ll often find it necessary to modify the families. Sometimes swapping out a generic family component for one that is more specific is the best solution. In other cases, it’s simply a matter of opening the component family that you started with and tweaking the geometry to better fit your design. Either solution is viable — which you choose depends on the result that is better for your design process.

In this chapter, you learn the following skills:

▶ Editing view display and detail level
▶ Changing the family category
▶ Modifying family geometry
▶ Family tips and best practices

**Editing View Display and Detail Level**

As you learned in Chapter 5, “Adding Families,” finding and placing content is pretty straightforward, but learning to modify it will take a bit more time. One of the first things you want to consider when loading a family into your project is the level of detail the family displays at different orientations and scales. It’s not likely that every part of a component family needs to display at all scales. It’s more likely that too much detail will be confusing (particularly at smaller scales). Just a decade or so ago, when we used pencils, knowing when to stop drawing detail was pretty easy. But high-resolution computer displays that give you the ability to zoom in and out, as well as modern printing technologies, have allowed us to create far more detail than is necessary or meaningful. So, how do you display just the right level of detail in the Autodesk® Revit® Architecture software? In this chapter, we’ll explore some fundamental techniques you can use to modify families to meet your needs.
To complete the exercises in this chapter, download the file `c06_Modifying_Families_Start.rvt` from the book’s web page. To download other content you will create during this chapter, go to www.sybex.com/go/revit2014essentials. From there, you can download the family files `c06_Three_Light_Fixed.rfa` and `c06_L_Shaped_Handrail.rfa`.

First, go to the South elevation in the exercise project. Create a copy of the desk to the right of the first one. You can zoom to fit by right-clicking in the view and selecting Zoom To Fit. But this shows you everything only in your view — it doesn’t give you a sense of what is going to legibly print (Figure 6.1).

A great way to tell what will be graphically legible when you print is to select the Zoom Sheet Size option from the Navigation bar on the right side of the view. Doing so will take the scale of the view into account when zooming in (or out). The difference is shown in Figure 6.2. If you need to see what’s important in a view (and you don’t want to get carried away with details that don’t yet matter), this is a great tool.
Try changing the scale in the View Control Bar to 1/2" = 1' - 0" (1:20), and then click the Zoom Sheet Size button again. You will see a more visible difference in what is displayed on the screen relative to the scale of the view.

Notice in both the previous figures that the hardware on the desk is completely visible in both views — which is reasonable to expect. But let's see what happens when the view scale changes. Figure 6.3 illustrates the same desk in elevation at dramatically different scales (1' = 50' [1:50], 1' = 20' [1:20], and 1' = 10' [1:10], respectively).

**Figure 6.3** Elevation at different scales

**View Scale and Detail Level**

As you can see, all the geometry of the desk — drawers and hardware — is visible at all view scales. But it doesn't have to be this way. Our rule of thumb is that if two lines are overlapping to the point that they'll print like a single line, they probably don't need to be seen. Nor do you want your computer to expend processing power displaying, printing, and exporting information that isn't important. There are built-in settings for displaying information at different scales. You can find them on the Manage tab under Additional Settings ➔ Detail Level, as shown in Figure 6.4.
In the Detail View settings, you can choose which view scales use one of three detail levels: coarse, medium, or fine. Based on the scale of the view when a view is first created, some elements will automatically display or hide. But to take advantage of this power, you must make sure the content in your project has the appropriate view scale-to-detail level correspondence. You should also know that the Detail Level and View Scale parameters are separate properties of project views. As such, if you change the scale of a view, the detail level does not automatically change. The settings shown in Figure 6.4 are automatically applied only when a view is first created.

Let’s look at another common example. Create a default stair run, as shown in Figure 6.5. Then look at the stair in the South elevation at a couple of different scales (Figure 6.6).
Figure 6.6 illustrates three scales (1' = 100' [1:100], 1' = 50' [1:50], and 1' = 10' [1:10]). As you can see, the balusters show up at every level of detail — even to the point that they're displaying as a solid black blob! This isn’t the kind of graphic communication you want from your project.
The scale for each of the views illustrated is correct, but why isn’t the model geometry automatically hiding at the coarser scales? You must first ensure that the content is assigned to the appropriate detail levels in the Family Editor. Some library and template content will be configured correctly, but some families will require modification.

**Level of Detail**

In this section, you will modify the detail-level settings for the desk and stair examples and then reload them into the sample project. Let’s start with the desk.

1. Select the desk, and choose Edit Family from the Modify menu, or right-click and choose Edit Family from the context menu.

   When you open a family or use the Edit Family command from within a project, the user interface (UI) changes to offer you various tools and commands for developing families. This mode is known as the Family Editor.

2. Make sure the default 3D view is active, and select the hardware (the drawer pulls) on the front of the desk. You will need to press the Ctrl key to select both sets. Click the Visibility Settings button on the Modify tab of the ribbon to open the Family Element Visibility Settings dialog box.
This dialog box allows you to determine the visibility for both the orientation and level of detail for the hardware. As you can see, the hardware is already set to not display in plan view.

3. The hardware shows up at all levels of detail (Coarse, Medium, and Fine). Change the settings so that it only shows up at a Fine level of detail. Do the same for the hardware on the other side of the desk (Figure 6.7).

![Family Element Visibility Settings](image)

**Figure 6.7** Editing levels of detail for hardware

4. Select the faces of the drawers. Change the visibility settings so they show up at the Medium and Fine levels of detail (but not Coarse).

5. On the Modify tab of the ribbon, click the Load Into Project button to reload the desk family into the project. The results are shown at the same detail levels as before (Figure 6.8), but legibility has been increased.
FIGURE 6.8 The level of detail corresponds to scale
Next you’ll repeat the same procedure for the stairs. The trick is that the balusters are not editable by selecting the railings. Railings are a system family, so you have to select the family from the Project Browser.

6. In the Project Browser, expand the Families tree and then Railings. Right-click Baluster-Square, and choose Edit to open the family in the Family Editor.

7. Select the element on the screen, and click Visibility Settings on the Modify tab of the ribbon. Uncheck the Coarse detail level. Note that the Plan/RCP views are already unchecked, meaning the baluster will not display by default in those views.

8. Click Load Into Project on the Modify tab of the ribbon to reload the family into the project, and the balusters display only at the Medium and Fine levels of detail. You now see results in a much cleaner graphic display.

**Changing the Family Category**

Family components schedule according to their category, which is determined when you start to model a new family component. When you create a new family component, you must first select the appropriate template.

It is important to differentiate between the category of the family and the template that the family was created with. While the family category can be changed later, the type of host cannot be changed afterward. For example, several generic model family templates are available when creating a new family, such as the following examples:

- Generic Model ceiling based.rft
- Generic Model face based.rft
- Generic Model floor based.rft
- Generic Model roof based.rft
- Generic Model wall based.rft

If I start a new family with Generic Model floor based.rft, I can always change the category from Generic Model to Furniture. However, it is not possible to change the host from floor to wall-hosted. The Host family parameter is fixed according to the starting template.
Chapter 6 • Modifying Families

Editing the Family Category

For this exercise, select the face-based box that we provided in the previous chapter. It’s placed on top of the desk in this chapter’s sample project file. Follow these steps:

1. Right-click the face-based box, and choose Edit Family from the context menu.
   
   When the family opens, the box is resting on a large platform. Don’t worry about this — it’s the context for the “face” of the face-based family (Figure 6.9). Face-based and hosted families already have geometric context (along with critical parameters and reference planes) in their templates so you can model in context and test parametric behavior.

![Figure 6.9 Editing the face-based family](image)

When this component was initially created, it needed to be face-based. So, the default face-based template was used, which is Generic Model face based.rft. Since the family category has never been modified, it is still configured using the original Generic Model category. Now let’s assume the design has progressed and the component needs to schedule as Specialty Equipment. You will now take the steps necessary to change the family’s category.
2. Go to the Create tab’s Properties panel, and click Family Category and Parameters.

3. When the Family Category and Parameters dialog box appears, the current category is selected. Select Specialty Equipment from the list (Figure 6.10), and click OK.

![Family Category and Parameters dialog box](image)

_Figure 6.10 Changing the family category_

4. Click Load Into Project from the Modify tab on the ribbon to reload the family into the project environment; select the option to override the existing version. In a CAD environment, this step would be just like reloading a block — you’re simply updating the element with the new information. The family doesn’t appear to have changed, but it now schedules according to its new category.

**Editing the Insertion Point**

Another adjustment you may need to make is to change the insertion point of a family. This topic is important for three main reasons.
A family will flex around its insertion point; therefore, the insertion point is maintained when the family's dimensions change.

If you need to replace one family with another of the same category, they should swap at the same insertion point. Otherwise, if you have a family with an insertion point that is at a corner and swap it with another family whose insertion point is at the center, all the instances of that family throughout your project will shift.

If you need to adjust the default elevation when placing some types of families (such as wall-based families) you can change the reference elevation.

To solve this, you will edit the insertion point using two approaches in the following exercise:

1. For this example, go to the Level 1 plan view. Go to the Architecture tab’s Component flyout, and click Place A Component.

2. From the Modify | Place Component contextual menu, click the Load Family button; under the Furniture folder, choose the Chair-Executive.rfa family. Place it as shown in the left image in Figure 6.11, making sure the chair is centered under the desk's opening.

3. Select the desk. In the Type Selector, choose the 72" × 36" (180 cm × 90 cm) type. The changes in the desk dimensions are applied from the upper-right corner; therefore, the chair is no longer centered and will have to be moved. If there were many chairs and desks in this situation (such as in an office layout), this task would be very tedious! Let’s change the insertion point of the desk to avoid this situation in future design iterations.
4. Select the desk, and click Edit Family in the ribbon to open the desk in the Family Editor. Open the Ground Floor, floor plan view. The insertion point of a family is determined by any two reference planes that have the Defines Origin property. In the next step, you will change the reference planes with this parameter.

5. For each of the two reference planes indicated with arrows in Figure 6.12, select the plane and select the check box for the Defines Origin parameter in the Properties palette. You may need to press the Tab key several times while hovering the mouse cursor over the horizontal reference plane because of its close proximity to other geometry.

6. Click Load Into Project from the ribbon to reload the family into the project, and select Overwrite The Existing Version from the Family Already Exists warning dialog that will automatically pop up in your view. The family initially moves to align the old insertion point with the new insertion point, effectively relocating the desk. Select the desk, and move it back relative to the chair. Test different desk sizes. The family flexes with respect to the location of the chair (Figure 6.13).
7. The Defines Origin parameter can also be set in elevation for specific types of families, such as wall-based families. For example, this may be useful for wall cabinets where specifying an exact elevation for the top of cabinets is required.

In the sample project, select the upper cabinet family above the desk family, and click Edit Family in the ribbon to open the cabinets in the Family Editor.

8. Open the Placement Side elevation view, and select the reference plane at the top of the cabinets. Select the check box for the Defines Origin parameter in the Properties palette as you did for the reference planes earlier. Note the reference plane elevation is 6'-0" (1829 mm) above the floor line (Figure 6.14).

**FIGURE 6.13** Different-sized desks

**FIGURE 6.14** Elevation view’s Defines Origin parameter
9. Click Load Into Project from the ribbon to reload the family into the project, and select Overwrite The Existing Version as we did earlier. Open the Level 1 floor plan view, and place a new instance of the overhead cabinet family on any of the walls.

10. Notice the default elevation when placing an instance in the floor plan view matches the 6'-0" (1829 mm) elevation of the reference plane. If you select the family, there is an Elevation instance parameter in the Properties palette.

Changing this value will move the cabinet family in elevation relative to the reference plane you set in the Placement Side elevation view. So, in this example, you can enter a precise value for the top of the cabinets (Figure 6.15).
Modifying Family Geometry

Now comes the tricky part. Even though you’re just starting out and you won’t be expected to create new content from scratch, it’s likely that you’ll be expected to modify existing content that will become part of your project.

As the design progresses, generic elements that have been used as meaningful placeholders will, in many cases, need to be modified to include more detail. In other cases, existing context will be exchanged for components that are already detailed. So, let’s start editing components of different categories.

Editing the Family

Let’s begin by modifying a 2D element already placed in the sample project. Suppose that according to your firm’s graphic standards, the Furniture tag should have rounded sides. Go to the South elevation to see the Furniture tag (Figure 6.16). The chair you placed in the previous exercise has been temporarily hidden in the image for clarity.

Rather than create another Furniture tag for the project, you’ll modify the one already loaded and used in this chapter’s sample file.

1. In the Project Browser, expand the Families category and then Annotation Symbols. Find the Furniture Tag family, right-click it, and then select Edit from the context menu.

2. In the Family Editor, click the Create tab, and activate the Line tool. Choose one of the arc draw shapes and add lines to both sides of the tag. Delete the vertical lines, as shown in the middle image in Figure 6.16. Then click Load Into Project from the ribbon to reload the tag into the project and overwrite the existing tag.
It's really that easy. Every tag throughout the entire project is updated (see the right image in Figure 6.16).

You have just seen one reason you don't need to configure all your standards and settings in order to begin your first project. It's easy to update your entire project as it develops!

**Editing Profiles**

Now let’s revisit the default handrail profile you used when you created a default stair. Profiles are also located in the Project Browser under Families. Here are the steps:

1. In the Project Browser under Families, click to expand Profiles, and then right-click Rectangular Handrail. Choose Edit from the context menu; Rectangular Handrail opens in the Family Editor.

   Because you want to keep your existing handrail profile intact, from the Application button choose Save As, and name the new profile L Shaped Handrail.

2. There are some parameters that you want to maintain in this family. To make them visible, go to the Visibility/Graphic Overrides dialog box (type VG on your keyboard), and select the Annotation Categories tab. Select all the options, as shown in Figure 6.17, and click OK to close the dialog box.

   ![Visibility/Graphic Overrides](image)

   **FIGURE 6.17** Adjusting the Visibility/Graphic Overrides properties of the profile

   The profile view resembles the image in Figure 6.18.
3. On the Create tab in the ribbon, click the Line tool, and add new profile lines to resemble Figure 6.19. Note that the parameters for Width and EQ have been retained. Load the profile into your project; the L Shaped Handrail profile family is now listed in your Project Browser along with the other profile families.

   Now you will create a new railing type and associate the railing to the existing stair. The default railing type in the sample project is named Handrail – Rectangular.

4. In the Project Browser, select Families ➢ Railings ➢ Railing, and right-click Handrail – Rectangular. Select Duplicate from the context menu. The copy is named Handrail – Rectangular 2; right-click it, and select Rename from the context menu. Change the name to L Shaped Handrail.

5. You need to modify the properties of the railing to include the new handrail profile. To do so, right-click the L Shaped Handrail type in the Project Browser, and select Type Properties; or just double-click the L Shaped Handrail type.
6. In the Type Properties dialog box, select Edit from the Rail Structure option. Doing so opens the Edit Rails dialog box (Figure 6.20). Pull down the profile menu, and select the L Shaped Handrail profile, as shown in Figure 6.20.
7. The new profile has been associated to the duplicate railing. All you need to do is swap out the default stair railing for the new one! Select the handrails assigned to the stair, and then choose the L Shaped Handrail from the Type Selector in the Properties palette (Figure 6.21).

**Figure 6.20** Editing the type properties of the railing

**Figure 6.21** Selecting the new railing
Detail Components

Imagine the following scenario: you’re working to integrate your office standards into your project template, and the break line in the default library doesn’t match the graphic standards of your office. To get the match-line detail component consistent with your standards, begin by opening the break-line family in the Family Editor. Here’s how to make the changes:

1. In the sample project for this chapter, activate the South elevation. Double-click the blue arrow–portion of the section head. In the wall section, double-click the head of the callout at the top of the wall.

2. In the detail callout view is a default break line that you need to modify. Select the break line, and click Edit Family from the ribbon to open the family in the Family Editor.

3. Select the break line in the Family Editor, and then click Edit Boundary from the ribbon.
   This element is not a line (see Figure 6.22). It’s actually a masking region (kind of like a white solid hatch) that is used to obscure geometry in your project. Some of the boundary line styles are Medium Lines, and some are Invisible Lines.

![Figure 6.22 Editing the detail component break line](image)

4. Before you begin to modify the masking region, you should be aware of any constraints established in the family. Press **V** on the keyboard, or click the Edit button next to Visibility/Graphics Overrides...
in the Properties palette. Switch to the Annotation Categories tab, and check both the Dimensions and Reference Planes options. Click OK to close the dialog box.

5. In the View Control Bar, change the scale of the view to $1\frac{1}{2}'' = 1'-0''$ (1:10) so the dimensions are more legible. Use Zoom To Fit to see the extents of the constraints (Figure 6.23).

6. Delete the squared jag lines, as shown in Figure 6.24. Notice that the original boundary of the masking region remains displayed in the background for reference.
7. From the Create tab in the ribbon, click the Line tool, and make sure Subcategory is set to Medium Lines at the right end of the ribbon. Draw new jag lines, as shown in Figure 6.25. Make sure the lines you draw snap to the midpoints of the previous jag lines and the end points of the remaining straight lines.

8. Click the green check button in the Mode panel of the ribbon to finish the sketch.
9. Go to the Modify tab’s Properties panel, and click the Family Types button. Change the Jag Depth value to 0’ 6”, as shown in Figure 6.26, and then click Apply. The size of the jag in the masking region should change. Try a few different values for Jag Depth to make sure the masking region flexes correctly. Click OK to close the dialog box.

10. Click Load Into Project from the ribbon to reload the break line into your project. It updates in all views, as shown here.
Repeating Details

Repeating details are based on component families that are given rules to repeat, based on a defined spacing and rotation. As an example, elements such as brick or concrete masonry units (CMU) in a wall section are elements that repeat on a regular interval. Rather than use an array each time you need to draw these elements in a detail, the repeating detail component allows you to create persistent rules for these components. You can then draw a repeating detail with the ease of drawing a simple line.

Repeating details are located on the Annotate tab’s Component drop-down; click Repeating Detail Component. If you edit the type of any existing repeating detail component, you can create a new type using Duplicate. Then you can set the detail component you want to repeat (any that is loaded into the current project) along with the layout, spacing, and detail rotation (Figure 6.27).

**Detail**  Specify the detail component to repeat.

**Layout**  Specify the spacing type to use (such as fixed spacing or maximum spacing).

**Inside**  Restrict spacing to the path length.

**Spacing**  This is the distance to space detail components.

**Detail Rotation**  Apply detail component rotation (None, 90 Degrees, and 180 Degrees).
Now let's investigate editing other 2D annotations by modifying the default title block family.

**Title Blocks**

Title blocks are also 2D elements, similar to tags and detail components. For pilot projects, it may be fine to start with the default title block and then modify it later. Grids are also helpful when you're organizing views on title blocks, but as you've noticed by now, the default title block doesn't have a grid. You will add a grid to a default title block in the following exercise:

1. In this chapter’s sample project, activate the sheet A101 from the Project Browser. Select the title block, and then choose Edit Family from the ribbon.
Before going any further, you need to create a new line type to use for the grid. It will have a slight color so you can easily distinguish it from the rest of the graphics on the title block as well as any project views.

2. Go to the Manage tab’s Settings panel, and click Object Styles. When the Object Styles dialog box opens, click New under Modify Subcategories. Use the New Subcategory dialog box to create a new line called Grid Lines, as shown in Figure 6.28. From the Subcategory Of drop-down, select Title Blocks. Then click OK.

![Figure 6.28 Adding a new subcategory](image)

3. Select the Line Color option, and modify the color to a light blue. Click OK to close the Object Styles dialog box.

4. You’re ready to draw the grid lines. Go to the Create tab’s Detail panel, and click the Line tool. Select the Grid Lines subcategory at the right end of the ribbon.

5. Draw five vertical lines and four horizontal lines (Figure 6.29). Dimension them with a continuous dimension (the dimensions will not show up in the project environment). Select the EQ option, and all the lines become equally spaced.
If you were to reload this sheet in the project, you’d be able to control the visibility of the grid like any other object: via Visibility/Graphics Overrides. But it’s useful to be able to turn the visibility of the grid on and off throughout the project, not just one sheet at a time. You can do this by associating a type parameter to the grid lines you’ve just created. Then when you’re done using the grid line to set up your project views, you can turn it off with one click!

6. Select all the grid lines you just created. In the Properties palette, click the small button to the right of the Visible check box to open the Associate Family Parameter dialog box.

7. Click Add Parameter to open the Parameter Properties dialog box. In the Name field, type Grid Visibility. Click the Type radio button, and set Group Parameter Under to Graphics, as shown in Figure 6.30.
8. When you’re finished, click OK to close both dialog boxes. Notice that the Visible property is now inactive because it is being controlled by the new Grid Visibility parameter. This is how you expose properties of individual family elements in the project environment.

9. Click Load Into Project to reload the title block into your project, overwriting the parameters of the existing title block.

10. Select the title block in the project, and click Edit Type in the Properties palette to open the Type Properties dialog box (Figure 6.31). If you uncheck the Grid Visibility parameter, it turns off the grid throughout your project (rather than just one view at a time).

11. Deselect the parameter. When you click OK, the grid is no longer visible in the title block.

Now that you’ve modified 2D family components, let’s experiment with editing 3D elements. You’ve already modified the geometry of a nonhosted element (the desk in the “Level of Detail” section). Next you will modify a hosted component.
Hosted Components

A hosted family has a required relationship to a specific host category, such as Floors, Walls, Roofs, or Ceilings. Without the host, the hosted family can’t be placed. For example, a wall-hosted family can be placed only in a wall, and so on.

For this exercise, you’ll modify the generic fixed window that is part of the default library.

1. In this chapter’s sample project, go to the Project Browser and expand Families and then Windows. Right-click Fixed, and select Edit from the context menu to open the family in the Family Editor (Figure 6.32).

   You want to keep the existing type, so begin by renaming the family via Save As.

2. Press VV on the keyboard to access Visibility/Graphic Overrides (the left image in Figure 6.33). Make sure the Walls category is checked as shown. The 3D view now resembles the image on the right in Figure 6.33. Use Zoom To Fit to adjust your view.
3. Activate the Exterior elevation view from the Project Browser window by double-clicking the Exterior elevation view (Figure 6.34).

![Visibility/Graphic Overrides for the host wall](image)

**FIGURE 6.33** Visibility/Graphic Overrides for the host wall

![Reference planes and dimension parameters](image)

**FIGURE 6.34** Reference planes and dimension parameters
Reference planes (displayed as green dashed lines) serve as guides that allow the geometry to flex. As you can see, the window geometry has not been directly assigned to dimension parameters. Instead, the parameters are associated to the reference planes. The window geometry is then associated to the planes. This is the preferred method for constructing family geometry.

4. Go to the Create tab’s Datum panel, and click the Reference Plane tool. Draw a horizontal plane around the midpoint of the window.

5. Go to the Modify tab’s Measure panel, and click the Aligned Dimension tool. Create a continuous dimension between the two outermost horizontal reference planes and the new plane you created in step 4. Click the temporary EQ icon that is active when you select the dimension just created to establish an equality constraint (Figure 6.35). In other words, no matter how the window height changes, the new reference plane will remain centered.

**FIGURE 6.35** Adding a new reference plane and keeping it equally spaced

This process is an important part of modifying existing content. This window family is full of dimension parameters that control different types. These parameters are extremely useful, so you do not want to delete them!

You do not need to create new geometry from scratch; you can modify what is already in the family. This approach may seem like cheating, but this is usually how content is modified. In addition to
this process being efficient, the geometry that you modify will likely continue to “remember” existing relationships to reference planes and other parameters.

6. Select Frame/Mullion Extrusion, and click Edit Extrusion from the ribbon. Sketch new internal lines, as shown in Figure 6.36, to split the window into three panels. Before you finish the sketch, delete the sketch segments between the new lines, as indicated in Figure 6.36, using the Split tool with the Delete Inner Segment option checked located on the lower panel of the ribbon.

![Figure 6.36 Editing the existing window frame](image)

7. Click the green check in the ribbon to finish the sketch. After the sketch is finished, it’s important to flex the family to make sure the different sizes will behave before you load the family into the project.

8. Click the Family Types button to view all the various family types. Select a few different types from the drop-down at the top of the dialog box, and click Apply after each type is specified.

9. Click OK to close the dialog box, and look at the window in 3D. The window geometry is flexing, but the window pane is still one piece of glazing.
10. Select the glazing, and then click the Edit Extrusion button from the Mode panel on the contextual Modify | Frame Mullion tab. Return to the exterior elevation, and add sketch lines aligned with your previously modified window trim, as shown in Figure 6.37. You can even use the Pick Lines option in the Draw panel to make this process even easier. Remember to remove the segments of outer line using the Split tool, as you did in step 6.

![FIGURE 6.37 Modifying the window glazing](image)

Finish the sketch, and then repeat the previous process of testing a few different family-type parameters in order to make sure the window glazing will flex with the different sizes.

Now that the window has been modified, load it into your project. Select one of the existing windows, and then use the Properties palette to swap out the existing window with the component you've just created. Because the insertion points are the same, the window location will remain consistent.
Family Tips and Best Practices

The following are some additional tips and best practices for modifying and working with families:

**Name Your Reference Planes**   After adding new reference planes, make sure to assign them a name in the Properties palette’s Name field. This makes it much easier to keep track of each reference plane and allows them to be selected by name when you are editing the work plane.

**Edit Work Planes**   When working in the Family Editor, you may at times need to move a work plane–based element (such as an extrusion) from one work plane to another. When selecting the element, the option to Edit Work Plane becomes available on the ribbon. You can select from a list of levels and reference planes to move the element to. This is another reason to name reference planes; if Name is blank, it will not appear under the Specify A New Work Plan ➢ Name list.

**Flex Reference Planes Before Adding Geometry**   When creating new geometry in a family or adding a parameter to existing reference planes, be sure to properly flex the family before adding geometry. Think of reference planes as the framework for the geometry. First add reference planes, and then add dimensions between the reference planes as needed. Once the dimensions/parameters are in place, the values should be adjusted to ensure the reference planes adjust properly. It is much easier to troubleshoot a potential issue before adding additional geometry into the family.

**Use the Wall Closure Option**   For wall-hosted families (such as door and windows), reference planes can be used to determine the point where the wall layers will wrap around the family insert. You can see the difference in Figure 6.38 with Wall Closure checked and unchecked.

![Wall Closure layers](image-url)
Deal with Filled Regions Blocking Lines in the Title Block  This is a common scenario when adding filled regions and lines in a title block family. In the Family Editor, the filled region is added first, and the lines are added second (so the display order appears as expected with the lines on top). Load the title block into the project, and the filled region now overstrikes the lines. One workaround is to start a new Revit generic annotation family and cut and paste the filled regions into the generic family. Lastly, load the generic annotation family into the title block family and locate as needed. While the display order may appear incorrect in the title block family, it should display (and print) correctly in the project.

Know When Objects in Family Cannot Be Deleted  Notice that when you start a new family using a default template, some of the existing elements cannot be deleted (such as some reference planes). Why is this? Any geometry that is included as part of the family template cannot be deleted when a new family is created.

Create a New Family Template  By default you cannot save an existing Revit family (.rfa) as a family template (.rft). However, you can copy the file in Windows Explorer and rename the extension from .rfa to .rft. Revit will consider this a family template afterward.

Use a “Super” Masking Region  By default masking regions mask model geometry in the project environment, but they do not mask annotation elements such as text, dimensions, tags, or detail lines. If you want to mask model and annotation elements, create a generic annotation family, and add a masking region in the family. When loaded into the project, the generic annotation family will mask both types of objects.

Use a Family Parameter Lock  For parameters in a family (Family Types dialog), there is a column with an option to lock. If you lock a parameter in the family, any labeled dimension with that parameter applied will be locked. This means you will be unable to change the value in-canvas. This also means you won’t be able to dynamically flex the family in-canvas (such as dragging a reference plane with a labeled dimension attached). This is good to keep in mind if you run into odd behavior when flexing the family; make sure to first confirm whether the parameter is locked.
Rather than starting from scratch, it’s often faster to find a family or element close to what you need and modify it. You learned how to edit the view display and detail level, as well as change the family category and modify family geometry.

**Additional Exercises**

- Select another family, and modify its level of detail so the appropriate geometry is displayed at the right scale and detail level in the project environment.
- Explain how you would modify a family from face-based or hosted to one that is not.
- Explain how you would modify a family that is not face-based or hosted to one that is.
- Nest a family into another family, and select the Shared option. Verify that this nested family schedules when placed in the project.
- Add a new subcategory to a family, and assign geometry to the category. From the project environment, compare the visibility options under the main category (Doors, Furniture, Specialty Equipment, and so forth) of this family before and after the family is loaded into a project.
Schematic Design

Design inspiration comes from many sources. Some designers like to sketch by hand, and others use digital tools, but regardless, the design needs to align with the building program. Many modern sketches now happen digitally to make the transition from concept to schematic design easier.

When you begin to migrate your conceptual design from the sketch to the computer, don’t start with building elements (walls, floors, and so forth). Instead, start with more primal elements, a process called massing in the Autodesk® Revit® Architecture software, to make sure your program is correct. Once you’ve confirmed that the mass contains the required building program, you’ll be able to start placing building elements with far more confidence. Although massing is capable of much more complex form-making than you’ll see in this chapter, it’s a great starting point for learning Revit Architecture.

In this chapter, you learn the following skills:

- Working from a sketch
- Modeling in-place masses
- Creating mass floors
- Scheduling mass floors
- Updating the massing study

Working from a Sketch

Sketches can be a great source for starting design massing in Revit Architecture. In certain cases, hand drawings can be scanned from physical pen-and-paper drawings. In some design workflows, sketching directly within a computer application is becoming increasingly common. To support this digital workflow, in 2010 Autodesk released a tool for Apple’s iPad called SketchBook Pro (see Figure 7.1) that allows you to sketch directly on a tablet or mobile phone using a stylus or even your finger.
The sketch in Figure 7.1 was created on an iPad, but the sample scenario for this chapter will work for any scanned sketch design, even one on tracing paper. In this example, the designer has created sketches of a proposed building form and would like you to import each of the view orientations (plan and elevations) into Revit Architecture and use them as context for a quick massing study. The building program allows a maximum building height of about 800' (244 m) and requires a gross area of 3.5 million square feet (325,000 square meters).

**Figure 7.1** A hand sketch from Autodesk's SketchBook Pro for the iPad

The sketch in Figure 7.1 was created on an iPad, but the sample scenario for this chapter will work for any scanned sketch design, even one on tracing paper. In this example, the designer has created sketches of a proposed building form and would like you to import each of the view orientations (plan and elevations) into Revit Architecture and use them as context for a quick massing study. The building program allows a maximum building height of about 800' (244 m) and requires a gross area of 3.5 million square feet (325,000 square meters).
Importing Background Images

Let’s look at how you can combine the design’s sketches with the Revit Architecture massing tools to help deliver preliminary feedback about the design. When you open Revit Architecture for the first time, you’ll find yourself at the Revit Architecture home screen. This screen keeps a graphic history of the recent projects and families that you’ve worked on. Now, follow these steps:

1. On the home screen, select Architecture Template to open one of the default Revit Architecture templates. Open the South elevation by double-clicking South in the Project Browser (see Figure 7.2).

2. On the Insert tab, select the Import panel, and click the Image tool.

3. Select the c07 Massing Sketch.png file from the Chapter07 folder on this book’s web page (www.sybex.com/go/revit2014essentials). When you select the image, you’re put back in the South elevation view.

4. You see a large, empty-looking box with an X through it. This is the Image Placement tool. Place the image as shown in Figure 7.3 so that the base of the building sketch roughly aligns with Level 1.
As you can tell from Figure 7.3, the scale of the sketch doesn’t relate to the real-world units of Revit Architecture. To remedy this, in the next section you’ll quickly scale the imported image.

**Accurately Scaling Images**

Select the Measure tool on the Quick Access toolbar (QAT) located at the top of the screen. When the tool is active, pick between the two points, as shown in Figure 7.4. As you can see, the real-world distance in the image is about 70’ (52 m). Depending on how you inserted your image, your dimension might vary a bit. That’s fine; your next step is to learn how to scale these images.
You know the desired distance is 800' (243 m) between the two points you just measured. One way to change the image size is to select the image and manually enlarge it by dragging the corner grips until the distance is correct—and in many cases this might be close enough. However, we'll show you a more precise method.

1. Select the image, and look at the Properties palette on the left. Notice the current dimension for the Height field is 113' 9" in the example. To modify the image size, you need to increase the Height value with regard to the desired and actual dimensions.

2. To determine this value, use this formula:
   \[
   \text{Current Height} \times \left( \frac{\text{Desired Height}}{\text{Measured Distance}} \right)
   \]
So, for this example, you’d use the following:

\[ 113'9'' \times \left( \frac{800'}{70'} \right) \text{ or } (26 \text{ m} \times \left( \frac{243 \text{ m}}{52 \text{ m}} \right) \]

Using the built-in database functionality of Revit Architecture, you can do this math right in the Properties palette, as shown in Figure 7.5. Be sure to add the \( = \) sign at the beginning of the formula. The height of the image increases significantly (more than 975’ [2,735 m]). But now the imported image has proportionally increased the correct amount.

![Figure 7.5 A formula for adjusting the image scale](image)

3. Move the sketch to align with Level 1 again (the arrow keys on the keyboard are useful for this). Also, increase the scale of the view to 1” = 40’-0” so that the level symbols are more visible.

### Using Reference Planes and Levels

Reference planes are one of the most useful tools in Revit Architecture. The planes are represented in Revit Architecture as green dashed lines, and they display in any view perpendicular to the reference plane. They don’t print in your drawing sheets, but they’re handy as a tool to align elements that are coplanar. Think of them as levels and grids, except that you don’t need to show them on your sheets.

In the example, it’s important to use reference planes as guides to help you create the masses in other views, because the image you imported will be visible only in the imported view. Reference planes are like guidelines that can be seen across many views. They will be extremely helpful when you line up the sketch in the South elevation and then in the North elevation or plan view.

1. To begin, click the Architecture tab, and on the Work Plane panel, select the Ref Plane tool. Click once, and then click again to draw
a vertical line in the canvas. Draw a total of six vertical reference planes like in Figure 7.6.

2. Selecting the reference planes can be difficult when an imported image is present. At this point, you should select the image and then click the Pin tool in the Modify gallery of the ribbon; this will keep the image from accidentally moving. Now, under the Modify button, click the Select button, and then uncheck the Select Pinned Elements button. The image will no longer interrupt your workflow.


4. You will dimension the distance between these planes. Select the far-left reference plane. On the Measure panel of the ribbon, choose the Aligned Dimension tool. Click each of the reference planes; then click once more to place the dimension string below the sketch.

5. The dimensions are not round numbers, so you’ll change that. Click the second reference plane; then click the blue dimension between the first and second reference planes, and type in 30. Now select the third reference plane, click the blue dimension between the third and second, and type in 20. Follow the same steps with the other reference planes to achieve the result in Figure 7.7.
Now you’ll add some levels to the file that will be useful for determining the limit of the three masses you’ll add.

1. Move Level 2 by selecting the Level element; then click the blue 10'-0" (3 m) text. Now type in the new elevation of 20' as in Figure 7.8.

2. To add levels, select the Architecture tab, and then choose the Level tool on the Datum panel. By clicking and dragging your cursor from left to right, you create a level that also creates a corresponding floor plan. Place Level 3 at 35'-0" (10 m).

3. You can also create levels by copying an existing level. Start by selecting level 3; then, on the Modify panel in the Ribbon, click the Copy tool. Click the Multiple check box on the Options Bar. Click to start the tool then again to place the copied level.
In Figure 7.9, Levels 1–3 have corresponding floor plan or level views, whereas Levels 4–10 are reference levels only. Reference levels can be turned into view levels, but during the design process (and later in documentation), you’ll find it helpful to create levels that don’t need to be views. Having 100 or more view levels would create a lot of clutter in your drawing set.

**FIGURE 7.9 View vs. reference levels**
Now you'll create the rest of the levels, as shown in Figure 7.9, by arraying Level 10.

1. Select Level 10. The Modify | Levels menu becomes active. Select the Array tool on the Modify panel.

2. Because Level 10 is at an elevation of 150'-0" (45 m), you need to create an array with the options shown in Figure 7.10. These options can be adjusted in the Options Bar below the ribbon.

3. Pick a location that is directly 12'-0" (3.6 m) above Level 10. When you click to place the 11th level, the additional 55 levels are created automatically. Your final level (Level 64) appears at 798'-0" (243 m). That’s pretty close to your goal of 800'-0" (243 m).

Creating and Placing Groups

In this exercise, you'll create a group and explore potential uses for the Group command.

1. Select the image you inserted earlier in the South elevation, and then select the Group tool on the Create panel on the ribbon.

2. When the Create Detail Group dialog opens, name the group Massing Sketch 1, as shown in Figure 7.11, and click OK.

3. Find and open the East elevation from the Project Browser. Now find the Groups node in the Project Browser. Click it and then Detail
to see the group you just created (see Figure 7.12). By clicking and dragging this group into your project window, you can add the detail group to other views in your project.

4. Drag a copy of the detail group from the Project Browser into the view. Change the view scale to 1" = 40'. Then create some more reference planes on the other elevation sketch, as shown in Figure 7.13.
5. Open the Level 1 view, and then drag a final copy of the detail group into the view. Now center the plan sketch in the reference planes you created, as shown in Figure 7.14. Now you have the three views necessary for massing the building.

**FIGURE 7.14** Reference planes in the Level 1 view

---

**Images and Groups**

Each image you import in Revit Architecture can be seen only in the view in which it’s placed. In other words, an image placed in the South elevation view is seen only in that elevation view. In the example, you’re trying to assemble a 3D context for modeling geometry, and you’ll need to place the image in multiple views.

When you change the scale or proportion of one of the images, you’ll likely want to change all of them. Groups are used in Revit Architecture to maintain relationships between collections of elements. When one group changes, all the groups change. This is very helpful for collections of components that are compiled into units, such as furniture layouts, hotel rooms, and apartment types.
Modeling In-Place Masses

Now that you've imported the designer's sketch and drawn the appropriate reference planes for added context, you can start creating the massing elements that will represent the building. You'll do so using a tool called In-Place Mass. Consider masses as families in Revit Architecture that are created directly within the project. This tool allows you to model within the context of the project you're actively working in.

Modeling the Base Mass

1. Open your Level 1 floor plan view by double-clicking Level 1 in the Project Browser.

2. Select the Massing & Site tab on the ribbon, and select the In-Place Mass tool on the Conceptual Mass panel. If you don’t see the Massing & Site tab, don’t fret. Click the Application button, and select Options. On the User Interface option, you can check the Massing & Site box.

3. Revit Architecture displays a dialog telling you that it has now enabled the Show Mass mode in the current view. Click Close.

4. The Name dialog appears. For this exercise, use the default name, which is Mass 1 (see Figure 7.15). Click OK.

5. Now you're in a special, in-place editor for creating masses in Revit Architecture. Notice that the menu options have changed. Select the Rectangle tool.

6. Using the Rectangle tool, sketch some lines as shown in Figure 7.16. These lines should cover the form and be placed along the reference planes you created earlier.
7. Select the lines, and then select the Create Form tool on the Form panel.

The results aren't immediately obvious because you're looking at a solid form in plan view. To view the results from another angle, return to the South elevation. Select the top of the form by clicking it, and use the grip arrows, as shown in Figure 7.17, to increase the form's height until it aligns with Level 8. The edge of the forms will “stick” to the level when you’re close and snap itself into place.
Modeling In-Place Masses

Sketching Masses

The type of mass you’re creating in this exercise is called an extrusion. There are many other configurations of masses, including blends, sweeps, swept blends, and revolves. After you’ve created the initial mass, it’s possible to edit the form dramatically; you can even use voids to carve away at your initial form.

We don’t have the space to go into that level of complexity. But modeling more complex masses is something that you’ll likely want to learn. Check out http://au.autodesk.com/?nd=class_listing.

Modeling the Middle Mass

The next step is to model the middle mass form.

1. Return to the Level 1 plan view. Set the view to Wireframe, as shown in Figure 7.18 (so you can see through the mass you’ve just created). The Wireframe button is located in the View Control Bar at the bottom of the screen.
2. Using the same workflow, sketch another rectangle, as shown in Figure 7.19. Then select the rectangle and click Create Form, as you did with the previous rectangle.
3. Open the South elevation, and use the grip arrows to move the second mass form so the upper face aligns with Level 10. Use Wireframe to see through the first mass to the second mass. Select the lower edge and drag it so it aligns with Level 8, as shown in Figure 7.20.

![Second Mass in Place](image)

**Figure 7.20** Second mass in place

### Modeling the Upper Mass

The process of creating the third (and uppermost) mass starts the same as for the first two masses.

1. Return to Level 1, and create a rectangular sketch that connects the outermost reference planes, as shown in Figure 7.21. Then select the lines, and click Create Form.
2. Return to the South elevation, and use the grip arrows to extend the top and bottom of the form. Extend the upper and lower faces to align with Levels 64 and 10, respectively.

You could continue to work in 2D views, but it’ll be more helpful if you can see what you’re doing in 3D.

**Working in 3D**

Select the Default 3D View icon from the QAT. Doing so allows you to see the working mass more completely, as shown in Figure 7.22.
You likely noticed from the imported sketches that the East façade of the mass should taper in elevation. The base and the top are different widths. By adding an edge to each face (both North and South or Back and Front on the ViewCube), you'll be able to adjust the upper form.

1. Hover over the South face of the upper form, and select the face by clicking it. Doing so activates the Add Edge tool on the Form Element panel.

2. The Add Edge tool divides one plane on the mass by adding another edge that can be adjusted independently of the other edges. Add the edge at the front, lower corner of the upper mass, as shown in Figure 7.23.
3. Rotate the model to expose the North face. Do so by selecting the intersection of the ViewCube between the right, back, and top sides. The model will spin around and center itself.

4. Select the North or Right face to add an edge from the top-right corner to the lower-left corner (see Figure 7.24).

5. As you hover your mouse pointer over the right face's top-left intersection, a vertex control appears as a purple dot (see Figure 7.24).
6. Select this control, and use the grip arrows to move it toward the center of the face. Next, do the same thing to the other corner of the face. The result will resemble Figure 7.25.

7. Your mass is nearly complete, but first you need to join all the mass geometry together. Select the Join tool on the Geometry panel. Then select the lower and middle forms to join them. Repeat this process for the middle and upper forms.
8. Now that the forms have been joined, select the Finish Mass tool in the In-Place Editor panel. It’s the big green check mark , meaning you’re done!

Congratulations! You’ve just created your first massing study.

**JOINING MASSES**

Each mass is an independent object. Masses can even be scheduled independently from each other. You’ll find this functionality helpful for creating separate masses for programming purposes (such as convention space or meeting rooms). But be careful if you have overlapping masses.

If overlapping masses aren’t properly joined, Revit Architecture will create overlapping mass floors, and your schedules will be incorrect. Furthermore, if you create real floors from the mass floors, the floors will overlap rather than create a single element.

**Creating Mass Floors**

Floor area faces are incredibly useful for getting a sense of the gross area of a building mass at any intersecting level. Furthermore, the results can be quickly and easily scheduled. Any changes to the massing study will update the schedules and all views in real time.

Select the completed mass, and then click the Mass Floors tool in the Model panel. You’re given the option to select all the levels in your project. You want to select them all, but rather than select them one at a time, select Level 1, and then scroll down. While pressing Shift, select Level 64. Now all of the levels are selected. Check any box, and all the boxes are automatically checked. Click OK.

Your mass has now been bisected with mass floors (faces with no geometry), as shown in Figure 7.26.
Creating schedules in Revit Architecture is easy. Doing so allows you to understand the impact of your work while you work—rather than at the end of a long design process. Schedules can help you not only track elements in Revit Architecture but also assess how conceptual design work meets your program requirements.

Schedules are just like any other type of view in Revit Architecture—they show you a current, specific look at the model. These views show you this information in a spreadsheet format, but just like the other view types, schedules dynamically update as changes are made to the model. Follow these steps:
1. To create the mass schedule, select the View tab on the ribbon. Then select the Schedules drop-down in the Create panel. Click Schedules/Quantities.

2. In the New Schedule dialog, find the Mass category, and expand it. Now select the Mass Floor option in the column on the left, and leave the other fields (Schedule Name and Phase) at their default values. Click OK.

3. The next dialog contains a series of tabs. You’ll step through some of these to set up the schedule. On the Fields tab, select the following from the list on the left:
   - Level
   - Floor Area

You can double-click these to move them to the box on the right, or you can highlight them and click the Add button (see Figure 7.27).

4. On the Sorting/Grouping tab, change Sort By to Level. Also, check the box at the bottom for Grand Totals, and select Title, Count, And Totals in the drop-down, as shown in Figure 7.28.
5. On the Formatting tab, select the Floor Area field, and then click the Calculate Totals option (Figure 7.29). Click OK. This creates the schedule.

![Figure 7.28 Selecting the Sorting/Grouping fields](image1)

![Figure 7.29 Calculating totals](image2)
Figure 7.30 shows the resulting schedule. With a total of 63 floor levels, Revit Architecture is calculating a gross floor area of just more than 4.5 million square feet (418,000 square meters).

Unfortunately, you know from the program (at the beginning of this chapter) that the gross floor area needs to be closer to 3.5 million square feet (325,000 square meters). So, let’s get back to that massing study and tweak the form to get it closer to the program goals.

**Updating the Massing Study**

Begin by selecting the mass in the default 3D view and then clicking the Edit In-Place button in the Model panel. Doing this returns you to In-Place editing mode and allows you to have specific control over mass geometry.

You’re going to modify the east and west faces, moving each face 40’-0” (12 m) closer to the center. Hover your mouse near the edge of the face of the upper mass. Select the face, and note the small temporary dimension and the 3D widget.

Click the blue text, and change the value to 260’-0” (80 m). Do the same for the middle and lower east faces. Click the Finish Mass button on the ribbon to confirm your edits. Go back to the Schedule view. Note the gross floor area is closer to 3.25 million square feet (see Figure 7.31), or about 302,000 square meters.
You will need the program to be closer to 3.5 million square feet. A quick discussion with the designer reveals that the base of the building is meant to hold important meeting and conference spaces. So, you’ll extend the eastern base of the building back to 300’ (91 m). Once again, you do so by repeating the previous steps of selecting the mass and returning to In-Place editing mode. When this is finished, the mass looks like Figure 7.32, and the gross floor area is within the required program.

If you want to download the completed Revit Architecture file, you can find it in the Chapter07 folder on the book’s web page. The file is called c07 Massing Exercise.rvt.
The Essentials and Beyond

Ultimately, masses can be used to host relationships to real building elements that would otherwise be nearly impossible to maintain. Mass floors can be used to control the extents of real floors. Many times, this will allow you to change location of many slab edges at once by changing the mass and then updating the floors within that mass.

Masses can also host walls, curtain walls, and roofs. This allows you to create (and modify) complex design forms that would be nearly impracticable to assemble bit by bit. The idea is that you’re working from general to specific: get the big ideas down first (as masses), and then go back and assign real building elements to those faces to build the building.

But keep in mind that it’s unlikely you’ll be able to use only one mass to host all your building elements. You may need one mass to host floors and control slab edges, another to host roofs, and even another to host walls and curtain wall systems. Don’t be afraid to use overlapping masses in these situations to control different host elements. More specific control will often require overlapping masses. But for initial design/programming purposes, using a single mass to resolve gross floor areas is often sufficient.

Additional Exercises

▶ After you’ve created your mass and mass floors, use the Floor By Face tool to assign real floors to the mass floors.
▶ Modify the mass and remake the geometric floors that you created in the previous item.
▶ Experiment with walls and curtain walls by using the Wall By Face and Curtain System tools to assign walls to the face of the mass.
▶ Modify the mass and remake the walls and curtain walls created in the previous item.
▶ Explain what you would do if you wanted to control floors and walls with a mass but the floors and the walls didn’t always align. For example, what would you do if the floors were set back or deviated from the face of the mass?
Rooms and Color-Fill Plans

In the previous chapters of this book, we discussed creating physical elements such as walls, floors, roofs, stairs, and railings; however, one of the most important elements in architecture is the spaces bounded by those elements. In the Autodesk® Revit® Architecture software, you have the ability to create and manage rooms as unique elements with extended data properties. Keeping room names and areas coordinated has the potential to free hours of manual effort for more productive and meaningful design-related tasks. Once rooms are tagged, you’ll be able to create coordinated color-fill plans that automatically reflect any data about the rooms in your project. Any changes to the rooms are immediately reflected throughout the entire project.

In this chapter, you learn the following skills:

▶ Defining rooms in spaces
▶ Generating color-fill room plans

Defining Rooms in Spaces

Rooms are unique types of objects because they do not have a clear physical representation like other model elements such as furniture and doors. Their horizontal extents are automatically determined by bounding objects in the form of walls, columns, or boundary lines that you can customize. These planar boundaries will determine the extent of the room object and, thus, the area of each defined room. As an additional option, you can allow Revit Architecture to calculate room volumes. The volumetric or vertical extents of rooms are determined by floors, ceilings, and roofs.

To access these calculation options, find the Room & Area panel on the Architecture tab. Click the panel title to expose the special commands, and select Area and Volume Computations (Figure 8.1).
Chapter 8 • Rooms and Color-Fill Plans

210

The area and volume settings are shown at the right of Figure 8.1. In addition to setting the volume computation option, you have the ability to customize the area computation as it relates to walls. This is important to understand because it will affect the area values calculated and displayed in room tags. In this section, you will place rooms and room tags in a floor plan of a project in progress.

From the book’s web page (www.sybex.com/go/revit2014essentials), download the project file c08_Rooms_and_Color_Fills_Start.rvt. Make sure the Level 1 floor plan is activated and set the scale to 1/4" = 1'-0" (1:50).

When you’ve finished the exercises in this chapter, you can inspect the file in its finished state on the book’s web page. Download the file titled c08_Rooms_and_Color_Fills_Finish.rvt.

Room Tags

Before you begin placing room objects, you should understand the distinction between rooms and room tags. The room is the spatial object that contains all the metadata about the space. The tag merely reports those values. In many cases, you can change the values in the room tag, and the room properties will update (and vice versa). But whereas deleting the room will delete the tag, the opposite is not true. You can delete a room tag, and the room will remain. Tags are simply 2D view–specific elements that attach to modeled objects, or, in this case, the room object.
To add a room to your project, follow these steps:

1. Go to the Architecture tab's Room & Area panel, and select the Room tool.
   The context menu that lets you modify and place rooms becomes available. As you hover over enclosed spaces, the room boundary highlights, indicating the space in which you’re about to place a room object (Figure 8.2). You don’t have to tag rooms as you place them, but by default this option is selected, as highlighted in the Modify | Place Room tab.

2. Place a room in the upper-left space on the Level 1 floor plan. Notice that the default room tag indicates only the room name and number (Figure 8.3), but more options are available.
3. Click the Modify button or press the Esc key to exit the Room command, and then select the room tag.

4. From the Type Selector in the Properties palette, choose the Room Tag With Area option. The room tag shows the area based on your project units (Figure 8.4). In this case, the room is 274 square feet. This feature is incredibly helpful if you want to create rooms as your design develops; you can constantly confirm that your spatial program requirements are being maintained. As locations of walls are modified within your project, the room object will adjust accordingly and display the recalculated values defined.
5. Select the first room you created, and examine its properties in the Properties palette. You can modify the room name and number here by editing the settings under Identity Data or by directly editing the Room Name and Number values in the room tag. It doesn't matter where you modify the data, because it is all stored in the room object. This makes it easy to create various plan diagrams to suit your needs.

6. Change the name of the room to Small Meeting, and change the number to 101. Place some other rooms, and observe how the numbering scheme has changed.

Because rooms do not represent physical objects, they have two unique properties to help you visualize and select them. One is a reference — a pair of invisible, crossing vectors that are usually near the middle of the space. You can find these by moving your mouse pointer around in a space. The reference will highlight when your mouse pointer is over one. The second unique property of a room is an interior fill. You can make these properties visible in the Visibility/Graphics settings for any view (Figure 8.5).

![Figure 8.5 Room references and interior fill in the Visibility/Graphics settings](image)

**Figure 8.5** Room references and interior fill in the Visibility/Graphics settings

**Room Boundaries**

Rooms will automatically fill an enclosed area and will always recalculate their area when bounding objects are defined and adjusted. Elements such as walls, floors, columns, and ceilings have a Room Bounding property that lets you customize this behavior to suit your designs. You can find this property in the Properties palette when you select one of the aforementioned model elements.
Now let’s see what happens if you move a wall that defines this space. Select the wall at the right, as shown in Figure 8.6, and move it 2'-0" (600 mm) to the left. The moment you release the wall, the room updates with the new area information, which is immediately reported by the room tag (Figure 8.7).

![Figure 8.6 Moving the wall](image)

![Figure 8.7 Updated room space and tag](image)

Continue to add rooms and tags to the Level 1 floor plan, as shown in Figure 8.8. The rooms will be numbered as you place them, so place the rooms according to the numeric sequence shown in the figure, starting with room 102.
Room Separation Lines

As you start to add a tag to the large, central open space, it’s obvious that the space will be tagged as a single room (Figure 8.9). But in many cases, open spaces need to be divided into smaller functional areas. You don’t want to add walls to carve the large space into smaller areas, especially if they don’t exist in the program; fortunately, there’s a better option. You can draw spatial dividers known as room separation lines.
Follow these steps to subdivide the open space in the project into three functional spaces:

1. Return to the Room & Area panel on the Architecture tab of the ribbon, and select Room Separator.

2. Draw a line between the wall intersections labeled 1 and 2 in the sample file. Room Separation lines are model lines, and they show up in 3D views. The great thing about them is that they allow you to create spaces without using 3D geometry.

   By default, these lines are thin and black, but you can change the settings to make it easier to distinguish the lines from other elements. You will modify the Room Separator line style to be more visible in a working view, but it will be turned off in your sheet views.

3. Go to the Manage tab’s Settings panel, click the Additional Settings flyout, and select Line Styles. Maximize lines to view all available line styles in the sample project. Change the default values for the <Room Separation> lines as follows:

   - Line Weight: 5
   - Color: Blue
   - Line Pattern: Dot 1/32" (Dot 1mm)

   You may customize these settings for room separation lines, or any other line style, as needed by your project.

4. Sketch another room separator in the sample file between the wall intersections labeled 1 and 3. Then add rooms and room tags to the spaces, as shown in Figure 8.10.
Deleting Rooms

You have seen that using the Room command, you can place a room and a room tag simultaneously; however, deleting a room completely from a project takes multiple steps. If you simply delete a room tag, the room object remains in the space. You can add another tag later or tag it in a different view.

If you delete a room object, the definition of the room remains in your project until you either place another room using the same definition or delete it in a room schedule. Let’s explore this behavior with a quick exercise in which you will delete a room object, observe the unplaced room in a schedule, and then replace the room object in the floor plan.
1. From the Level 1 floor plan, delete the first room you placed in the previous exercise by selecting and deleting the room object. A warning appears in the lower-right corner of the application. This warning tells you that the room you just deleted will remain in the project until it is deleted from a room schedule.

2. Go to the View tab’s Create panel, click the Schedules flyout, and click Schedule/Quantities.

3. Select Rooms from the Category list, and click OK.

4. Add the following fields to the room schedule in this order:
   - Number
   - Name
   - Area

5. Click OK. One room in the schedule displays Not Placed in the Area column. There are filters in the ribbon to show, hide, or isolate unplaced or unenclosed rooms when you are viewing a room schedule. These filters are useful when you want to perform quality control on your project and quickly clean up unplaced rooms.

6. To replace the room you just deleted, return to the Level 1 floor plan, and start the Room command again. This time, open the Room dropdown on the Options Bar. You see any unplaced rooms available in your project (Figure 8.11). Select the unplaced room from the list, and place the room back in the floor plan.

7. A room can also be renamed by modifying the room schedule. At this time, return to the schedule you created by locating the Schedules/Quantities category in the Project Browser and opening the room schedule.
8. Highlight the name field for the first unnamed room object, and modify the value to read Large Meeting. Continue renaming all the remaining rooms, as shown in Figure 8.12, naming the spaces appropriate to their function.

<table>
<thead>
<tr>
<th>Number</th>
<th>Name</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>161</td>
<td>Small Meeting</td>
<td>347 SF</td>
</tr>
<tr>
<td>162</td>
<td>Large Meeting</td>
<td>368 SF</td>
</tr>
<tr>
<td>163</td>
<td>Office</td>
<td>382 SF</td>
</tr>
<tr>
<td>164</td>
<td>Office</td>
<td>370 SF</td>
</tr>
<tr>
<td>165</td>
<td>Office</td>
<td>367 SF</td>
</tr>
<tr>
<td>166</td>
<td>Office</td>
<td>360 SF</td>
</tr>
<tr>
<td>167</td>
<td>Small Meeting</td>
<td>383 SF</td>
</tr>
<tr>
<td>168</td>
<td>Entry</td>
<td>615 SF</td>
</tr>
<tr>
<td>169</td>
<td>Hallway</td>
<td>268 SF</td>
</tr>
<tr>
<td>170</td>
<td>Open Office</td>
<td>520 SF</td>
</tr>
<tr>
<td>171</td>
<td>Large Meeting</td>
<td>340 SF</td>
</tr>
<tr>
<td>172</td>
<td>Office</td>
<td>345 SF</td>
</tr>
<tr>
<td>173</td>
<td>Office</td>
<td>145 SF</td>
</tr>
<tr>
<td>174</td>
<td>Storage</td>
<td>151 SF</td>
</tr>
<tr>
<td>175</td>
<td>Office</td>
<td>251 SF</td>
</tr>
<tr>
<td>176</td>
<td>Small Meeting</td>
<td>232 SF</td>
</tr>
</tbody>
</table>

**Figure 8.12** Renaming rooms in a room schedule

### Generating Color-Fill Room Plans

Creating color-fill plans in Revit Architecture is easier to accomplish than most other design applications. Once again, color-fill plans constantly update as existing information is modified or new information is added. This allows you to focus on communicating rather than coordinating your design information — as if resolving your design isn't already hard enough!

### Adding a Color Legend

To create a color-fill plan, go to the Annotate tab's Color Fill panel, and select the Color Fill Legend tool. Click anywhere in the Level 1 floor plan, and a dialog opens that allows you to select the space type and color scheme (Figure 8.13). In this case, set Space Type to Rooms and Color Scheme to Name.
You can create any number of color schemas based on various data in your project model. For example, you could create color-fill legends according to department, floor finish, occupancy type, and even ranges in area.

To edit the color assignments, select the color-fill legend in the plan view. You can then select the Edit Scheme tool from the contextual ribbon. You can also access the same settings in the Properties palette for the current view. Just find the Color Scheme property, and click the button in the parameter field.

Selecting the Edit Scheme tool opens the Edit Color Scheme dialog where all the values are available for editing (Figure 8.14). You can edit the color as well as the fill pattern. Changing the fill pattern is helpful if you want to create an analytic fill pattern for a black-and-white or grayscale print.
Modifying Color Schemes

By default, solid fill colors will be automatically assigned to each unique value in a color scheme. Fortunately, you can completely customize the colors and fill patterns for the scheme. Let’s edit the color of the Small Meeting fill by following these steps:

1. With the Edit Color Scheme dialog box open, select the Color field in the row for Small Meeting. The Color dialog box opens.

2. Modify the color values to R 255, G 128, and B 128. When you complete the changes, the fill color automatically updates to reflect your changes (Figure 8.15).

Color fills were automatically created in the project view based on all the assigned room names. Notice all rooms that share the same name also share the same color fill. If a room is renamed, the color fill should change accordingly.

3. Continue modifying the color values in your color scheme until you are satisfied with its appearance (Figure 8.16).
All the room tags and color fills are associated with the elements of your building design. Experiment with this behavior by moving some of the walls. Note how the room areas and color fills automatically adjust as each space changes.

**Adding Tags and Fill Colors in Section**

Room tags and color fills are not just for use in floor plans — they can be utilized in sections as well. Let’s examine this functionality with a quick exercise.

1. Activate the Level 1 floor plan. Go to the View tab’s Create panel, and select the Section tool. Create a section across the project plan view, as shown in Figure 8.17.
2. Press the Esc key to deselect the section you just created. Double-click the section head to open the new view. Figure 8.18 illustrates the new building section. Although all the geometry is shown correctly, it would certainly help to tag the spaces with their room names.

3. Select the Tag All option on the Annotate tab’s Tag panel. Doing so opens the Tag All Not Tagged dialog, allowing you to tag numerous element categories in a view simultaneously. You need to tag only rooms in this exercise, so select the Room Tags category, as shown in Figure 8.19, and then click OK.
FIGURE 8.19  Adding room tags with the Tag All command

The section view is automatically populated with room tags (Figure 8.20). Keep in mind that the tags will be centered in each room, so you may need to move their location slightly if the tag is overlapping element geometry. To move a tag, click the Modify button in the ribbon (or press the Esc key), select a tag, and drag it using the grip that appears near the selected tag. You can also grab and drag a tag directly without selecting it first.

FIGURE 8.20  Room tags shown in section

4. What about the color fills? Return to the Annotate tab’s Color Fill panel, select the Color Fill Legend tool, and place the legend in the section view.

5. Once again, set Space Type to Rooms and Color Scheme to Name. The rooms are filled with the same pattern and color in the section view.
as the color fill in the plan view, as shown in Figure 8.21. Remember, you can set the color fills in the section view to describe Department or other values, while the room tags displayed the room name.

Notice in Figure 8.21 that the color fill is obscured by some of the model elements such as doors and furniture. This is because the color fill can be placed as a background or foreground in any view. To change this setting, look in the Properties palette for the settings of the current view, and find the Color Scheme Location parameter. Change this setting to Foreground, and observe how the color-fill display is modified.

**FIGURE 8.21** Room colors in the section view match the plan colors.

**THE ESSENTIALS AND BEYOND**

There’s a lot of wonderful functionality with regard to rooms, room tags, and color fills that we haven’t been able to cover in this brief chapter. Instead, we focused on typical uses to get you up to speed so you can be confident and productive as quickly as possible.

**ADDITIONAL EXERCISES**

- Create a single room, and add a room and a room tag. Now add a wall across the middle of the room. Which side of the room contains the space of the room? What denotes the origin of the room?
- Create a room color fill that uses black-and-white patterns rather than color. Why might this be useful?
- Create a room tag that displays information not visible in the default tag (such as Department).
- Create a color fill in your own project template.
Materials, Rendering, and Visualization

*The Autodesk® Revit® Architecture* software offers various opportunities for you to visualize your design in exciting ways. We’ll discuss how to set the material properties for your building information model and then view the materials in renderings. We’ll share how to access them and create compelling presentation graphics.

Being able to visualize an architectural building before completion is one of the many advantages of building a 3D model. With Revit you have the ability to apply real-world materials and observe them at different levels of abstraction, from generic shading to photorealistic rendering with physically accurate lighting.

To create compelling graphics, you’ll need to access and modify the material properties of your model. So, in this chapter, we’ll introduce the basics of the Material Editor. This functional area is massive, so we’ll limit our discussion to applying and making basic edits to materials. It is important to follow this workflow first, before rendering.

Rendering is typically associated with final presentation-quality graphics, but Revit allows you to quickly iterate renderings at different quality levels at any phase of your project. As you become a skilled Revit user, you can also become a visualization expert.

In this chapter, you learn the following skills:

- Using materials
- Using graphic display options
- Rendering graphics

CHAPTER 9
Using Materials

Materials have many applications within Revit Architecture. In this chapter, we’ll talk about the Graphic and Appearance tabs of the Material Editor to help you create and control the visualizations of your design. First we’ll discuss how to apply materials to your model.

Editing Material Properties of Walls

Revit Architecture uses a system of generic walls that in most cases do not consist of specific materials. They are simply meant to illustrate an approximate thickness for the proposed construction type. We recommend using these generic walls during the design process and then swapping them out for more specific geometry later.

To begin the exercises in this chapter, download the file c09-Start.rvt or c09-Start-Metric.rvt from the book’s companion web page: www.sybex.com/go/revitessentials2014.

Let’s start by giving your generic walls a material assignment that can be used to distinguish them from more specific wall types.

1. Open the file c09-Start.rvt (c09-Start-Metric.rvt), and make sure the 3D view is activated. Select one of the walls (Figure 9.1).

2. In the Properties palette, click the Edit Type button to open the Type Properties dialog for the Generic 6² (Generic 200 mm) wall type. To the right of the Structure label, click the Edit button, and the Edit Assembly dialog will appear. In the Layers list, find the Material
column, and click the ellipsis button in the field currently displaying Generic, as shown in Figure 9.2.

FIGURE 9.2 Select the Material field.

3. You’ll duplicate a material and then modify it. Duplicating is a safe way to edit a material without affecting all model elements that use the original material. From the Project Materials list, the material named Generic should be highlighted blue. Right-click it and select Duplicate, as shown in Figure 9.3. Find the duplicated material in the list named Generic (1), right-click it, and select Rename. Change the name of the material to Brick.

FIGURE 9.3 Duplicating the generic wall material

4. On the Graphics tab, find the Shading values, and click the color sample to open the Color dialog. Choose a red color.

5. Click the Appearance tab, and click the Swap icon at the right end of the row (Figure 9.4) to open the Asset Browser.

FIGURE 9.4 Editing the Appearance asset
6. In the Asset Browser dialog, find the search box at the top of the dialog. Search for the word brick. Many different brick materials appear; any of these will do. Choose one, double-click, or click the double-arrow button as shown in Figure 9.5 to assign the Brick appearance asset to the brick material.

![Figure 9.5 Assigning an appearance asset to a material](image)

7. Close the Asset Browser window, and then click the Done button in the Material Editor. Click OK to close the Material Browser and again to close any remaining wall type property dialogs.

8. You’ve now applied your new material called Brick to all the walls in your model. For extra practice, you can select the floor element in the model; follow these same steps, but create a wood material, and apply a wood material asset.

**Designing with Generic Elements**

Generic elements play an important role in your Revit Architecture workflow. When you’re creating your design, it’s not practical to use lines to represent ideas when you can use content. But if you select something that’s too specific, you might become frustrated. A design that is too specific too early has the tendency to be “exactly wrong.”

Generic elements and materials help convey the intent of your design with the added benefit of scheduling so that the data about a project can move in the right direction without distracting anyone. They’ll help you emphasize “where” something is as well as some of “what” something is without getting into the detail of how it’s supposed to be assembled — until the time is right. Most of the frustration in design comes from working specifically to generally, rather than the other way around. Designing generic elements will help you avoid this trap.
The shading (Graphics tab) and rendering (Appearance tab) values don’t need to be the same, but there is a way to link them. On the Graphics tab you’ll find a Use Render Appearance check box, which will average the colors of the rendering texture to produce a similar color in shaded views.

To observe the changes you’ve made to the generic walls, change the visual style of the view. From the View Control Bar at the bottom of the view, click the Visual Style icon (the cube), and set the view to Shaded. Now try Realistic. Now try Hidden Line again. You can clearly see the visual impact and interest achieved by applying materials to your model.

Setting the material properties for your wall layers is just the beginning of the visualization opportunities in Revit. You can follow the same steps shown previously to apply materials to your floors, roofs, ceilings, and other elements in the Revit model.

Using Graphic Display Options

Now that you understand the basics of assigning building materials to your model elements, you will open an example file that has many materials and views already set up. You’ll use this model as a canvas to create a presentation-style elevation and 3D isometric drawing. You won’t use rendering yet; first you’ll just use the techniques available in the Graphic Display Options dialog.

To begin the exercise for this segment of the chapter, download the file c09-Residence-Visualizations.rvt or c09-Residence-Visualizations-Metric.rvt from the book’s companion web page: www.sybex.com/go/revitessentials2014.

Presentation Elevation Drawing

Find the view East under the Elevations node in the Project Browser. When you open this view, you can see many notes, dimensions, tags, and other annotation elements. For these visualization purposes, you don’t need these elements, so let’s duplicate the view without any details.

1. Navigate to the East elevation in the Project Browser. Then right-click the name East elevation and choose Duplicate View ➔ Duplicate (Figure 9.6). This will make a copy of the view but without any annotation elements.
2. Right-click the bolded view Copy Of East and choose Rename. Give your presentation view the new name East – Presentation. Notice that the annotation elements are gone. Now let’s turn off the level markers and the reference planes in the view.

3. Select one of the green dashed reference planes, right-click, and choose Hide In View ➢ Category (Figure 9.7). Notice that all of the reference planes are now hidden.

4. Select one of the level graphics, right-click, and choose Hide In View ➢ Category. Notice that all of the level markers are now hidden.

**Designing with Generic Elements**

To reveal hidden elements and categories, click the Reveal Hidden Elements button on the View Control Bar. This is a special temporary mode where hidden elements are denoted by magenta lines. You can select any hidden element and chose Unhide from the ribbon. This will make the element visible in the view again.
Now you have a view that is ready to be embellished with the presentation drawing techniques found in the Graphic Display Options (GDO) dialog. You can access the GDO settings in three ways: the View Control Bar, the view Properties palette, or the keyboard shortcut GD. Once the GDO dialog is open, you will see an array of options. You'll start by adding shadows and a background.

1. Open the GDO dialog from the Properties palette by clicking the Edit button next to the Graphic Display Options parameter. This brings up the GDO dialog. Notice that the different options are collapsed by default (Figure 9.8).

![Graphic Display Options](image)

**Figure 9.8** Graphic Display Options

2. Expand the Shadows section. Click the Cast Shadows and Show Ambient Shadows check boxes. Now click the Apply button at the bottom of the dialog to see the effect these have on the model.

3. Expand the Background section. Chose Gradient from the drop-down list. Click Apply again to see this effect. You should see something similar to Figure 9.9.
FIGURE 9.9 Shadows and background

4. Expand the Lighting option, and find the Shadow slider control. You can slide this to the left to make your shadows lighter or to the right to make the shadows appear darker. Click Apply to see the effect. When you’re satisfied with the darkness of the shadows, click OK to close the GDO dialog.

The view is starting to look presentation-worthy, but the crop region needs to be adjusted. Adjusting the crop region is useful for many different views, but especially so for presentation drawings.

1. Select the crop region anywhere along the edge of your view. Note the blue grips that appear in the middle of the edges. These can be dragged so that the elevation is framed as you desire.

2. Once you have the elevation centered in the crop region, you can turn off the crop region. The visibility control for the crop region is on the View Control Bar at the bottom of the screen. Click the Hide Crop Region button. Now you have an elevation view ready to be placed on a sheet.
Presentation 3D Isometric Drawing

Now let’s perform a similar exercise, but instead of working with a 2D elevation view, you’ll work on a 3D isometric view. Working with the same file as before, please navigate to the 3D view titled 3D Isometric. The view is locked so that you cannot accidentally change the angle of the view. You can unlock the view by clicking the Unlock button on the View Control Bar, next to the Hide Crop Region button.

Now open the Graphic Display Options dialog and perform the same steps as you did previously with shadows, ambient shadows, and gradient background, shown here:

1. Click the Visual Styles button on the View Control Bar, and choose the Shaded option. Then click the Visual Styles again, but this time click the Graphic Display Options button at the top of the list. This is a handy shortcut to the GDO dialog.

2. Click the Cast Shadows and Show Ambient Shadows check boxes. Click the arrow next to the Background option, and choose Gradient from the drop-down list. Click Apply to see this effect.

3. Expand the Lighting option, and adjust the Shadow, Sun, and Ambient Light slider controls. The Sun and Ambient Light controls make an impact when your visual style is set to Shaded or Realistic. Set each of these values to 40, and click OK to exit the GDO dialog (Figure 9.10).

![Lighting sliders](image)

**FIGURE 9.10** Lighting sliders

So far, this is similar to the elevation presentation view. The large wall that is facing the view is blocking the interior of the house. In this isometric view, it would be nice to make this wall semi-transparent so you can understand what is happening inside the house.
1. Select the large brick wall (Figure 9.11). Right-click and choose Override Graphics In View ➢ By Element.

2. Click the arrow next to the Surface Transparency, and use the slider control to set the wall element’s transparency to 40. Click OK, and deselect the wall by hitting the Esc key twice.

3. Notice that you can see into the house, but the brick surface pattern is obscuring the view.

4. Select the wall again, right-click, and choose Override Graphics In View ➢ By Element. Expand the Surface Pattern control, and deselect the Visible parameter (Figure 9.12).
3D Exploded View

There is another way to see inside your architectural projects using an exciting new feature in Revit Architecture 2014: Displace Elements. Perhaps you are familiar with the architectural drafting convention of offsetting elements and then using dashed lines to represent the way in which a building is put together. The Revit tools that make this convention possible allow you to “displace” sets of elements in a view — much like overriding or hiding elements in a view.

Open the view in the model called 3D Exploded View. In the following steps, you'll displace the wall, then displace the windows from the wall, and finally connect them with dashed lines.

1. Select the large brick wall, and click the Displace Elements button on the View panel of the Modify tab (Figure 9.13).

2. Notice that a widget appears on the wall with green, red, and blue arrows. This is the control that allows you to move the set of elements. Click and hold the red arrow to drag the wall away from the house. Notice the windows move with the wall.
3. Now select one window by using the Tab key until the window highlights, and then click the mouse to select it. Then hold the Ctrl key, and select the other two windows. Click the Displace Elements button; when the widget appears again, drag the red arrow.

4. Select one of the windows, and from the ribbon choose the Path tool. Hover your mouse over one of the corners of your displaced window or wall. Click to place a dashed line path back to where the element originated. Now you have an exploded view (Figure 9.14).

Rendering Graphics

The technique of computer rendering is a complex science that has been simplified and tailored for architects in Revit Architecture. There are many expert computer renderers in the architecture field, and I recommend this tutorial as an initiation to the activity of rendering. However, please explore other techniques as well.

We’re going to focus on a simple exterior perspective view and show a typical workflow to get the materials, sunlight, and background right for a cover image to use in your document set. You’ll start by opening a perspective camera view.
1. Find the 3D Views node in your Project Browser. Double-click to open the view 3D Cover Shot. Get a quick preview of the materials used in the scene by switching to Realistic visual style from the cube on the View Control Bar.

2. If you’re unsatisfied with any of the materials used, you can follow the steps outlined earlier in this chapter to change the material’s Appearance properties (not the material’s Graphics properties) to make a material more suitable for renderings.

3. Open the Rendering dialog by clicking the teapot icon in the View Control Bar or by clicking the Render button on the View tab. This dialog looks very similar to the Graphic Display Options dialog, but this dialog does not have an OK or Cancel button. It has a big Render button at the top. Click it now.

4. Congratulations, you’ve just made a Revit rendering! Now let’s refine the quality of this image. First, change the Quality Setting to Medium, and click Render again. Then, change the Quality setting to High, and click Render again. Note that changing the quality settings improves the rendering but lengthens the time it takes to finish. Change the Quality setting back to Medium for the rest of this exercise.

5. After the High Quality rendering is finished, click the Sun Settings button in the Lighting group. The dialog that opens allows you to specify the location of the sun during your rendering. Change the Time setting from 10:15 a.m. to 1:15 p.m. (Figure 9.15), and click OK. Click Render again to see how this iteration changes the rendering.

6. Once the latest iteration of your rendering is complete, click the Adjust Exposure button. The very first slider control in this list allows you to lighten or darken the image. Adjust the Exposure Value
parameter to 13. The other sliders are useful if you want to adjust the colors of your image without using photo-editing software. Click OK, and notice the changes made—without having to rerender!

7. Let’s look at the Output Settings options. So far in this tutorial you’ve been rendering at screen resolution, so the rendering will finish faster. When switching to print output, you can specify the DPI. The higher the DPI, the longer the rendering takes. To have crisp edges in your finished rendering, set the DPI to 150.

8. Once this rendering finishes (Figure 9.16), click the Save To Project button. This will prompt you to name the image. The image will be saved in your Project Browser under the Renderings node. You can continue to test different rendering quality settings and background options. This is an iterative process; working from low quality to high DPI is a fast way to reach a finished image.

**Figure 9.16** The finished rendering
In this chapter, you learned how to render and create presentation graphics in elevation and 3D views. Using these techniques, you can visualize your model in interesting ways for presentations, for working out a detail, or for communicating construction methods.

**Additional Exercises**

- Use the 3D view called Kitchen to practice rendering with artificial lights. Make sure to set the light scheme in the Rendering dialog to a setting that includes artificial lights. Using exposure control is very helpful with interior renderings.

- Place some entourage in the house. Entourage people and plants are loaded into the project and can be placed by using the Component button (look for RPC Male and Female). Note that you cannot place this content in a perspective view.

- Try using the View property called Section Box to limit the amount of model elements in a view. This is one of the best ways to see inside your model in a 3D view. You can also render with Section Box active.

- Use the Region button next to the Render button to render a smaller portion of the entire view. This is useful for a fast test of a small section of the rendering you’re working on.
Worksharing

Understanding multiuser workflow is essential to completing your Autodesk® Revit® Architecture pilot project. There’s plenty of work to go around between the design, development, and eventual documentation of a building project.

If you’ve never used the Revit Architecture software before, you’re probably used to CAD. Multiuser workflow in CAD is a very different animal, so you may need to suspend your expectations of what it will be like to use Revit Architecture tools.

Whereas CAD projects are typically divided along the lines of what needs to be drawn (plan, section, and elevation at various levels of detail), Revit Architecture envelops you in the entire process. 2D, 3D, schedules, and so on, are in a single database, waiting for the input and direction of your team.

In this chapter, you learn the following skills:

- Enabling worksharing
- Creating central and local files
- Adding worksets
- Assigning elements to worksets
- Saving to the central file
- Creating new elements
- Worksharing display modes
- Editing requests
- Worksharing best practices
Enabling Worksharing

The first thing you’ll need to do is open the file from the end of Chapter 8, “Rooms and Color-Fill Plans.” If you don’t have the file, go to the book’s web page at www.sybex.com/go/revit2014essentials and download c10_Worksharing_Start.rvt.

Preparing the Central File

We strongly suggest that before you enable worksharing, you create a new copy of the file in order to back up your old work. For example, you may have been doing some schematic design planning in Revit Architecture, and now it’s time to add more people to the project in order to meet a deadline. Creating a copy of your old file (before enabling worksharing) is good practice and makes it easier should you need to return to your previous work.

In this case, prepare for this file to be the central file by naming it c10_Worksharing_Central_Finish.rvt (Figure 10.1). Then continue with these steps:

1. Open the file, go to the Collaborate tab and then the Worksets palette, and select the Worksets tool. This tool lets you enable and access worksets.
The Worksharing dialog box shown in Figure 10.2 appears, mentioning several important items.

![Fig. 10.2 The initial Worksharing dialog box](image)

- Datum objects are moving to a workset called Shared Levels and Grids.
- Project content that is not view specific (geometry and rooms) is all being assigned to Workset1.

All of this is fine and will allow you to enable worksharing. Click OK to continue.

2. The Worksets dialog box shown in Figure 10.3 opens. Your workset username appears in the Owner field. Currently, you own everything in the project. No one else can work on the project without your permission.

![Fig. 10.3 Worksets dialog box](image)
Creating Central and Local Files

In a real project, the next step would be to save your central file onto a server location so the entire project team could access the file. Team members never work in the central file directly; instead, they create and work in local files. Local files communicate directly with the central file, so it needs to be in an accessible location.

Creating the Central File

It’s a good idea to save the project, which will establish it as the central file. Before you save the file, think about where you want it to be located. When the central file is saved, it will include the file location as part of the project, so it can’t simply be moved after the fact. We won’t get into all the details now — just know that you should save the file in the desired location.

Navigate to Application ➣ Save As ➣ Project. Before clicking Save, click the Options button in the save dialog. The File Save Options dialog that opens assures you that this will be the central file and provides other options, such as the number of backups that Revit Architecture will maintain for the central file (Figure 10.4).

![File Save Options dialog](image)

**Figure 10.4** Saving the central file

Close the central file; you’ll now create a local copy.
Creating the Local File

When you work in Revit Architecture with worksharing enabled, you would typically never work directly in the central file. Rather, you will work on your own local copy of the central file, as will everyone else. These local copies are continuously communicating with the central file in order to avoid conflicts.

Click Open in the Application menu or Quick Access toolbar in the Revit Architecture software, and browse to your central file. Select it, but don't double-click. As shown in Figure 10.5, ensure that the Create New Local option is checked. Selecting this option will not open the central file but rather will create a local copy of the central file.

By default, your local copy is placed in your Documents folder with a suffix based on your username in Revit Architecture. In this author's case, the username is duellr. So, the local file is saved in the Documents folder as c10_Worksharing_Central_Finish_duellr.rvt (Figure 10.6).
FIGURE 10.6 Saving the local copy

Now that the local file has been created, you’re ready to create some user-defined worksets and then assign geometry to those worksets. Theoretically, other users could also start to access the central file and make their own local copies. But in practice, they’ll probably wait until the user-defined worksets are created and the geometry has been properly assigned.

Adding Worksets

To create worksets, follow these steps:

1. Open the Worksets dialog box under Collaborate ➤ Worksets.

2. Click New, and then create three additional worksets called Core, Exterior, and Interior, as shown in Figure 10.7. Keep in mind that worksets are not layers, and not much granularity is required. Basically, worksets should be used as collections of objects based on how you want them to be organized in the project.
The project you're using for this exercise is fairly modest. Interior, exterior, and core worksets are sufficient. If this were a multistory project, you would likely create interior worksets for each building level, as well as another workset for the roof and roof-related elements (such as equipment and skylights).

Once you've created the worksets, click OK.

3. Open the Visibility/Graphic Overrides dialog box for the view (press VG on the keyboard). As you can see in Figure 10.8, there's an additional Worksets tab that didn't exist before worksharing was enabled. This tab allows you to turn off elements based on their workset assignment.
Workset Visibility

You're about to begin assigning portions of the project to your user-defined worksets. As you do this, you want to be able to clear the view of elements that have already been assigned to one of your newly created worksets. Basically, you want to work “subtractively” by removing elements.

To do this, set the Visibility Setting column for the active view to Hide, as shown in Figure 10.8. As geometry is assigned to each of those worksets, it will disappear from view and keep you from accidentally selecting it again.

When you first enable worksharing in your project, the project geometry is organized between the Shared Levels and Grids and Workset1 worksets. Workset1 is the default project workset. The default workset can never be deleted (it can be renamed, though, so it may not always be called Workset1) and is a great place to put content when you're not sure which workset something should belong to. Now you can begin assigning elements to your user-defined worksets.

Assigning Elements to Worksets

Assigning elements to worksets is easily done. Just be sure of what you're selecting. You will often use the Filter tool and may work in more than one view. Except for rooms, it's often easier to select elements in 3D views. For this exercise, you'll keep it simple by working from the 2D Level 1 floor plan view. Follow these steps:

1. Select the elements shown in Figure 10.9—the walls in the lower-left corner of the plan.
2. On the Properties palette, the Workset field indicates the object’s workset assignment. Change this value from Workset1 to Core. Once you do so, the elements assigned to the Core workset are no longer visible in this view. Don’t be alarmed! Recall that in the previous section, you turned off the visibility for this workset, as well as others, so this behavior should be expected.

Now you’ll select all the interior elements and move them to a new workset rather than selecting one element at a time.

3. To select all the elements described, draw a selection window from the lower right to the upper left inside the exterior walls. Windowing from this direction will include every element you cross or include within the window you draw. (If you windowed from left to right, it would select only the elements fully contained within the selection box.)

4. Not all the selected elements can be assigned to user-defined worksets, so you need to use the Filter tool to deselect some of the elements. Choose Modify ➔ Filter. In the Filter dialog box, deselect Room Tags, Text Notes, and Views, as shown in Figure 10.10.
5. Assign these elements to the interior workset. Once again, don’t be alarmed when they seem to disappear.

6. For the final selection, select all the remaining walls that are visible in the view, and then select the Filter tool again. This time, choose only Walls in the Category list (Figure 10.11). Elements such as curtain panels, grids, and mullions automatically belong to their parent workset: Walls.

7. None of the geometry or rooms is visible in your project. Open the Visibility/Graphic Overrides dialog box for the view, and reset the visibility settings, as shown in Figure 10.12. All the elements once again become visible.
FIGURE 10.12  Resetting the visibility settings

At this point, you can save your project and synchronize it with the central file.

Saving to the Central File

There are several options available for saving your changes back to the central file. The following options are available on the Synchronize panel of the Collaborate tab:

Synchronize And Modify Settings  Synchronize And Modify Settings provides more specific control when saving the central file. The dialog box shown in Figure 10.13 displays the central file location and gives you options to relinquish worksets, compact the central file, and save your local file (after the sync with the central file is complete).

FIGURE 10.13  Synchronize And Modify Settings options
Synchronize Now  This option is probably more frequently used than the other options. Consider creating a keyboard shortcut so you don’t have to return to this tab as you work when you want to save to the central file.

Synchronize Now saves your local copy and syncs with the central file as well as updates your file with any changes from the central file. Any borrowed elements are also relinquished. But if you have an entire workset checked out, it’s not checked back in. It will still be editable by you after the save completes.

Reload Latest  The Reload Latest option lets you reload the latest version of the central file in your local project. However, it doesn’t publish any of your work in the central file.

Relinquish All Mine  Relinquish All Mine allows you to check in elements that you may have borrowed but did not change. If you’ve made changes, you have to either sync them with the central file or discard the changes without saving. You cannot relinquish elements in a file that has been modified.

So, what do you do if you’ve made changes that you want to get rid of? If Undo is not an option, the only other approach is to close the file and select the Do Not Save The Project option (Figure 10.14). This will close the project without saving your work or syncing with the central file.

If you select this option, Revit Architecture will ask you what to do with the elements you’ve borrowed or worksets you have enabled (Figure 10.15). If you relinquish the elements and worksets, other people will be able to modify them in their local files. If you keep ownership, the changes you’ve made will be lost, but you’ll still have the elements and worksets enabled.
When you have no elements or worksets enabled in a project, you can confirm this by opening the Worksets dialog box in Figure 10.16.

You'll continue by adding new elements to your local file.

Creating New Elements

When worksharing is enabled, you'll want to make sure that any new geometry (including rooms) you add is being assigned to the right workset. You're going to add some new furniture to the project, so you need to make the interior workset active. The following activity involves creating groups in Revit. For a more
detailed explanation of groups, you can also reference Chapter 14, “Repeating Objects, Best Practices, and Quick Tips.”

1. Copy a group of furniture from room 105 to room 103, as shown in Figure 10.17. Because the active workset is Interior, the elements in the group are assigned to this workset.

   **Figure 10.17** Copying a group

   Revit Architecture automatically assigns elements within a group to be on the same workset as the group itself. Now you’ll duplicate an existing component, create a new type, and then use this new type in the project.

2. Duplicate the table. In the Project Browser, expand Families ➔ Furniture ➔ Table-Rectangular, right-click 72" × 30" (180 cm × 75 cm), and choose Duplicate from the context menu (Figure 10.18).
3. To modify the duplicated table, select the table again in the Project Browser, right-click, and choose Type Properties. Click the Rename button in the Properties dialog to rename the type to 144" × 48" (350 cm × 120 cm).

4. Modify the dimensional parameters as shown in Figure 10.19, changing the Height, Length, and Width values. Doing so creates a significantly larger table for use in your conference rooms. Click OK to finish editing the family.
5. Place a new instance of the table in the project (Figure 10.20). Again, because Interior is the active workset, the table is assigned accordingly.

![Figure 10.20 Adding the table to the project](image-url)

6. Place chairs around the table, as shown in Figure 10.21.

![Figure 10.21 Adding chairs to the table](image-url)

This grouping of furniture will be a useful addition to other meeting spaces in the project. But rather than copy them as separate
elements, it will be more helpful to create a group and then copy this group in the project.

7. Select all the elements in the furniture group, and then select the Group tool. Name the model group Large Table and Chairs. Click OK.

   Note that the group is also assigned to the active workset (Figure 10.22).

![Workset assignment for the new group](image)

**FIGURE 10.22** Workset assignment for the new group

### Opening and Closing Worksets

As you work on larger and larger projects (or even very dense small projects), worksets are a great way to help you isolate and focus on what you’re trying to accomplish. And although each view has its own visibility settings, when you want to isolate (or hide) elements throughout your project, worksets offer helpful options.

Open the Worksets dialog box, and notice that currently all the user-created worksets are set to Opened. This is fine if you need to see everything at once. But for larger projects or in cases where you want to limit what you’re seeing
across all project views, you can selectively open and close worksets. Leave the Interior workset set to Yes so that it remains Opened, but set the other worksets to No by clicking the pull-down menu for each workset (or select multiple worksets by holding the Ctrl key and picking each workset, and then click the Close button on the right). Click OK to close the dialog box.

The results are immediate (Figure 10.23). Only the interior workset is shown in all your project views (3D, perspective, plan, elevation, section, and so on).

Now that you have a good understanding of how to place elements on an active workset as well as open and close worksets selectively, you’ll explore workset display filters.

**Worksharing Display Modes**

Worksharing display modes are a great way to visually understand many things about your project. To create this scenario, all three authors are accessing this file at the same time. There’s a central file on the server, and we’re all working from our local copies.

Furthermore, all of us have borrowed elements in the central file. In the past, it was difficult to see who had ownership of certain elements, and this issue often created workflow problems when borrowed elements were modified.
In Figure 10.24, the Worksets dialog box shows that no worksets are editable but that another user has borrowed elements.

**FIGURE 10.24** Borrowed elements in the Worksets dialog box

Now let’s look at the worksharing display settings available for worksharing display in a project: Checkout Status, Owners, Model Updates, and Worksets. These settings are based on the particular parameters in your project (number of worksets, active users, and so forth). To activate any of these settings, click the icon in the lower portion of the Revit Architecture project window, and choose one of the menu items from the list (Figure 10.25).

**FIGURE 10.25** Worksharing Display Settings options

Activating any of the worksharing display modes from the menu toggles your visibility settings and applies an orange border to the view you’re in, alerting you that you’ve activated the mode. To turn them back off, choose the Worksharing Display Off option from the same menu.

Let’s set some of these modes active one at a time and view the results. Click on the Worksharing Display button and choose Worksharing Display Settings. Start with the Checkout Status tab; the checkout status helps you distinguish between elements that are owned by you, others, or no one (Figure 10.26).
Individual owners will help you visualize exactly which elements belong to which users (Figure 10.27).

The Worksets tab helps you visualize elements based on the workset to which they're associated (Figure 10.28).
Eventually while working on a project team, another user will own an element you need to modify. To modify that element, the other user will first need to relinquish it. Let’s take UserA and UserB as a simple example for this scenario.

UserA attempts to modify a wall but receives a dialog noting that UserB currently owns the element. UserA clicks the Place Request button in the dialog so UserB will be notified (Figure 10.29).

![Figure 10.29: Placing a request](image)

While UserB is working in their local file, they receive a modal Editing Request Received dialog indicating that UserA has requested the wall element. UserB clicks Grant, which will give editability to UserA for that wall element only (Figure 10.30).

![Figure 10.30: Grant request](image)

Lastly, UserA receives the confirmation dialog back that UserB has granted access to the wall element (Figure 10.31). In this example, no further action is required from UserA; UserA can start making modifications to the wall. The editing request serves as both a user notification system and an automated method to swap element ownership.
Worksharing Best Practices

Now that you have a general understanding of how worksharing and worksets operate, let’s take a moment to consider a few best practices.

**Think of worksets as containers.** Worksets aren’t layers as in CAD. Think of them as containers for major systems in your building (interior, exterior, roof, core, and so on). You need to manage or be mindful only of stuff that belongs to user-created worksets, such as the following:

- Datum (levels and grids)
- Geometry (building elements that show up in multiple views)
- Rooms (the spaces that can be tagged)

**Be mindful of the active workset.** As you’re creating datum, geometry, or rooms, be mindful of the active workset. And keep in mind that Revit Architecture automatically manages the worksets for everything else (views, families, and project standards), and these cannot be changed by the user.

**Borrow elements on the fly.** Don’t check out worksets by making the entire workset editable. Instead, just borrow elements on the fly. This approach lets you
avoid many conflicts that occur when one person needs to modify something you own (but don’t really need) in the model. With the interconnected nature of buildings, you don’t even need to deliberately make an element editable. All you have to do is modify an existing element, and Revit Architecture will transparently borrow it for you. This works the same when adding new elements as well.

**Associate linked files to their own workset.** Associate any linked files to their own workset. Then you can open and close the worksets associated to those links. This strategy is much more predictable than loading and unloading links (which will have an effect on everyone working on the project). Opening or closing a workset affects only your local file.

**Stay out of the central file.** Stay out of the central file — don’t move it, and don’t rename it (unless you know what you’re doing). Opening the central file restricts access by the files that are trying to connect to it. And if you break something in the central file, you’ll break the connections that others have from their local copy, which means they may end up losing their work, which in turn means your team will not like you.

**Open and close worksets selectively.** Selectively opening and closing worksets is a lot faster than opting to modify the visibility settings of multiple views or using hide/isolate on a view-by-view basis. If you’re supposed to be working only on the core and internal areas of a multistory building, opening only the worksets associated to those areas will save a lot of computing power.

---

**The Essentials and Beyond**

Worksets are straightforward once you understand the basics. Larger projects will require more granular workset assignments, but the principles are the same.

**Additional Exercises**

- Use the previous exercise with a friend or co-worker to access the same project at the same time.

- Link a Revit Architecture project into a file that has worksharing enabled. Assign the linked file to a workset, and then practice opening and closing the workset. What happens to the linked file?

- Create a workset named Entourage, and make it not visible by default. Use this workset for elements that are useful for visualization but not documentation.

- Practice locking the datum (levels and grids) by making the workset editable to you and not relinquishing it. Others will be able to graphically adjust the end points, but they won’t be able to move or delete the datum.
Details and Annotations

So far, you have used the Autodesk® Revit® Architecture software to create walls, doors, roofs, and floors; to define space; and to bring your architectural ideas into three-dimensional form. In each of these cases, the geometry is typically modeled based on a design intent, meaning that your goal hasn’t been to model everything but rather to model enough to demonstrate what the building will look like. To this end, it becomes necessary to embellish parts of the model or specific views with detailed information to help clarify what you’ve drawn. This embellishment takes the shape of 2D detail elements in Revit Architecture that you will use to augment views and add extra information.

In this chapter, you learn the following skills:

▶ Creating details
▶ Annotating your details
▶ Using legends

Creating Details

Even when you’re creating details, Revit Architecture provides a variety of parametric tools that allow you to take advantage of working in building information modeling (BIM). You can use these tools to create strictly 2D geometry or to augment details created from 3D plans, sections, or callouts. To become truly efficient at using Revit Architecture to create the drawings necessary to both design and document your project, you must become acquainted with these tools.

These view-based tools are located on the Detail panel of the Annotate tab (Figure 11.1). This small but very potent toolbox is what you will need to familiarize yourself with in order to create a majority of the 2D linework and components that will become the details in your project. To better
understand how these tools are used, let’s quickly step through some of them. You’re going to use the Detail Line, Region, Component, and Detail Group tools, because they will make up your most widely used toolkit for creating 2D details in Revit Architecture.

**Detail Line**

The Detail Line tool is the first tool located on the Detail panel of the Annotate tab. This tool is the closest thing you’ll find to traditional drafting in the Revit Architecture software. It lets you create view-specific linework using different lineweights and tones, draw different line shapes, and use many of the same manipulation commands you would find in a CAD program, such as offset, copy, move, and so on.

Detail lines are view specific — they appear only in the view in which they’re drawn. They also have an arrangement to their placement, meaning you can layer them under or on top of each other or other 2D objects. This feature is especially important when you begin using regions, detail lines, and model content to create details.

Using the Detail Line tool is fairly easy. Selecting the tool changes your ribbon tab to look like Figure 11.2. This tab has several panels that allow you to add and manipulate linework.
This tab primarily contains three panels: Modify, Draw, and Line Style. You've seen the Modify panel before. It contains the host of tools you've used so far for walls, doors, and other elements. Here you can copy, offset, move, and perform other tasks. The Draw panel lets you create new content and define shapes, and the Line Style drop-down allows you to choose the line style you'd like to use.

**Region**

The next tool on the Detail panel of the Annotate tab is the Region tool. *Regions* are areas of any shape or size that you can fill with a pattern. This pattern (much like a hatch in AutoCAD) dynamically resizes with the region boundary. Regions layer just like detail lines do and can be placed on top of, or behind, other 2D linework and components. Regions also have opacity and can be completely opaque (covering what they are placed on) or transparent (letting elements show through).

There are two types of regions: filled regions and masking regions. *Filled regions* allow you to choose from a variety of hatch patterns to fill the region. They are commonly used in details to show things such as rigid insulation, concrete, plywood, and other material types defined by a specific pattern. *Masking regions*, on the other hand, come in only one flavor. They are white boxes with or without discernible border lines. Masking regions are typically used to hide, or *mask*, from a view certain content that you don't want shown or printed.

**Component**

The Component drop-down menu lets you insert a wide array of component types into your model. These are 2D detail components, or collections of detail components in the case of a repeating detail. Detail components are schedulable, taggable, keynotable 2D families that allow an additional level of standardization in your model. Some examples of when you'd use detail components are blocking, steel shapes, and brick coursing in section — just about any replicated 2D element that comes in a standardized shape.

Detail components are 2D families that can be made into parametric content. In other words, a full range of shapes can be available in a single detail component. Because they are families, they can also be stored in your office library and shared easily across projects.
To add a detail component to your drawing, select Detail Component from the Component drop-down list located on the Annotate tab, and use the Type Selector to choose from detail components that are already inserted into the model. If you don’t see a detail component you want to insert in the Type Selector, click the Load Family button on the Modify | Place Detail Component tab and insert one from the default library or your office library.

Creating a Detail

Making a detail component is much like creating a 2D family. Let’s step through making a simple 2D detail component.

From the book’s web page (www.sybex.com/go/revit2014essentials), download the c11-Detail-Start.rvt file and open the view Exterior Detl, Typ, which you’ll find in the Sections (Building Section) node of the Project Browser. In the next few steps, you’ll create some detail components and regions to get started with a typical window detail:

1. Use the Callout tool on the View tab to create a new detail of the second-floor window sill: create a new callout, and name it Exterior Window Sill, Typ. The starting view looks like Figure 11.3.

![Figure 11.3](image-url)
Now, let’s make the detail. You have some detail elements that can’t exist in real-life construction. For example, you’d never run the sheetrock back behind the floor slab, and there’s no room for flashing or blocking below the window. You need to modify this view to rectify these conditions. Let’s start with the floor slab and fix the sheetrock. To do this, you’ll cover a portion of this area with a filled region.

2. Click the Filled Region button on the Annotate tab. Choose Invisible from the Line Style drop-down on the Modify tab, and create a box bounding the floor slab (Figure 11.4).

![Figure 11.4 Modifying the boundary of the filled region](image)

Two of the bound lines are on cut planes of the floor: the top and bottom edges of the box. Select these edges, and use the Line Style drop-down to change the lineweight to Medium Lines.

3. Click the Edit Type button in the Properties palette to open the Type Properties dialog box. Because there is no defined region type that is identical to existing materials, you need to make one. Click Duplicate, name the new region type 00 Existing, and click OK.

4. Modify these settings in the Properties palette:
   - Fill Pattern: Set this field to Drafting, and choose ANSI31.
   - Background: Set this to Opaque.
   - Line Weight: Set this to 1.
   - Color: Set this to Black.

Click OK when you’re done.
5. Click the green check mark \( \checkmark \) to complete the sketch. Your finished filled region appears highlighted and slightly transparent. Click off the region to see the finished product. When you do this, notice that the invisible line on the left doesn’t cover the cut of the wall, and a thinner line remains. To cover the remainder of the existing wall, highlight the filled region again and use the Nudge tool (the arrow keys on the keyboard) to move the region over slightly. The finished region looks like Figure 11.5.

![Figure 11.5 Adding the filled region](image)

As part of the window-sill condition, say you know you have a 1" (25 mm) gap between the bottom of the window sill and the top of the existing masonry opening. This gap isn’t reflected in the window detail currently because the window family was created to cut a square opening just big enough for the window. For this detail, you need to create a masking region under the window sill so you can add some other components, such as blocking.

6. Choose the Masking Region tool from the Region flyout on the Annotate tab.

7. With Line Style set to Thin Lines, create a box 1" (25 mm) deep under the window sill (Figure 11.6).
8. Click the green check to complete the sketch. The finished sill looks like Figure 11.7.

![Figure 11.7 The completed sketch](image)

The next step is to add some detail components for blocking and trim. Choose Application ➤ New ➤ Family, and choose Detail Item.rft. When you’re creating detail components, as with any other family, you’ll start with two reference planes crossing in the center of the family. This crossing point is the default insertion point of the family.

The first family, blocking, is straightforward. You’ll use Masking Region instead of the Lines tool so you have a clean, white box that you can use to layer over and mask other elements you might not want to see.

1. Select the Masking Region tool on the Create tab, and draw a box with the lower-left corner at the origin. The box should be 1” (25 mm) high and 3” (75 mm) wide. Click the green check to complete the region.

2. On the Create tab, click the Line tool, and draw a line diagonally across the box to denote blocking. The family should look like Figure 11.8.
3. Choose Application ➢ Save As ➢ Family, and name the family 06 Blocking. Place it in a folder with the model.

4. Click the Load Into Project button at the far right on the ribbon to add the family to the model.

5. To add the blocking detail component to your view, return to the Exterior Window Sill, Typ. detail, and click the Detail Component button on the Annotate tab.

6. The component you insert will become the default component; you can see the name 06 Blocking in the Type Selector. Insert a piece of blocking at the left, right, and center of the sill (Figure 11.9).

7. Let’s make one more detail component for the baseboard. Create a new detail item using steps 1–6; for this item, use the dimensions 1" (25 mm) wide by 6" (150 mm) high, and name the new family 06 Baseboard. Save the baseboard, and click Load Into Project. Make sure the view Exterior Window Sill, Typ. is activated, and place the baseboard at the corner of the gypsum board and finished floor. The detail looks like Figure 11.10.
You create these elements as families and not just as filled regions so that later in the detailing process you can annotate them using the Keynote tool. Families offer a lot more functionality and versatility down the line for faster documentation.

You can't complete all the detailing using components. Sometimes, it is easier and more effective to simply use detail lines to create the necessary features in a detail. For these purposes, you want to create some flashing at the window sill.

8. Choose the Detail Line tool, and select Medium Lines from the Line Style drop-down menu.

9. Using the Detail Line tool, draw in some flashing for the window sill (Figure 11.11).
Arranging Elements in the View

So far, you have created all the content in order and have not had to change the arrangement of any of the elements. However, knowing how to change arrangement is an important part of detailing, so you don’t have to draw everything in exact sequence. Arrangement allows you to change the position of an element, such as a line or a detail component, relative to another element. Much like layers in Adobe Photoshop or arrangement in Microsoft PowerPoint, Revit Architecture allows you to place some elements visually in front of or behind others. Once an element or group of elements is selected and the Modify menu appears, on the far right you’ll see the Arrange panel.

From here, you can choose among four options of arrangement: Bring To Front, Bring Forward, Send To Back, and Send Backward. Bring Forward and Send Backward are available selections using the drop-down arrows next to Bring to Front and Send to Back, respectively. Using these tools will help you get your layers in the proper order.

Repeating Detail Component

Repeating elements are common in architectural projects. Masonry, metal decking, and wall studs are some common elements that repeat at a regular interval. The Revit Architecture tool you use to create and manage these types of elements is called Repeating Detail Component, and it’s located in the Component flyout on the Annotate tab.

This tool lets you place a detail component in a linear configuration in which the detail component repeats at a set interval; you draw a line that then becomes your repeating component. The default Revit Architecture repeating detail is common brick repeating in section. Creating elements like this not only lets you later tag and keynote the materials but also allows you some easy flexibility over arraying these elements manually.

Before you create a repeating detail component, let’s examine one such component’s properties. Select Repeating Detail Component and choose Edit Type from the Properties palette to open the Type Properties dialog box shown in Figure 11.12.
Here’s a brief description of what each of these settings does:

**Detail**  
This setting lets you select the detail component to be repeated.

**Layout**  
This option offers four modes.

- **Fixed Distance**  
  This represents the path drawn between the start and end points when the repeating detail is the length at which your component repeats at a distance of the value set for Spacing.

- **Fixed Number**  
  This mode sets the number of times a component repeats itself in the space between the start and end points (the length of the path).

- **Fill Available Space**  
  Regardless of the value you choose for Spacing, the detail component is repeated on the path using its actual width as the Spacing value.

- **Maximum Spacing**  
  The detail component is repeated using the set spacing, and the number of repeated components is set so that only complete components are drawn. Revit Architecture creates as many copies of the component as will fit on the path.

**Inside**  
This option adjusts the start point and end point of the detail components that make up the repeating detail. Deselecting this option puts only full components between start and end points rather than partial components. As an example, if you have a run of brick, selecting the Inside check box will make a partial brick at the end of the run. If you want to see only full bricks (none that would be cut), deselect the option.
**Spacing** This option is active only when Fixed Distance or Maximum Spacing is selected as the method of repetition. It represents the distance at which you want the repeating detail component to repeat. It doesn’t have to be the actual width of the detail component.

**Detail Rotation** This option allows you to rotate the detail component in the repeating detail.

With these settings in mind, let’s create a custom repeating detail for the sill detail you’ve been working on. The exterior of the building is terracotta brick and will have visible joint work every 8” (200 mm). Follow these steps:

1. Select a new Detail Component family again. Choose Application ➢ New ➢ Family, and choose Detail Item.rft from the list.

2. Create a masonry joint 6" long and 3⁄8" (10 mm) high with a strike on one of the short ends (Figure 11.13) using a filled region. Save the family as 04 Grout, and load it into the project.

![Figure 11.13 The grout detail component](image)

3. Back in the project, go to the Annotate tab’s Detail panel, open the Component flyout, and choose the Repeating Detail Component tool. Choose Edit Type from the Properties palette, and then click the Duplicate button in the Type Properties dialog. Name the new type 04 Terracotta Grout, and click OK.

4. You need to change the properties of this new type to reflect the detail component you just created and its spacing. Change the following fields:

   - **Detail**: Set this field to 04 Grout, the family you just created.
   - **Spacing**: Set this value to 8" (200 mm).

   You can leave the rest of the fields alone. Click OK when you’re finished. The Type Properties dialog box looks like Figure 11.14. Click OK when you’re done.
5. Because you’re still in the Repeating Detail command, you can begin drawing a line with the repeating detail. Starting at the base of the view, draw a line all the way up the left edge, placing the new joint over the terracotta exterior.

6. You can further finesse the appearance by placing one of the joints directly below the window sill. This appears placed on top of the flashing you drew earlier, so you’ll want to move the flashing to the front. Select the flashing detail line, and choose Bring To Front from the Arrange panel. The completed detail looks like Figure 11.15.

---

**FIGURE 11.14** The repeating detail’s type properties

5. Because you're still in the Repeating Detail command, you can begin drawing a line with the repeating detail. Starting at the base of the view, draw a line all the way up the left edge, placing the new joint over the terracotta exterior.

6. You can further finesse the appearance by placing one of the joints directly below the window sill. This appears placed on top of the flashing you drew earlier, so you'll want to move the flashing to the front. Select the flashing detail line, and choose Bring To Front from the Arrange panel. The completed detail looks like Figure 11.15.

---

**FIGURE 11.15** The finished window-sill detail
Although this detail needs annotations before you can think about placing it onto a sheet, you can begin to see how you have used the 3D geometry of the model and were able to quickly add embellishment to it in order to create a working project detail. For now, save this detail. You’ll return to it later in the chapter.

**Insulation**

The best way to think of the Insulation tool is like a premade repeating detail. You’ll find this tool on the Detail panel of the Annotate tab.

Selecting this tool allows you to draw a line of batt insulation, much like a repeating detail. You can modify the width of the inserted insulation from the Options Bar (Figure 11.16). The insulation is inserted using the centerline of the line of batt, and you can shorten, lengthen, or modify the width either before or after inserting it into your view.

![FIGURE 11.16 Modifying the Insulation width in the Options Bar](image)

**Detail Groups**

Detail groups are similar to blocks in AutoCAD and are a quick alternative to creating detail component families. Like modeled groups, these are a collection of graphics though contain detail lines, detail components, or any collection of 2D elements. While you will probably want to use a detail component to create something like blocking, if you plan to have the same blocking and flashing conditions in multiple locations, you can then group the flashing and blocking together and quickly replicate these pieces in other details. Like blocks in AutoCAD, manipulating one of the detail groups changes all of them consistently throughout the model.

There are two ways to make a detail group. Probably the most common is to create the detail elements you’d like to group and then select all of them. When you do, the Modify context tab appears: click the Create Group button under the Create panel to make the group. When you’re prompted for a group name, name the group something clear like **Window Head Flashing** or **Office Layout 1** rather than accepting the default name Revit Architecture wants to give it (Group 1, Group 2, and so on).
The other way to create a detail group is to go to the Annotate tab’s Detail Group flyout and click the Create Group button. You are prompted for the type of group (Model or Detail).

**Model**  Model groups contain model elements (elements that are visible in more than one view). Choose Model if you want elements to be visible in more than one view or if they are 3D geometry.

**Detail**  Detail groups contain 2D detail elements and are visible only within the view you’re in (you can copy or use them in other views). Choose Detail if you’re creating a group containing detail lines or other annotations and 2D elements.

You cannot create a group that has both model elements and detail elements. When you select the elements, you’re taken into Edit Group mode. A yellow transparency is overlaid on top of the view, and elements in the view appear gray. To add elements to the group, select Edit Group and then click the Add button (Figure 11.17). You can also remove unwanted elements. When you’re finished, click the green Finish check mark, and your group will be complete.

![Edit Group panel](image)

**Figure 11.17**  The Edit Group panel

You can place any group you’ve already made using the Place Detail Group button on the Annotate tab’s Detail panel. Groups insert like families, and you can choose the group you’d like to insert from the Type Selector on the Properties palette.

**Linework**

Although not part of the Annotate tab, the Linework tool is an important feature in creating good lineweights for your details. Revit Architecture does a lot to help manage your views and lineweights automatically, but it doesn’t cover all the requirements all the time. Sometimes the default Revit Architecture lines are heavier or thinner than you desire for your details. This is where the Linework tool comes in handy; it allows you to modify existing lines in a view-specific context.
To use the Linework tool, go to the Modify tab’s View panel and click the Linework button, or use the keyboard shortcut LW. You will see the familiar Line Styles Type Selector panel on the right of the tab, and you can select a line style from the list. Simply choose the style you want a particular line to look like; then select that line in the view. The lines you pick can be almost anything: cut lines of model elements, families, components, and so on. Selecting the line or boundary of an element changes the line style from whatever it was to whatever you have chosen from the Type Selector. Figure 11.18 shows a before and after of the sill detail with the linework touched up.

You can also choose to visually remove lines using this tool. Doing so leaves the line in the view or as a part of the 3D element but makes it effectively invisible for the sake of the view. Do this by selecting the <Invisible> line type. This is a good alternative to covering unwanted linework with a masking region. You also have the ability to return a line to its default lineweight by using the <By Category> line type.

### Annotating Your Details

Notes are a critical part of communicating design and construction intent to owners and builders. No drawing set is complete without descriptions of materials and notes about the design. Now that you’ve created a detail, you need to add the final touches of annotations to communicate size, location, and materiality. The tools you will use for annotations are found on the same Annotate tab that you used to create details. These are the Dimension, Text, and Tag panels shown in Figure 11.19.
Annotating Your Details

FIGURE 11.19 The Revit Architecture annotation tools

Dimensions

In your detail, you have added aspects to the window family to reflect some of the details needed for construction. Now, with much of the linework and elements in the view, you need to annotate and add dimensions. The dimension tool you will use most often is Aligned, located on the left side of the Dimension panel and highlighted in Figure 11.19. It can also be found on the Quick Access toolbar.

Let’s begin by adding dimensions to the detail you just created.

1. Select the Aligned dimension tool, and place a dimension string from the grid line to the centerline of the wall, as shown in Figure 11.20.

2. Now that you’ve placed the dimension, you realize it’s in the wrong location: you want the left side at the exterior wall. Dimensions are dynamic in Revit Architecture and easy to relocate. Highlight the dimension string, and you see two sets of blue dots on either side. One set controls the length of the witness line (the line that extends from the actual element you dimensioned to the tick mark), and the other (on top of the tick mark) controls the witness line’s location.
Select this blue dot that controls the witness line location, and drag it to the exterior of the wall. The dimension automatically updates.

3. Add another dimension string from the grid line to the back of the window jamb.

4. The dimension you just added doesn’t read very well because it’s located over the window sill. You need the dimension located there, but you can relocate the text. To do so, grab the blue dot under the text and drag the text string to the right. Once the dimension text is outside of the dimension string, Revit Architecture adds an arc associating the text to the dimension (Figure 11.21).

5. Add another dimension that locates the gypsum board relative to the grid line (Figure 11.22). By default, the exterior face of the gypsum board won’t highlight to accept the dimension. With your mouse hovering over the right edge of the gypsum board, press the Tab key, and you can place the other side of the dimension string.
6. In this dimension, the dimension text has a white box similar to a masking region that lies behind the text and covers some of the detail of the sill condition. You can eliminate this box so the dimension string reads clearly and doesn’t cover underlying elements. To do this, highlight the dimension by left-clicking it, and select Edit Type from the Properties palette. The Type Properties dialog box for dimensions opens, as shown in Figure 11.23.

**Figure 11.23** Dimension type properties

This dialog box allows you to change all the dimension settings: text, color, length of each dimension element, and so forth.

7. Scroll to the bottom to find the Opaque/Transparent setting under Text Background. This controls that white box behind the dimension. Set it to Transparent, and click OK. The dimension now has a transparent background.

8. Let’s add one final dimension string. Add a dimension locating the window sill relative to the floor, as shown in Figure 11.24.
9. This dimension is an awkward length and probably isn’t something you want to include in the CD set. Remember that in Revit Architecture, dimensions report the relative location of objects — they cannot be forced with values. So, to change the dimension string, you need to change the location of one of the two objects you’ve dimensioned. The floor probably isn’t going to move, but you can reposition the window slightly.

Select the window. The dimension string turns blue, and the numbers become very small (Figure 11.25).
10. You can now enter a more reasonable value. Select the blue text, and type 1 4 (400 mm) in the text box (Figure 11.26). Press Enter. The window pushes up just a bit and resets the dimension string.

![Figure 11.26 Entering a value into a dimension string](image)

With all the dimensions on the detail, it should look like Figure 11.27.

![Figure 11.27 The dimensioned detail](image)
Tags

Now that you have embellished and dimensioned the detail, it’s time to add some tags. Tags are 2D view-specific elements that attach to modeled or detail elements to report information based on that element’s type or instance properties. Any modeled or detail element can be tagged; however, they are most commonly used to identify your basic building blocks — doors, windows, wall types, and rooms. In this exercise, you’ll tag the window as well as some of the materials in the detail to help identify these items to the contractor. You can add Material tags through the Material Tag button on the Annotate tab’s Tag panel. Begin by tagging the window.

1. Choose the Tag by Category button on the Annotation tab’s Tag panel, and select the window.

   Revit Architecture displays the warning shown in Figure 11.28. It tells you that Revit Architecture has added a tag but that it has fallen outside of your view. By default, Revit Architecture places tags in the center of the element being tagged. In this case, the tag resides in the middle of the window cut in section, which is above your crop box.

   ![Figure 11.28](image-url)

   **Figure 11.28** The tag fell outside of the crop window.

2. To remedy this, select the box that defines the crop region for the detail. Doing so highlights the crop box and also an invisible, dashed box called the *annotation crop box*. This crop window can be turned on and off through the Properties palette.

   Drag the upper limit of the annotation box higher, and you will eventually see the Window tag you placed on the window (Figure 11.29).
3. The tag has a leader line associated with it. You want to move the tag but also remove the leader line. To do so, highlight the tag, and, in the Options Bar, deselect the Leader check box that is shown checked (Figure 11.30). Doing so lets you drag the tag down — leader free — and place it in the crop region.

![Extending the annotation crop window](image)

**Figure 11.29** Extending the annotation crop window

4. Now let's add a Material tag. Material tags let you tag materials consistently throughout the model. This means if you tag something like Concrete once in the model, the material will remember the tag you used and show that same tag every time you tag it in any other view.

To add the tag, choose the Material Tag button from the Tag panel. With the tag selected, mouse over the vertical panel shown in Figure 11.31. The material there has been prepopulated with 5/8" GYPSUM BD as a tag through the material (from the Manage tab). Select the material, and place the tag.

![Removing the leader from the Window tag](image)

**Figure 11.30** Removing the leader from the Window tag
5. Notice that by default the tag has no arrowhead. Select the tag, and choose Edit Type from the Properties palette. Here in the tag’s Type Properties dialog, you can assign an arrowhead. Choose 30 Degree Arrow for the Leader Arrowhead property, and click OK (Figure 11.32).

In the same way, you can populate the remainder of the materials in the detail. For materials that aren’t already specified, Revit Architecture will display a question mark. Click it, and you can enter the text describing that material; all other materials of that type in the model will automatically show the text you just entered. Changes made to this material will also be broadcast throughout the model.
Text

Not all elements in Revit Architecture have materiality to them, and sometimes tags are not the best way to convey information. In these cases, you can use text. The Text tool is located on the Text panel of the Annotate tab.

When you're using text in your model, it's important to remember that text is not linked to any element or material. If you label something with text or use text to call out notes, the text doesn't dynamically update as elements change in the model.

In your example detail, the shims you placed as part of the window family do not have a way to tag a material and need to be called out using text. Here are the steps:

1. Choose the Text command on the Annotate tab. Doing so opens the Modify | Text tab. The tools on the Format panel control the leaders, leader location, justification, and font formats, respectively.

   For now, leave the selections at the defaults, choose a location on the screen, and click the left mouse button. Doing so begins a text box. Type 1/2" SHIMS (Figure 11.33).

   ![Figure 11.33 Adding text to the detail](image)

2. When you add text to the box, the Modify menu changes. You now have the option to add and remove leaders. To add a leader, click the Add Leader button at the upper left of the Format panel.

   Move the text and leader into position with the other notes. In this way, you can complete the annotations on the detail (Figure 11.34) and begin the next one.
Legends are unique views in Revit Architecture because you can place them on more than one sheet, which is not typical for most view types. These can be great tools for things such as general notes, key plans, or any other view type you want to be consistent across several sheets. It’s important to note that anything you place inside a legend view — doors, walls, windows, and so on — will not appear or be counted in any schedules. Legend elements live outside of any quantities present in the model.

The Legend tool is located on the View tab. You can create two types of legends from this menu: a **legend**, which is a graphic display, or a **keynote legend**, which is a text-based schedule. Both legend types can be placed on multiple sheets, but for this exercise, you’ll focus on the legend.

As part of the sample workflow, you may want to present some of the wall types as part of your presentation package to demonstrate the Sound Transmission Class (STC) of the walls and the overall wall assembly. Because these wall types will appear on all the sheets where you use them in the plan, you’ll make them using a legend.

1. Choose the Legend button on the View tab’s Legends flyout. Creating a new legend is much like creating a new drafting view. A New Legend View dialog box opens (Figure 11.35) where you can name the legend and set the scale. Name this legend **WALL LEGEND**, and choose 1" = 1'-0" (1:10) for the scale. Click OK to create the legend.
FIGURE 11.35 Creating a legend

The legend you’ve created looks like a blank view. At this point, it’s up to you to add content. The simplest type of legend would include notes such as general plan or demolition comments that would appear in each of your floor plans. You could do this by using the Text tool and adding text in this legend view; however, in this example, you want to add more than just text.

2. To add wall types or any other family to the legend view, expand the Families tree in the Project Browser and navigate to the Wall family. Expand this node, and then expand the Basic Wall Node. Select the Interior – Gyp 4 7/8" wall type, and drag it into the view.

3. The family appears in the view as a 3' (1000 mm) long plan wall. Change the view's detail level in the view's Properties palette from Coarse to Medium or Fine so you can see the detail in the wall. Remember, you can turn off the thicker lines in the view by clicking the Thin Lines button  in the QAT. With that done, highlight the inserted wall, and look at the Modify | Legend Components settings in the Options Bar (Figure 11.36).

FIGURE 11.36 Select a legend component to access its properties in the Options Bar.

This menu is consistent for any of the family types you insert. It consists of three sections.

Family This drop-down menu allows you to select different family types and operates just like the Type Selector does for other elements in the model.

View The View option lets you change the type of view from Plan to Section.

Host Length This option changes the overall length (or, in the case of sections, height) of the element selected.
4. Let’s make some minor adjustments to the wall. Change View to Section, and change Host Length to 1'-6" (500 mm).
  The wall now looks like a sectional element. By adding some simple text and detail components, you can embellish the wall type to better explain the elements you’re viewing (Figure 11.37).

![5/8" GYPSUM BOARD
3-5/8" METAL STUDS AT 16" O.C.
3" SAFB IN CAVITY](image)

**Figure 11.37** Add other annotations and detail components to embellish the wall-type section.

5. Continue the exercise by adding the Exterior – Brick wall type to the legend along with some additional text notes.

### The Essentials and Beyond

The process of embellishing a model to reflect the design intent and detailing gets easier with practice. Remember that you won’t have all the geometry you need in the 3D model to show the level of detail you’ll need for full documentation. By embellishing the callouts and sections with additional information, you can quickly add the detailed information you need to show.

(Continues)
Additional Exercises

You need to detail the window-head condition for a full set of documents. Using the section you’ve already created, create a detail view of the window head; then, using the same tools and workflow demonstrated in this chapter, add a similar level of detail to the condition. You can reuse a number of the elements — such as keynotes and some of the filled regions — from the previous detail, making this effort a bit quicker. Don’t be afraid to copy and paste filled regions or other elements from one detail to another.

In this chapter, you added a level of detail to the window family by including some CAD details. Replicate the same level of detail in the head condition. You can reuse the information in the sill to expedite the process.
Creating Drawing Sets

While the industry continues to move toward a building information model as a contract deliverable, today we still need to produce 2D documents for most construction and permitting purposes. Using the Autodesk® Revit® Architecture software, you can create these sets with more accuracy and dependability than in the past.

In this chapter, we’ll introduce a scenario that will mimic what might happen on a real project in preliminary design. You’ll be using the c12-Residence.rvt model from the book’s web page (www.sybex.com/go/revit2014essentials) in the Chapter12 folder.

Here’s the story. You have recently completed some design work in advance of your upcoming pricing package for a residential design project. You will need to present the plans, elevations, and perspectives on some sheets for the package. But you want to help the contractor by providing some quantities, so you will also include schedules.

In this chapter, you learn the following skills:

▶ Creating schedules
▶ Placing views on sheets
▶ Printing documents

Creating Schedules

Schedules are lists of elements and element properties in the model. They can be used to itemize building objects such as walls, doors, and windows; calculate quantities, areas, and volumes; and list elements such as the number of sheets, keynotes, and so on. They are yet another way to view building objects in a model. Once created, they are dynamically kept up-to-date with any changes that occur to the model itself.
Chapter 12 • Creating Drawing Sets

Understanding Schedules

In a project workflow, creating schedules of model elements, areas, or other objects is usually one of the most laborious tasks for architects. When this process is performed manually, it can take a very long time and typically results in errors requiring much checking and rechecking of the information. In Revit Architecture, all the elements have information about their properties defined in the model. For example, doors have properties such as size, material, fire rating, and cost. All this information can be scheduled and quantified. As those doors are changed, the properties update in the schedule.

Because Revit Architecture is a bidirectional parametric modeling program, you are also able to make changes to element properties in a schedule — updating the model and all other views automatically. Continuing with the door example, you can change the material of a door in the door schedule, and the material tags and rendering view will be instantly updated.

<table>
<thead>
<tr>
<th>ID</th>
<th>Description</th>
<th>Width</th>
<th>Height</th>
<th>THK</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>Double-Glass 2</td>
<td>6’ - 8”</td>
<td>7’ - 0”</td>
<td>6’ - 2”</td>
<td>Exterior Door</td>
</tr>
<tr>
<td>103</td>
<td>Overhead-Rolling</td>
<td>6’ - 0”</td>
<td>6’ - 6”</td>
<td>6’ - 2”</td>
<td></td>
</tr>
<tr>
<td>104</td>
<td>Single-Flush</td>
<td>2’ - 0”</td>
<td>6’ - 8”</td>
<td>6’ - 2”</td>
<td>Standard</td>
</tr>
<tr>
<td>105</td>
<td>Single-Flush</td>
<td>2’ - 0”</td>
<td>6’ - 8”</td>
<td>6’ - 2”</td>
<td>Standard</td>
</tr>
<tr>
<td>109</td>
<td>Single-Panel 3</td>
<td>2’ - 0”</td>
<td>6’ - 8”</td>
<td>6’ - 2”</td>
<td>Metal panel door</td>
</tr>
<tr>
<td>110</td>
<td>Sliding-Closet</td>
<td>5’ - 6”</td>
<td>6’ - 8”</td>
<td>6’ - 2”</td>
<td></td>
</tr>
<tr>
<td>111</td>
<td>Sliding-Closet</td>
<td>5’ - 6”</td>
<td>6’ - 8”</td>
<td>6’ - 2”</td>
<td></td>
</tr>
<tr>
<td>112</td>
<td>Single-Glass 2</td>
<td>5’ - 0”</td>
<td>6’ - 8”</td>
<td>6’ - 2”</td>
<td></td>
</tr>
</tbody>
</table>

Level 2:

<table>
<thead>
<tr>
<th>ID</th>
<th>Description</th>
<th>Width</th>
<th>Height</th>
<th>THK</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>201</td>
<td>Double-Panel 1</td>
<td>6’ - 0”</td>
<td>7’ - 0”</td>
<td>6’ - 2”</td>
<td></td>
</tr>
<tr>
<td>202</td>
<td>Single-Flush</td>
<td>3’ - 0”</td>
<td>6’ - 8”</td>
<td>6’ - 2”</td>
<td>Standard</td>
</tr>
<tr>
<td>203</td>
<td>Single-Flush</td>
<td>3’ - 0”</td>
<td>6’ - 8”</td>
<td>6’ - 2”</td>
<td>Standard</td>
</tr>
<tr>
<td>204</td>
<td>Single-Glass 2</td>
<td>3’ - 0”</td>
<td>6’ - 8”</td>
<td>6’ - 2”</td>
<td></td>
</tr>
<tr>
<td>205</td>
<td>Single-Glass 2</td>
<td>3’ - 0”</td>
<td>6’ - 8”</td>
<td>6’ - 2”</td>
<td></td>
</tr>
<tr>
<td>206</td>
<td>Single-Glass 2</td>
<td>3’ - 0”</td>
<td>6’ - 8”</td>
<td>6’ - 2”</td>
<td></td>
</tr>
<tr>
<td>207</td>
<td>Sliding-Closet</td>
<td>5’ - 8”</td>
<td>6’ - 8”</td>
<td>6’ - 2”</td>
<td></td>
</tr>
</tbody>
</table>

Grand total

You can access several types of schedules from the Create panel of the View tab. Let’s look at each of the six primary types of schedules.

**Schedule/Quantities**  This is the most commonly used schedule type, allowing you to list and quantify any element category. You can use this type to make door schedules, wall schedules, window schedules, and so on. These schedule
Creating Schedules

types are usually limited to scheduling properties in the same category; however, you can create a multicategory schedule or use some fields from other elements. For example, many model elements can refer to the properties of the room in which they are placed.

**Graphical Column Schedule**  This schedule is different from the other schedule types and is commonly used by structural engineers. Structural columns are displayed according to their grid intersections, indicating top and bottom constraints as well as offsets.

**Material Takeoff**  This type of schedule lists all the materials and subcomponents of any family category. You can use a material takeoff to measure any material that is used in a component or assembly. For example, you might want to know the volume of concrete in the model. Regardless of whether the concrete is in a wall or floor or column, you can tell the schedule to report the total amount of that material in the project. Material takeoffs report material properties across multiple categories.

**Sheet List**  This schedule allows you to create a list of all the sheets in the project.

**Note Block**  This tool creates a unique schedule that lists the properties of a generic annotation symbol used in a project.

**View List**  This schedule shows a list of all the views in the Project Browser and their properties. A view list can be a valuable tool to help you manage your project’s views efficiently.

**Choosing a Schedule Category**

Each of these schedule types has a host of categories that you can mix and match to track elements in the model. You can adjust several aspects of these schedules to build and customize your schedules to meet your needs. Let’s step through these aspects and see how they can be used.

Go to the View tab, then go to the Create panel, then select the Schedules flyout, and select Schedule/Quantities. The New Schedule dialog box appears, allowing you to select a category to schedule (Figure 12.1).
If there aren’t enough categories for you to choose from to create a schedule, there is a venue to add additional options. At the top of the New Schedule dialog box is a Filter List drop-down that gives you the ability to schedule elements from the mechanical, electrical, and plumbing (MEP) and structural categories. This option can be useful when those disciplines are supplying model files to you and you are linking them into your architectural model.

You also have the opportunity to create schedules that span multiple categories. The first option in the Category list in Figure 12.1 is Multi-Category. You might want to schedule all the casework and furnishings in a project simultaneously. Or perhaps you want to schedule all the windows and doors if they are being ordered from the same manufacturer. One of the limits of this schedule type is that you cannot schedule host elements such as walls, floors, and ceilings.

**Customizing Schedules**

With this description in mind, let’s look at the other options when creating a schedule. Choose Walls from the Category list, rename the schedule Door Schedule, and click OK. Doing so opens a new dialog box called Schedule...
Properties. Here you can set the various properties of a schedule that define not only how it looks but also what information it reports.

Five tabs appear across the top: Fields, Filter, Sorting/Grouping, Formatting, and Appearance. Each of these controls different aspects of the schedule. Let’s step through these tabs and see how they affect the look and reporting of the schedule.

**Fields**  The Fields tab lets you select the data that will appear in your schedule. For the wall schedule, it shows all the properties available in the Wall category. The list of available fields on the left will vary based on the category you chose to schedule. If you’ve added any project-based parameters to a category, they will be available here as well. Also notice in the lower-left corner the option Include Elements In Linked Files. Enabling this option allows you to schedule across multiple files; it can be a great tool on larger projects. Choose Family And Type, Type Mark, and Volume, and add them to the Scheduled Fields list on the right by clicking the Add button (Figure 12.2). Note that the order of the items in the Scheduled Fields list from top to bottom will be the order of the columns in your schedule from left to right.

![Schedule Properties](image)

**FIG URE 12.2** The Fields tab
Filter  On the Filter tab (Figure 12.3), you can filter out the data you don’t want to show in your schedule. Filters work like common database functions. For example, you can filter out all the sheets in a set that don’t begin with the letter A. Or you can filter a material list so that it shows only materials containing the word *Concrete*. In Figure 12.3, we have created a filter that will exclude walls that have X in the Type Mark property. Note that to create a filter, you can use only the fields added to the Scheduled Fields list.

![Schedule Properties](image)

**Figure 12.3** The Filter tab

Sorting/Grouping  The Sorting/Grouping tab (Figure 12.4) lets you control the order in which information is displayed and which elements control that order. For instance, if you are creating a sheet index, you can choose to sort by Sheet Number or Sheet Name, depending on how you’d like the information displayed. You can also decide whether you want to show every instance of an item or a roll-up of common items using the Itemize Every Instance check box at the bottom. Set the Sort By value to Family And Type, and select the Itemize Every Instance option. Also select the Grand Totals option, and set the adjacent drop-down menu to Totals Only.
FIGURE 12.4 The Sorting/Grouping tab

Formatting  The Formatting tab (Figure 12.5) controls the display of each field and whether the field is visible on the schedule. You can modify various properties of each field such as alignment, heading, and orientation of the header. You can also modify the format of measurement properties. For example, the default unit of measurement for volume on your project might be cubic feet, but you may want to show the volume of walls in cubic yards rounded to the nearest full unit (no decimals). The Calculate Totals option in the Formatting tab is important. This option must be selected for the grand totals to function at the bottom of the schedule. Pick Volume from the Fields list, and select the Calculate Totals option. Click the Field Format button, and the Format dialog box opens. Deselect the Use Project Settings option, set Units to Cubic Yards, set Rounding to 0 Decimal Places, and select the Use Digit Grouping option.
**Appearance**  The Appearance tab (Figure 12.6) controls the graphical aspects of the schedule, such as font size and style of text for each of the columns and headers in the schedule. It also allows you to turn the schedule grid lines on and off, as well as modify the line thickness for the grid and boundary lines. Many more appearance options are available in the ribbon than are available in this dialog.

![Schedule Properties](image)

**Figure 12.6** The Appearance tab

Once you've established the fields and look of your schedule, click OK to view the working schedule. This layout can be modified at any time, but it gives you a basis from which to begin. To modify the schedule, use the buttons in the Properties palette to access any of these five tabs. You will see the final graphic formatting of the schedule only when it is placed on a sheet. We’ll get to that later in this chapter.

**Using Ribbon Commands in a Schedule**

Schedules have their own special tab on the ribbon that is active when you are viewing the schedule outside of a sheet. The tab (Figure 12.7) allows you to insert, delete, and resize rows; show or hide columns in the schedule; and control the appearance of titles, headers, and body of the schedule. The
Creating Schedules

Commands become available as you click in the schedule header field, column label field, or row of data.

Another key feature of this menu bar is Highlight In Model. This button allows you to select any element in the schedule and locate that element in the model. Let’s say you want to locate a particular wall segment from your wall schedule. Highlight the wall in the schedule, and click the Highlight In Model button; you will be taken to a different view with that wall instance highlighted.

Now that you have an idea of the elements that compose a schedule, let’s return to the demonstration workflow and create a window schedule, a room schedule, and a sheet list.

Making Schedules

Continue using the c12-Residence.rvt model from the book’s website. You’ll notice that several views and sheets are already created. This model is a work in progress — it’s a private residence of 1,230 square feet. The project is a renovation of an 1890s two-story brick house. In the design, all the interior walls have been eliminated and put on a demo phase, which keeps the 19’ (6 m) clear span as open as possible. All new interior walls have been added, and the entire interior has been refreshed in the historic shell. Because the renovation is so substantial, the designer chose to replace all the existing original windows with insulated, wood windows.

Creating a Window Schedule

To assist the window manufacturer with the custom sizes, you need to create a window schedule. To begin, go to the View tab, go to the Create panel, select the Schedule flyout, and click the Schedule/Quantities button. The New Schedule dialog box (shown earlier in Figure 12.1) opens. Here you’ll make a series of selections to create the schedule. Follow these steps:

1. From the Category list, select Window at the bottom. Because this project has multiple phases, you want to make sure the phase is set to New Construction — you don’t need to schedule the windows you’re
removing. Note that a particular phase filter will need to be set in the Properties palette for the schedule. You will get to that after progressing through the Schedule Properties tabs. Click OK to continue.

You'll now step through the five tabs in the Schedule Properties dialog box to format the schedule and choose what you'd like to see. Note that you can freely switch between tabs in this dialog box without clicking OK each time.

2. Switch to the Fields tab, and add the following fields to the Scheduled Fields list (in this order):
   - Type
   - Type Mark
   - Width
   - Height
   - Count

3. Choose the Sorting/Grouping tab. From the Sort By drop-down, choose Type. Uncheck the Itemize Every Instance option.

4. Choose the Formatting tab, and select Count from the Fields list on the left. Change the Alignment setting to Right. Select the Type Mark field, and change Alignment to Center so all the letters will align nicely.

5. To leave the rest of the schedule at the defaults, click OK, and the schedule will display as shown in Figure 12.8. Note that you can also change any of the heading names by simply typing inside the box. Because this example is using the type name to describe the unit size, we have changed the first heading to OPENING SIZE and Type Mark to TYPE.

<table>
<thead>
<tr>
<th>WINDOW SCHEDULE</th>
<th>OPENING SIZE</th>
<th>TYPE</th>
<th>WIDTH</th>
<th>HEIGHT</th>
<th>COUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>12&quot; x 64&quot;</td>
<td>D</td>
<td>1&quot;</td>
<td>5'</td>
<td>2'</td>
<td>1</td>
</tr>
<tr>
<td>10&quot; x 64 3/4&quot;</td>
<td>M</td>
<td>1' 3/4&quot;</td>
<td>5' 1/4&quot;</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>9&quot; x 62&quot;</td>
<td>T</td>
<td>1&quot; 3/4&quot;</td>
<td>10' 1/4&quot;</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>20&quot; x 62 3/4&quot;</td>
<td>C</td>
<td>2&quot; 3/4</td>
<td>10' 1/4&quot;</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>10&quot; x 48&quot;</td>
<td>F</td>
<td>2&quot; 1/4&quot;</td>
<td>10' 1/4&quot;</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>8&quot; x 64 3/4&quot;</td>
<td>T</td>
<td>2&quot; 1/4</td>
<td>10' 1/4&quot;</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>8&quot; x 48 3/4&quot;</td>
<td>C</td>
<td>2&quot; 1/4</td>
<td>10' 1/4&quot;</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>7&quot; x 62&quot;</td>
<td>G</td>
<td>2&quot; 1/4</td>
<td>10' 1/4&quot;</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>6&quot; x 62&quot;</td>
<td>J</td>
<td>2&quot; 1/4</td>
<td>10' 1/4&quot;</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>20&quot; x 12&quot;</td>
<td>D</td>
<td>2&quot; 1/4</td>
<td>10' 1/4&quot;</td>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 12.8** The Window schedule
6. With the window schedule still active, look in the Properties palette for the Phase Filter parameter. Set it to Show New. In step 1, you set the phase to New Construction; however, the phase setting alone does not customize the display of elements in a view. The Show New filter setting excludes model elements that were demolished in a previous phase.

Creating a Room Schedule

Creating other schedule types is fairly simple if you follow the guidelines just covered and step through the tabs in the Schedule Properties dialog box. You have one schedule under your belt, so let’s try another — this time, you’ll create a room schedule. Let’s try a different method for starting a new schedule. In the Project Browser, right-click Schedules/Quantities, select New Schedule/Quantities, and then follow these steps:

1. Choose Rooms from the Category list in the New Schedule dialog box, set the phase to New Construction, and click OK.

2. In the Fields tab, add the following fields from the Scheduled Fields list in this order:
   - Number
   - Name
   - Floor Finish
   - North Wall
   - East Wall
   - South Wall
   - West Wall
   - Area
   - Comments

3. On the Sorting tab, sort by number, and select the Itemize Every Instance option.

4. On the Formatting tab, select the Area field, and set the alignment to Right. Now choose North, East, South, and West Wall by holding down Ctrl when you click. Set the alignment to Center. Click OK to get the schedule you see in Figure 12.9.
Notice that some of the fields already contain data. This is because some of this information was generated automatically (such as room areas), and some of it was added earlier in the process by adding room numbers to the plans or room names. Remember, schedules are just a tabular way of viewing the model — changes to the schedule will alter what you see in the model.

Now you’ll do something slightly different with this schedule. Because four of the columns are dealing with wall finishes, you’ll add a header to those columns so you can group them under one header.

1. Click in the <Room Schedule> field (the brackets denote that this text is reporting the View Name Parameter value). Click Insert ➢ Below Selected from the Row panel in the ribbon. Notice that you now have a row of headers corresponding to the columns below.

2. Hold down the Shift key, and click the four cells that are directly above the C, D, E, and F columns. With the four columns selected (Figure 12.10), click the Merge button in the Titles & Headers panel in the ribbon. This gives you one large cell. Now type Wall Finishes into this cell, and you have a grouped header.

![Figure 12.10 Selecting the wall finishes](image)
3. Hold down Shift key; select the cells above A, B, and C; and then click Merge. Merge the cells above columns H and I. Now your schedule is complete (Figure 12.11).

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>LIVING ROOM</td>
<td>WOOD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>101</td>
<td>DINING ROOM</td>
<td>WOOD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>102</td>
<td>OFFICE</td>
<td>WOOD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>103</td>
<td>1ST BATH</td>
<td>WOOD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>104</td>
<td>KITCHEN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>200</td>
<td>BEDROOM 1</td>
<td>WOOD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>201</td>
<td>BATH 1</td>
<td>WOOD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>202</td>
<td>BEDROOM 2</td>
<td>WOOD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>203</td>
<td>BATH 2</td>
<td>WOOD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>204</td>
<td>HALL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>205</td>
<td>Room</td>
<td>WOOD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>206</td>
<td>Room</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>207</td>
<td>Room</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>208</td>
<td>Room</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>209</td>
<td>Room</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>210</td>
<td>Room</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 12.11** The room schedule

**Creating a Sheet List**

The last kind of schedule type we’ll talk about is a sheet list, which allows you to create a customized list of drawing sheets in your project and place it on a sheet for printing. This can be especially useful on larger projects where the sheet list can get long. This tool is also located on the Create panel of the View tab in the Schedules flyout.

This schedule has a feature that allows you to create placeholders for sheets that are not yet created or will not be part of your discipline's drawings. You can use this feature to create full-sheet schedules including all consultant drawings. It also lets you create placeholder entries in the sheet schedule before you’ve created your own sheets.

In the sample workflow, you have created several sheets, and you now need to add a sheet list to your drawings.

1. Select the Sheet List tool from the Schedules flyout. The Sheet List Properties dialog box appears, starting with the Fields tab. Add the Sheet Number and Sheet Name fields from the list on the left to the column on the right (Figure 12.12).
2. On the Sorting/Grouping tab, choose to sort by Sheet Number, and make sure the Itemize Every Instance check box is selected. Because you’re creating a sheet index for a specific set of sheets, you need to create a filter. In this exercise, the only sheets you need to schedule are the A-series sheets.

3. On the Filter tab, choose to filter by Sheet Number. From the next drop-down, choose Begins With. In the third field, enter the letter A. (Be sure to use an uppercase A, because queries in Revit Architecture filters are case-sensitive.) The filter should look like Figure 12.13. When you’re done, click OK to close the dialog box.
You should have a schedule with only sheet numbers that begin with the letter A. Now you need to populate the rest of the sheet list. At this point, it is critical to understand the two methods you can use to create new sheets in your project.

- Create new sheets by using the View tab in the ribbon or by right-clicking the Sheets heading in the Project Browser.
- Add sheets by adding rows to a sheet list. These become placeholders until you create an actual sheet in your project. If you have placeholders in a sheet list, when you create a new sheet, you can select a placeholder from the New Sheet dialog box.

Although you can use either method with similar efficacy, let’s continue the exercise by first adding placeholders and then creating the respective sheets.

4. With the sheet list still active, click the Insert button in the Rows panel of the ribbon; from the flyout menu, choose Data Row. You should see a row appear with a sheet name defined as Unnamed. Change the name to FLOOR PLANS, and the number to A100.
5. Click the Sheet button on the View tab in the ribbon. In the New Sheet dialog box, choose the 22 × 34 Sheet CD – C1 titleblock, and select A100 – FLOOR PLANS from the list of placeholder sheets (Figure 12.14). Click OK to close the dialog box and create the new sheet.

![Figure 12.14 Adding sheets using a placeholder](image)

You’ll notice in the new sheet that the sheet number and sheet name have been automatically populated based on the information you added to the sheet list as a placeholder. This workflow is useful for larger projects where the index of drawings may be planned in advance and entered into a sheet list. As the design progresses and sheets are created, the design team only needs to pick from the list of placeholders. Also, remember that additional parameters can be added to the sheet list in addition to the number and name.
Placing Views on Sheets

Throughout this book, you have created several different kinds of views, from plans to elevations to perspectives. Eventually, you will need to lay out those views on sheets so they can be printed or converted to PDF and sent to clients or team members for review.

Creating sheets in Revit Architecture is very easy. As you've already seen, they can be created through a sheet list schedule. You can also create sheets by right-clicking the Sheet node in the Project Browser and selecting New Sheet from the context menu. Regardless of which method you use to create them, let’s walk through laying out these views on sheets and see how each view can be further manipulated once it’s placed on a sheet.

Adding Floor Plans to the Sheet

Because a series of views has already been created in the exercise file, let’s use the sheet you just made for placing some views. You place a view on a sheet by dragging the view out of the Project Browser and placing it on the sheet. Let’s practice this with another exercise.

1. Open the A100 – Floor Plans sheet by double-clicking it in the Project Browser.

2. Under the Views heading in the Project Browser, find Floor Plans, and expand the tree to locate the plan named Basement. Holding down the left mouse button, drag the Basement floor plan out of the Project Browser and onto sheet A100. Release the left mouse button, and the outline of the view displays with a view title. This outline represents the extents of the view at the appropriate view scale.

3. Click the sheet once more to complete the placement of the view. Remember, you can adjust the location of the view on the sheet at any time. Figure 12.15 shows the view placed on the sheet.
4. You have space left on the sheet, so let’s add other views. Add Level 1 and Level 2 by dragging and dropping them from the Project Browser onto the sheet.

When you’re placing the second and third views on the sheet, you’re presented with an outline of the plan view with a dashed line in the center of the view. This is an alignment tool; Revit Architecture is assuming you want the plans to align on the sheet, and it is intelligent enough to aid you in this process. You can casually drag the views around on the sheets enough to find the alignment lines and to ensure that all your plans line up (Figure 12.16). Your sheet full of views should look like Figure 12.17.
Once the views are placed on a sheet, you’ll inevitably want to do a bit of cleanup to the drawings to place everything properly. First, the view tag is placed in roughly the same place for each view; however, the default location might not be the location you desire. Revit Architecture also numbers the views sequentially (1, 2, 3, …) in order of placement.

Let's adjust the view tags on the sheets. To adjust the text in the tags, start by selecting the view itself, not the tag.

1. Select the Basement floor plan view placed on the sheet. The view tag highlights in blue. You want to change two things on the tag: the number and the length of the line.

2. Select the number 1, and change it to A1 to reference the ConDoc drawing system — letters vertically along the side of the sheet and numbers across the bottom of the sheet.

3. Using the blue grips on the view tag line, drag the right grip closer to the end of the Basement text. The tag looks like Figure 12.18.
4. Let's move the view tag to a better position. Click off the tag, anywhere on the sheet, to deselect the tag. You can also press the Esc key twice or select the Modify arrow at the upper left. Then, select the tag itself. It highlights blue again but without the grips on the line. Hold the left mouse button, and drag the tag to any location on the sheet (Figure 12.19).

![Figure 12.19](image1.png) Moving the view tag

5. Do the same to the other two views. Renumber Level 1 to A6 and Level 2 to A11 to match their locations on the sheet as shown, shortening the view-tag lines to a more appropriate length (Figure 12.20). Notice that the view tags align with other view tags on the sheet, similar to the way the plans did.
To finish organizing your sheet, let’s add a few lines to divide the views. You can do so easily by using the Detail Line tool, which is on the Annotate tab.

6. On the Annotate tab, choose Detail Line from the Detail panel. Doing so activates the Modify | Place Detail Lines context menu. On the Line Style panel at the far right, choose Wide Lines from the drop-down.

7. You’re ready to start drawing lines, and by default, the straight-line tool is active. You can select one of the nodes on the sheet between views and draw a vertical line between the Basement and Level 1 plans and again between the Level 1 and Level 2 plans (Figure 12.21).
With these dividing lines in place, you may notice that one of the text annotations in the Basement view is a little too close to the dividing line you added to the sheet (Figure 12.22). Let’s adjust it.

To adjust the text object on the floor plan view, you could simply open the view and adjust the text box, but you wouldn’t have the sheet and the dividing line as a reference. Instead, you’re going to use a command called Activate View.

Activating a view is like working in a model-space viewport while in paper space using the Autodesk® AutoCAD® software. You’re working on the actual view, but you’re doing so while it is placed on the sheet. This approach allows you the benefit of seeing how changes to the view affect the layout of the view on the sheet.

1. Right-click the plan view, and choose Activate View from the context menu (Figure 12.23).
2. With the view activated, notice that the other views have become grayed out. Only the elements you can currently edit remain active in the view. Select the text box you’ve identified, and drag the right grip inward so the text wraps, as shown in Figure 12.24.

![Figure 12.24 Modifying the text box](image)

3. To complete your edits, you need to deactivate the view. Right-click, and choose Deactivate View from the context menu.

Adding the Schedules

With your sheet of floor plans configured and ready to print, you can quickly finish the sheet set by adding the window schedule you created earlier. Adding a schedule is just like adding any other view — you drag and drop it from the Project Browser onto the sheet.

1. Open the sheet named G000 – COVER SHEET by double-clicking it in the Project Browser.

2. Grab the window schedule from the Project Browser, and drag and drop it onto an open area on the sheet.

3. Repeat this process for the room schedule and the sheet list.

Once the schedules are on the sheet, they may need a bit of adjustment. You can redefine the column spacing and even split larger schedules directly on the sheet to make them easier to read. Such adjustments do not change the actual schedule — just its appearance on the sheet.

To adjust a schedule placed on a sheet, highlight the schedule by selecting it. The schedule turns blue, and a few new grips appear that you can use to make changes (Figure 12.25). The blue inverted triangles at the top of each column allow you to modify the column widths. Grab one, and drag it left or right to change the column sizing.
You'll notice a blue cut symbol to the far right of a selected schedule. This cut symbol lets you break the schedule into two parts that can be placed on the same sheet. This can be especially handy if you have a long schedule, such as a room or door schedule, that has too many rows to fit on your sheet vertically. Selecting this tool breaks the schedule in half (and you can break it in half again and again) so you can take advantage of the horizontal real estate on your sheet. If you choose to separate your schedule in this fashion, it retains all the necessary information, and all the portions continue to automatically fill themselves dynamically as a single schedule would. You can also change the overall height of the schedule once it is broken by grabbing the grips at the bottom of the schedule and dragging them up or down.

With your schedule on the sheet and the columns properly formatted, you can drag the schedule around on the sheet until it’s located where you’d like to have it. To do so, click the schedule and hold down the left mouse button. As you move the schedule on the sheet, it behaves like other views: it aligns with the other schedules on the sheet and displays a light blue dashed line to help with alignment. Your finished sheet should look like Figure 12.26.
Printing Documents

You will eventually need to get the sheets out of Revit Architecture and into a printed format. If you've been working in the Windows environment, you'll find that printing from Revit Architecture is straightforward because the process resembles that used in other Windows-based applications.

Exploring the Print Dialog Box

To begin printing, you do not need to be in any particular view or sheet. Select the Application menu and then select Print ➤ Print to open the dialog box shown in Figure 12.27. All the features for printing are found here. Let's step through this dialog box and explore each element.
The drop-down menu at the top of the Print dialog box allows you to select the printer or plotter to which you want to print. This can be a physical printer or a virtual one (such as Adobe Acrobat Distiller). You can add printers to this list using your Windows Printer control panel.

Most of the controls you need to use can be found at the bottom of this dialog box in the Settings section on the right and the Print Range section on the left.

**Exploring the Print Settings**

In the Print dialog box, click the Setup button under Settings to open the Print Setup dialog box (Figure 12.28). Here you can customize the print settings including paper size, zoom, and orientation. You can save these settings with a name so that you can reuse them in later work sessions. We recommend creating saved setups based on a printer type — not for one specific printer. For example, if your office has several plotters of the same make and model, it is sufficient to create one setup named Full Size B/W Plot.
The print settings can also be transferred to other project files if necessary, using the Transfer Project Standards tool located on the Manage tab in the ribbon. Let’s take a look at some of the important printing options available to you.

**Hidden Line Views**

Views in Revit Architecture can be displayed in several graphic modes: Wireframe, Hidden Line, Shaded, Consistent Colors, and Realistic. The most commonly used type is Hidden Line. You’ll choose this mode for most floor plans, sections, and elevations, and sometimes even for 3D.

You have the option to print this type of view with vector processing or raster processing of the hidden lines. Vector is faster; however, you need to be aware of some nuances when working with hidden-line views. For example, transparent materials (such as glass) print transparent with raster processing but opaque with vector processing.
Zoom

If you’re looking for the ability to print a view to a specific scale (the way you would in the Autodesk AutoCAD software), it’s actually much simpler in Revit Architecture. Remember that every view is assigned a scale factor; therefore, printing a view is always determined as a percentage of that assigned scale. For example, if a floor plan is assigned a scale factor of 1/4”=1'-0" (1:50) and you would like to generate a quick print of the plan at 1/8”=1'-0" (1:100), simply set the zoom to 50 percent. Sheets should be printed at 100 percent for full-size or 50 percent for a half-size set.

Options

The Options pane is at the bottom of the Print Setup dialog box. The pane includes these options:

**View Links In Blue**  View links are hyperlinked tags that lead you from one view to another. They appear blue in the views and print black by default, but you can specify that they should be printed in blue, mimicking their on-screen appearance. This option is useful when you are creating an electronic print in a format such as DWFx or PDF.

**Hide Ref/Work Planes, Hide Scope Boxes, and Hide Crop Boundaries**  These three check boxes let you decide whether to print various elements that are usually used only while working in the software.

**Hide Unreferenced View Tags**  During the course of a project, for working purposes, you may create a lot of elevation tags, section flags, or detail callouts that you don’t want to be printed in the final documents. If the corresponding views are not placed on any sheets, these view tags are referred to as unreferenced, and you have the option not to print them.

**Replace Halftone With Thin Lines**  If you experience trouble with printing line-work that is configured as halftone (gray shade), you can select this option to temporarily convert any halftone lines to solid black thin lines.

When all your options are set, you can save the settings so you can reuse them on future prints. Because everyone’s system printer configurations will be somewhat different, we won’t ask you to create a specific setting configuration. Instead, use the information we just reviewed to create your own printer setup configuration. Note that you can change settings temporarily by selecting the <in-session> setting from the Name drop-down. Then, click OK to close this dialog and return to the Print dialog.
Exploring the Print Range

The other important part of the Print dialog box is Print Range. In this section, you can define exactly what areas, sheets, or views you want to print. It includes these options:

**Current Window**  This option prints the full extent of the open view, regardless of what extents of that view are currently visible on your screen.

**Visible Portion Of Current Window**  This option prints only what you see in the frame of the open window framed for the sheet size you’ve selected.

**Selected Views/Sheets**  This option allows you to define a reusable list of views, sheets, or any combinations of views and sheets. This way, you can essentially batch-print a job by sending large quantities of sheets to the printer in one shot and save these selections for future print jobs.

You can pick any view or sheet to include in the view/sheet set. If you want to include only sheets in a set, use the Show options at the bottom of the View/Sheet Set dialog box to shorten the visible list. Doing so allows you to select only sheets or only views if you choose.

This is a great tool to help define print lists. Some examples of using these selections would be a 100 percent construction document package or a specific set of presentation sheets.

In the exercise, suppose you want to print the A-series sheets and the G000 cover sheet. Follow these steps:

1. In the Print dialog box, choose the Selected Views/Sheets option, and click the Select button.
2. In the resulting View/Sheet Set dialog box, deselect the Views check box at the bottom. Revit Architecture displays only the sheets you’ve created to date.
3. From the list, select the A-series sheets and the G000 cover sheet (Figure 12.29).
4. Because you will more than likely want to print this set again, click the Save As button and name the set Presentation Set 1. Doing so will keep your current collection of sheets together, and if you want to reprint this set, you can grab the set name from the Name drop-down menu in the View/Sheet Set dialog box. Remember, if you add more drawings to the set, by default they won’t be added to this print set. You’ll need to revisit this dialog box, add the sheets, and click the Save button. For now, click OK to close this dialog box.

5. Clicking OK in the Print dialog box prints the selected drawings to the printer listed at the top. Clicking Close saves your print setup and closes the dialog box without printing.
In this chapter, you learned how to quantify the elements in the model by using schedules. You used the same Schedule tool to create a standard window schedule, a room schedule, and a sheet list. You also learned how to place views onto sheets and print them.

**Additional Exercises**

- Create a door schedule, and add the following fields:
  - Mark
  - Type
  - Width
  - Height
  - Thickness
  - Material
  - Finish
  - Comments

- Lay out this new schedule on sheet G000; be sure to align it with the schedules you already placed on that sheet. Change the schedule’s Sorting/Grouping options by including the Count field and toggling the Itemize Every Instance setting. Observe the differences in scheduling every door compared to a rolled-up schedule showing only individual door types and how many of each exist in the project.
CHAPTER 13

Workflow and Site Modeling

Understanding the Autodesk® Revit® Architecture software and how to use it is not a difficult challenge. The real challenge is determining how using Revit Architecture and building information modeling (BIM) will change your organization’s culture and your project’s workflow, especially if you’re coming from a CAD-based environment. Revit Architecture can be more than just a different way to draw a line. In this chapter, we’ll focus on what those changes are and provide some tools to help you manage the transition.

In this chapter, you learn the following skills:

▶ Understanding a BIM workflow
▶ Modeling a site
▶ Performing quality control on your Revit Architecture model

Understanding a BIM Workflow

Regardless of the workflow you have established, moving to Revit Architecture is going to be a change. You’ll need tools to help transition from your current workflow to one using Revit Architecture. To begin, we’ll cover some of the core differences between a CAD-based system and a BIM-based one.

Moving to BIM is a shift in how designers and contractors look at the design and documentation process throughout the entire life cycle of the project, from concept to occupancy. In a traditional CAD-based workflow, represented in Figure 13.1, each view is drawn separately with no inherent relationship between drawings. In this type of production environment, the team creates plans, sections, elevations, schedules, and perspectives and must coordinate any changes between files manually.

In a BIM-based workflow, the team creates a 3D, parametric model and uses this model to automatically generate the drawings necessary for
documentation. Plans, sections, elevations, schedules, and perspectives are all by-products of creating an embellished BIM model, as shown in Figure 13.2. This enhanced documentation methodology not only allows for a highly coordinated drawing set but also provides the basic model geometry necessary for analysis such as daylighting studies, energy, material takeoffs, and so on.

**Figure 13.1** A CAD-based workflow

**Figure 13.2** A BIM workflow
Using Revit Architecture becomes more than a change in software; it becomes a change in workflow and methodology. As various design specializations interact and create the building model (Figure 13.3), you can see how structure, mechanical, energy, daylight, and other factors inform design direction. You can also draw relationships between some of these elements that might not have been as obvious in a more traditional approach. Although some of these specialties (such as structure and mechanical) are historically separate systems, by integrating them into a single design model, you can see how they interact in relation to other systems within a building.
Analysis such as daylighting can inform your building orientation and structure. Depending on your glazing, it can also affect your mechanical requirements (as solar gain). You can see some of these effects through a computational fluid dynamics (CFD) model (used to calculate airflow). Geographic information system (GIS) data will give you your relative location globally and allow you to see how much sunlight you will be receiving or what the local temperature swings will be during the course of a day. As you can see, all of these variables can easily affect building design.

**Staffing a BIM Project**

As you rethink the process of design and documentation, one of the semantic changes you will need to address is staffing. A common misconception of project management when teams are first moving from CAD to BIM is that staffing the project will be the same in both workflows. This couldn’t be further from the truth. When the workflow changes, staffing allocations, time to complete tasks, and percentage of work by phase are all affected as a by-product of the change of method.

In a CAD-based project, the level of effort during each of the phases is fairly well known. The industry has been using some metrics over the past several years that should be fairly familiar. There is modest effort and staffing in the conceptual design and schematic design phases, and this effort builds until it crescendos during construction documentation. At this phase, a CAD project can greatly increase the number of staff in an effort to expedite the completion of the drawing set. This staff increase can be effective because the CAD drawings are typically separate files, and moving lines in one drawing won’t dynamically change another.

In a BIM-based framework, there is still a gradual increase of staffing and effort through conceptual design and into the schematic phase, but the effort during schematic design is greater using BIM than in CAD. During schematic design and design development, the project team is still performing all the same tasks that occur in any design process: testing design concepts, visualizations, or design iteration. The increase in effort during the early design phases lets the team use the parametric nature of the model to significantly reduce the effort later during construction documents, allowing for a decrease in the overall effort over the project cycle.

**Project Roles Using Revit Architecture**

With such a significant change in the effort behind a BIM-based project flow, it’s also important to understand how this can change the various roles and
responsibilities for the project team. The changes in traditional roles can become a barrier to many projects successfully adopting BIM. Project managers need to be able to predict staffing and time to complete tasks throughout the project phases and have relied on the past precedent of staff and project types to do this. Because a BIM-based project can significantly alter the project workflow, many of the historic timetables for task completion are no longer valid. However, a BIM-based project can be broken down into a few primary roles that will allow you some level of predictability through the various project phases. Although the specific effort and staffing will vary between offices (and even projects), some general roles will need to be accounted for on every project.

There are three primary roles on every BIM project.

**Architect**  Deals with design issues, code compliances, clear widths, wall types, and so on

**Modeler**  Creates content in 2D or in 3D

**Drafter**  Deals with annotations, sheet layout, view creation, and detail creation

These roles represent efforts and general tasks that you need to take into account on any Revit Architecture project. On a large project, these roles could also represent individual people, whereas on a smaller project they might be all the same person, or one person might carry multiple roles. We’ll now cover each of these in a bit more detail and discuss how these roles interact with the project cycle.

**Architect**

The role of the architect is to deal with the architectural issues revolving around the project. As the model is being created, you will naturally have to solve issues such as constructability and wall types, set corridor widths, deal with department areas, and deal with other issues involving either codes or the overall architectural design. This role will be the one applying standards to the project (as in wall types, keynotes, and so on) and organizing the document set. This role will need to be present on the project from the beginning to ensure consistency of the virtual building creation and isn’t necessarily limited to only one person.

This role also might or might not be a “designer.” Although it is possible to do early design in Revit Architecture, many project teams prefer to utilize other tools such as Trimble SketchUp or even pencil and trace paper. The job of the
architect is steering the creation of the building in Revit Architecture. Tasks for this role include the following:

- Leading the creation of massing (if used) and major architectural elements and then building from within the model
- Designing around code requirements and other building logistics
- Ensuring constructability and detailing aspects of the design

Modeler

The role of the modeler is to create all the 2D and especially the 3D content needed in the project. This content includes all the parametric families for elements such as windows, doors, casework, wall types, stairs, railings, and furnishings. Typically, this role is the responsibility of less experienced staff, who might not be able to fulfill the role of architect. These less experienced positions tend to have longer periods of undisturbed time, making them better suited to deal with some of the longer, more involved tasks in modeling content. Finally, they also tend to have some 3D experience coming out of school. They might not have worked with Revit Architecture directly but possibly with Autodesk 3ds Max or Trimble SketchUp and are thereby familiar with working in a 3D environment. Tasks for this role include the following:

- Exchanging any generic elements used during early design stages for more specific building elements
- Creating and adding new family components and modifying existing components in the project
- Regularly reviewing and eliminating project warnings

Drafter

The role of the drafter is to create sheets and views and embellish those views with annotations or other 2D content. This role will be doing the bulk of the work needed to document the project. In earlier stages of the project, this role is typically assumed by either the architect or the modeler, but as documentation gets moving into high gear, it can quickly become the role of multiple people on a larger project. Tasks for this role include the following:

- Keynoting
- Dimensioning
- Setting up sheets and views
- Creating schedules
During schematic design, you'll need to include the role of the drafter to begin laying out sheets and creating views. These sheets and views don't have to be for a construction document set yet, but you'll have to establish views for any schematic design submittals. If these views are set up properly, they can be reused later for design development and construction-document submittals as the model continues to gain a greater level of detail.
What you’d like to avoid for your project staffing, if possible, is adding staff during the construction-document phase. In a BIM/Revit Architecture workflow, this can sometimes cause more problems than it solves and slow down the team rather than get work done faster.

**Adding Team Members to Fight Fires**

In many projects, there comes a time when the schedule gets tight and project management wants to add more staff to a project to meet a specific deadline. In a 2D CAD environment, new team members would be added to help meet a deadline and would have the burden of trying to learn the architecture of the building, the thoughts behind its design, and how its various systems interact. In a Revit Architecture project, they have that same obligation, but they have the additional task of learning how the model goes together. The model will have constraints set against various elements (such as locking a corridor width) as well as various digital construction issues (such as how floors and walls might be tied together, what the various family names are, or workset organization). This ramping-up period consumes additional time.

Regardless of planning, deadlines escape the best of architects and project managers. It’s a good idea to know when and how you can staff to make sure you meet deadlines. Keep in mind that any team members new to the project have to learn about both the design and the model they have been thrown into, follow these suggestions so new staff can help production, and don’t accidentally break anything along the way:

*Create content, content, content.* You will find that you are making model families or detail components until the end of the project. This process will help get the newbie engaged in a specific part of the project and also isolate them until they learn more about how the model has gone together.

*Put them into a drafting role.* Even if this isn’t their ultimate role on the project, having staff new to the design help create views and lay out sheets will get them familiar with the architecture while still allowing the team to progress on the document set.

*Start them to work on detailing.* Every project can always use someone who knows how to put a building together. If you have someone new to the project and possibly even new to Revit Architecture, let them embellish some of the views already created and laid out on sheets. These views can be layered with 2D components, linework, and annotations.
Modeling a Site

In the previous sections of this chapter, you learned about the fundamental roles and workflow for your project team. Now let’s talk about some other less frequently used tools. Another set of tools you should become familiar with are the site tools. They allow you to create a context in which your building models can be situated. For example, a toposurface will create a hatched area when you view your building in a section, and it will function as a hosting surface for site components such as trees, shrubs, parking spaces, accessories, and vehicles (Figure 13.5).

The site tools in Revit Architecture are intended only to be used for the creation of basic elements, including topography, property lines, and building pads. Although editing utilities are available to manipulate the site elements, these tools are not meant to be used for civil engineering like the functionality found in Autodesk® AutoCAD® Civil 3D®.

In the following sections, you’ll learn about the different ways to create and modify a toposurface and how to model a building pad in a toposurface.
Using a Toposurface

As its name suggests, a toposurface is a surface-based representation of the topography context supporting a project. It is not modeled as a solid in Revit Architecture; however, a toposurface will appear as if it were a solid in any section cut view, as in the 3D view with a section box enabled shown in Figure 13.6.

You can create a toposurface in three ways: by placing points at specific elevations, by using a linked CAD file with lines or points at varying elevations, or by using a points file generated by a civil-engineering application. You'll create a site from an imported CAD file in the following exercise.

A common workflow you may encounter, when creating the topography context, involves the use of CAD data generated by a civil engineer. In this case, the engineer must create a file with 3D data. Blocks, circles, and contour polylines
must exist in the CAD file at the appropriate elevation to be used in the process of generating a toposurface in Revit Architecture.

In the following exercise, you will download a sample DWG file with contour polylines. You must link the file into your Revit Architecture project before creating the toposurface. Here are the steps:

1. Create a new Revit Architecture project using the default.rte or DefaultMetric.rte template.
2. Download the file c13-Site-Link.dwg from this book's web page.
3. Activate the floor plan named Site in the Project Browser.
4. Go to the Insert tab in the ribbon, and click the Link CAD button. Select the c13-Site-Link.dwg file, and set the following options:
   - Current View Only: Unchecked
   - Import Units: Auto-Detect
   - Positioning: Auto – Center To Center
   - Place At: Level 1
5. Click Open to close the dialog box and complete the insertion of the CAD link. Open a default 3D view to examine the results (Figure 13.7).

**FIGURE 13.7** Linked CAD file as seen in a 3D view
6. On the Massing And Site tab in the ribbon, click the Toposurface button. In the Tools panel on the Modify | Edit Surface tab, select Create From Import and then select Import Instance.

7. Click the linked CAD file, and the Add Points From Selected Layers dialog box appears (Figure 13.8). Click the Check None button, and then select the layers C-TOPO-MAJR and C-TOPO-MINR.

8. Click OK to close the dialog. Revit Architecture may take a few seconds to generate the points based on the contour polylines in the linked file, but they will appear as black squares when they have all been placed.

9. If you want to use fewer points to define the toposurface, click the Simplify Surface button in the contextual ribbon, and enter a larger value such as 1'-0" (250 mm).

10. Click the Finish Surface button in the contextual ribbon to complete the toposurface. Change the visual style of the view to Consistent Colors to examine your results.

Creating a Building Pad

A building pad in Revit Architecture is a unique model element that resembles a floor. It can have a thickness and compound structure, it is associated with a level, and it can be sloped using slope arrows while you’re sketching its boundary. The building pad is different from a floor because it will automatically
cut through a toposurface, defining the outline for your building’s cellar or basement.

The process to create a building pad is virtually identical to that of creating a floor. Let’s run through a quick exercise to create a building pad in a sample project:

1. Open the file c13-Site-Pad.rvt, which you can download from this book’s web page.

2. Activate the floor plan named Site in the Project Browser. You see an existing topographic surface and a property line. Notice that reference planes were created to demarcate the required zoning setbacks from the property line. Foundation walls have been created in these reference planes.

   Note that you don’t have to create a property line and walls before creating a building pad. You might create a building pad before any other building elements. Just realize that you can use the Pick Walls mode to associate the boundary of the building pad with the foundation walls.

3. Activate the Cellar floor plan from the Project Browser.

4. Go to the Massing & Site tab in the ribbon, and click the Building Pad button. In the Properties palette, change the Height Offset From Level value to 0.

5. Switch to Pick Walls mode in the Draw panel of the contextual ribbon, and then click the inside edges of the four foundation walls. You can use the Tab+select method to place all four lines at once.

6. Click the Finish Edit Mode button in the contextual ribbon to complete the sketch, and then double-click the section head in the plan view to examine your results. Notice that the top of the building pad is at the Cellar level and the poche of the topographic surface has been removed in the space of the cellar (Figure 13.9).

![Figure 13.9](image)

**Figure 13.9** This section view illustrates how the building pad adjusts the extents of the topographic surface.
Performing Quality Control on Your Model

You can take several measures to ensure that your model is a smooth-running and efficient machine. From time to time, ideally after major project milestones, someone on the project team should oversee the following steps to manage your model’s file size and number of warnings.

Keeping an Eye on File Size

Watch the size of your file. It’s a good metric for general file stability. A typical Revit Architecture file size for a project in construction documents will be between 100 MB and 250 MB (250 MB is on the high side of file sizes). Beyond that, you will find that the model will be slow to open and hard to rotate in 3D views; and other views, such as building elevations and overall plans, will also be slow to open.
Should your file become large or unwieldy, you have several ways to trim the file down and get the model lean and responsive again.

**Purging Unused Families and Groups**

On the Manage tab is a command called Purge Unused. This command removes all the unused families and groups from your model by deleting them. Many times in a design process you will change window types or wall types or swap one set of families for another. Even if those elements are not being used in the project, they are being stored in the file, and therefore when the file is opened, they are being loaded into memory. Depending on the stage of your project, you should periodically delete these elements from the model to keep your file size down. Don’t worry—if you find you need a family you’ve removed, you can always reload it.

Select the Manage tab, and choose Purge Unused on the Settings panel. Depending on the size of your model and how many families you have loaded, it might take Revit Architecture a few minutes to complete this command.

After Revit Architecture is done thinking, it will provide you with a list of all the families and groups in the file that are not actively in a view (Figure 13.10). At this point, you have the option to select the elements you want to delete or to keep and remove the rest.

![The Purge Unused dialog box](image-url)
We don’t recommend you use this command in the early stages of design, mainly because your file size won’t be that large early on and purging at this stage would eliminate any preloaded families that you might have included in your template. During schematic design and design development, you are typically going through design iteration and will likely be adding and removing content regularly. It can become a hassle to have to constantly load or reload families into the model. If your model is not suffering from performance issues or the file size isn’t unruly, it’s not necessary to perform a Purge Unused command.

Managing Links and Images

Another way to manage your project’s file size is to remove all unused linked files and raster images from your model. If you’ve linked CAD files from your civil engineer or other consultants and no longer need them as a reference in your model, removing them will also unload that stored data from your model. In addition, if you’ve imported raster images into your project, deleting them can significantly reduce your file size. It is good practice to periodically remove these types of files from your model, especially after major deadlines, if they are not actively being used in your project.

To access these options, find the Manage Project panel on the Manage tab. Notice the Manage Links and Manage Images tools. These two commands allow you to remove any linked CAD files, Revit files, or DWF files, as well as any raster images, not required for your project. Click Manage Links to remove any unwanted files, browse to the appropriate tab, select the file to delete, and click Remove. Manage Images works similarly; click Manage Images, highlight the image you want to remove, and click Delete.

Cutting Down on the Number of Views

The ability to quickly create views in a model is one of the fast and easy benefits of using Revit Architecture. This ability can also be a detriment, though, if it is not managed. Beyond the hassle of having to sort through many views to find the one you need, having too many views in Revit Architecture can also impact your performance and file size.

Obviously, a number of views are needed in the model to create the construction documentation. In addition, you will find yourself creating views to study the design, deal with model creation, or view the building or project from a new angle. These types of working views will never make it to the sheet set, and some will be used only for brief periods.
How Many Working Views Is Too Many?

How many working views is too many to have in your model? The obvious answer is that when performance begins to suffer, you need to start looking at ways to make the model lean and speed up response times. We had a project team new to Revit Architecture, and they were complaining about the file being slow to open and manipulate. When we reviewed their model, the file size was around 800 MB! We were surprised that they were able to do any work at all.

One of the first things we did to get the file size down was look at all the views that were not on sheets. More than 1,200 views were not being used. Deleting those views, paired with a File ➣ Save (with the Compress check box selected), reduced the file size to 500 MB. Although the result was still high, you can see the impact that keeping too many views has on file size.

Dealing with Warnings

An important way to troubleshoot your model is to use the Review Warnings tool. This tool will do very little to affect your overall file size, but it will alert you to problems in the model. Warnings should regularly be addressed to ensure file stability. To open the Review Warnings dialog box, shown in Figure 13.11, click the Warnings button on the Inquiry panel of the Manage tab. The dialog box lists all warnings still active in your project file.

![Figure 13.11 The Warnings dialog box](image-url)
Errors and warnings are all essentially types of issues Revit Architecture has when it tries to resolve geometry, conflicts, or formulas that do not equate. Things that appear in this dialog box include instances of multiple elements sitting directly on top of each other, thereby creating inaccurate schedule counts; wall joints that do not properly clean themselves up; wall and room separation lines overlapping; stairs that have the wrong number of risers between floors; and so on. This dialog box shows you all the times the yellow warning box appeared in the bottom-right corner of the screen and you ignored it. Errors that go unchecked can compound to create other errors and can also lead to inaccurate reporting in schedules or even file corruption. Check the Warnings dialog box regularly as part of your periodic file maintenance, and try to keep the number of instances to a minimum.

Notice that the Warnings dialog box has an Export feature. Use this feature to export your error list to an HTML file so you can read it at your leisure outside the model environment (Figure 13.12). You can also pull this list into a Microsoft Word or Excel document so you can distribute the errors across the team to be resolved.

![PhillipsPlace Error Report](image)

**PhillipsPlace Error Report (12/18/2012 10:29:11 PM)**

In the example shown in Figure 13.12, using the Phillips Place model, the file has 118 errors and warnings. How many errors in a file are too many? Much of that depends on your model, your computer’s capabilities, the error types, and your deliverable. For instance, if you are delivering a BIM model to your client...
or to the contractor, you might have a zero-error requirement. In that case, no errors are acceptable. If you are still actively in the design phase of the project, however, you will always have some errors—it is an inescapable part of the iteration process. As you refine the drawings, errors will be resolved; and as you add new content to the model that is in need of resolution, new errors will be created. If you are not worried about a model deliverable, you can get away with having fewer than 1,000 errors in the project without too much trouble. That said, the cleaner the model, the smoother it will run.

The Essentials and Beyond

This chapter focused on understanding some essential but atypical things about Revit Architecture and a BIM workflow. We discussed how you can best transition from a 2D CAD environment to a Revit Architecture BIM workflow and how to incorporate some of the lesser-used (but just as important) tools such as site work and building pads. We also discussed how to manage the Revit Architecture file itself. Good file management will help to ensure that your Revit Architecture projects are quick and responsive. Using Revit Architecture means understanding BIM as a workflow and process at all levels in your office and at all phases on your project. Being prepared for a process change as well as a software change will help you become successful as you move into BIM.

Additional Exercises

▶ Diagram your project or office’s historical workflow using CAD or hand drafting. Consider the hours used in each phase of the project and the number of staff members needed to complete a given phase. Track your first Revit Architecture project so you can compare the two.

▶ Revit Architecture is a great tool, but it is also one of many that you will use in your projects. Discuss with your design teams how they would like to transition from design tools (such as Trimble SketchUp and trace paper) to Revit Architecture.
This chapter provides an overview of different methods for repeating objects in the Autodesk® Revit® Architecture software. In addition, we will discuss tips, optimizations, and best practices to help keep your project files running smoothly.

In this chapter, you learn the following skills:

- Repeating objects
- Optimizing performance
- Utilizing best practices
- Using quick tips and shortcuts
- Finding additional resources

**Repeating Objects**

Revit Architecture offers several approaches to repeat geometry throughout your project. Some are better suited for specific conditions depending on your project, so we’ll discuss an overview for each, along with key takeaways.
Component Families  As outlined in Chapters 5 and 6, component families are best described as anything manufactured away from the job site and used throughout your project files. Component families are the core type of repeating object you will utilize. They can be constructed to be parametric by containing multiple types of the same family; think of one door with ten types to represent variations in standard sizes. Component families can also be used with (and are a critical aspect of) groups, links, and assemblies.

The following are the key takeaways:

▶ Component families can contain types. Instead of creating separate door families, you can create one, and you can create multiple types within the family. Each type can be configured with parameters to flex the geometry to match specific sizes or visibility requirements.

▶ Component families can be saved outside the project as stand-alone RFA files and loaded back in or into other projects. This allows for the creation of shared libraries so the entire office or multiple offices can utilize the same components.

▶ Component families can be 2D or 3D. If a component family simply needs to be quantified or scheduled but isn’t visible outside plan orientation views, it could initially be created as 2D geometry. Later if the project needs change, the family can always be modified.

Groups  Groups are collections of project objects such as system families, component families, or detail items. Model groups are collections of 3D geometries, whereas detail groups are strictly 2D. Groups are easily created by selecting the objects you want to include in the group and choosing Create Group on the ribbon. Creating a group will generate a single element that contains a collection of objects (which also makes it easy to move everything together). A good use case for groups is a condominium or apartment project. For typical units or apartments that will appear more than once in the project, you can select the objects and create a group. This group can then be copied or inserted at multiple project locations. Edit one group type, and all instances will update to match.

The following are the key takeaways:

▶ A group instance can automatically be converted to a link at any time by selecting the group and choosing Link on the contextual ribbon panel.
Groups can be saved out of a project as stand-alone project files (right-click the group type in the Project Browser and choose Save Group).

Group members can be excluded from a group instance. This is extremely powerful for groups that may have one or two variations (but otherwise are identical). Instead of creating a new group type, Tab+select the group member you want to exclude from the group instance, and click the Exclude symbol. Should you need the member back, Tab+select the group again, and click the Restore Excluded Group Member symbol.

A wall in the project can still join with a wall inside a group.

**Assemblies**  Assemblies are similar in many aspects to groups but with some unique tools directed toward construction workflows. Assemblies are collections of project objects similar to groups, organized in the Project Browser, along with any associated assembly views. To create an assembly, select the objects you want to include, and choose Create Assembly on the ribbon.

The following are the key takeaways:

- Revit automatically detects whether changes to an assembly make it unique and, if so, creates a new assembly type.
- Assemblies have an exclusive tool called Assembly Views. These views are organized in the Project Browser (under the assembly) and create isolated views of the specific assembly type only. To create assembly views, select an assembly, and click Create Views on the ribbon.
- Assemblies do not allow as many object categories to be added as groups do. There are restrictions on some object categories (cannot be added to the assembly) such as other assembled objects, annotation/detail items, groups, imports, links, model lines, masses, rooms, images, curtain systems, stacked walls, or curtain walls.

**Revit Links**  Revit project files can be linked into one another. This is useful not only to divide large projects or campus buildings but can also be used to repeat geometry. For example, your project may have identical wings or buildings on campus. The Revit project can be linked in and even allows for copies of the link to be created (all instances will update if reloaded). Links also have projectwide
controls under Manage Links. Here you can reload, unload, or entirely remove the link from the host project.

The following are the key takeaways:

▶ A link can be bound into the project (which will place all geometry into a new group). Simply select the link instance and choose Bind Link on the ribbon.

▶ A link can be copied, mirrored, rotated, or further modified. There can also be multiple instances of the same link.

▶ Under Visibility/Graphic Overrides, there is a Revit Links tab. Changing the display settings between By Host View and By Linked View allows the link to follow the settings of the host view or use the appearance settings of the link view.

▶ A wall in the host project cannot join with a wall in the link.

Optimizing Performance

It should make sense that a smaller file on a good network will run the fastest. Revit Architecture files can range anywhere from 5 MB to more than 500 MB. Much of that variation depends on the level of detail in the model itself, the presence of imported geometry (2D CAD files, SketchUp, and so on), the number of views, and the overall complexity of the model geometry. Obviously, your hardware configuration will also be a factor in determining the performance of your models.

You can optimize your hardware in a number of ways to get the most out of your configuration. You should first look at the minimum hardware specifications for a computer running Revit Architecture. Autodesk has published those requirements on its website, and they are updated with each new release of the application. You can find the current specs at www.autodesk.com/revit; choose Features and then System Requirements under the Autodesk Revit Products heading. Beyond the default specifications, you can do a number of things to help keep your files nimble. Here are some additional recommendations:

You want to use a 64-bit operating system. Revit Architecture needs a lot of RAM, and the more physical RAM it can use, the more data you can cache into active memory; 64-bit Windows 7 or Windows 8 is recommended for Revit Architecture 2014.
Figure out how much RAM your project will need. Before emailing your IT department requesting 24 GB of RAM, figure out how much you’re actually going to use on your project. Even for an average small 100 MB project, 4 GB of RAM is the bare minimum. The OS and other applications such as Microsoft Outlook will use some of your RAM, but you can calculate how much RAM Revit Architecture will need to work effectively. The formula is as follows:

Model Size in Explorer $\times$ 20 + Linked File Sizes $\times$ 20 = Active RAM Needed

Let’s look at a couple of examples to demonstrate how this works. You have a project file with no linked files, and the file size on your server is 150 MB. So, $150 \times 20 = 3,000$ MB, or 3 GB of RAM to operate effectively.

In another example, you have a 120 MB file, a 50 MB structural model linked in, and four CAD files at 1 MB each.

$$(120 \times 20) + (50 \times 20) + (4 \times 20) = 3,480$ MB, or 3.5 GB of RAM

The one area where it can be difficult to predict, since each project file varies, is when upgrading a project. Upgrading a project is usually the most memory-intensive operation in Revit. Since it is a one-time operation (for each release), you can dedicate one workstation for this task. Specify one workstation with additional memory for upgrading, if you find it necessary.

Once you’ve put as much RAM into your workstation as is practical, your next recourse for improving model performance is to reduce your file size so you’re not using as much RAM. Here are some tips to do that and thereby improve your file speed:

**Manage your views.** You can do two things using views to help improve performance. First, close windows you’re not using to help minimize the drain on your resources. It’s easy to lose track of how many views are open, even if you’re concentrating on only a few views—and the more you open, the more information you will load into active RAM. Use the Close Hidden Windows tool to close all the windows but your active one: on the View tab, click the Close Hidden Windows button (it’s also conveniently located in the Quick Access toolbar). You can also assign this command to a keyboard shortcut such as XX.

The other way to manage your views is to remove the ones you don’t need from your project. You can make views in your model quickly and easily, and this feature can lead to an abundance of views (possibly hundreds) that you aren’t using in your document set and don’t plan on using. Adding too many views can raise your overall file size even if you haven’t added any geometry. It is helpful to periodically get rid of unused views—typically views that are not on
sheets—to help keep your file size down. An easy way to manage this is to create a view list including the Sheet Number parameter. In other words, if the Sheet Number parameter for a view is empty, that view has not been placed on a sheet. Select rows in a view list, and use the Delete button in the ribbon; or select multiple views in the Project Browser, and use the Delete command on the right-click command menu.

**Delete or remove unused CAD files.** While working on a project you will often want to load content from another source to be used as a background. This could be a client’s CAD as-built drawings or a consultant’s mechanical, electrical, and plumbing (MEP) design. You might link or import these files into your drawing and forget about them during the busy course of the project. As you've seen from the earlier tips on RAM use, all these small files add up. Getting rid of them can speed up your file and is good housekeeping. If the file is linked, you can remove it using the Manage Links button on the Insert tab. Note that the Unload button does not remove it from the Revit Architecture project. If it is inserted, right-click an instance of the CAD file, and choose Select All Instances from the context menu. Clicking Delete will then remove all the instances in the view or project depending on your Select All Instances choice.

**Link instead of importing CAD files.** As a general rule, always link a CAD file rather than import a CAD file. You generally have greater control using a link rather than imported geometry. The link can be removed or unloaded from the project and all views with a single action. A CAD link is similar to an xref in Autodesk® AutoCAD® and will update if the original CAD file is modified. An imported CAD file may be spread across several different views and is more difficult to hide or remove from specific views or the entire project. It also has no association to the original CAD file and will not subsequently update if modified outside the Revit project.

**Never explode imported CAD files.** When imported into a family or project, a CAD file is a collection of objects that is managed as a single entity. If you explode a CAD file, the single object immediately becomes many objects—and they all take up space in the file, requiring more resources from the application to track and coordinate them.

   If you need to import a DWG file, leave them unexploded. If you need to hide lines, use the Visibility/Graphic Overrides dialog box to turn layers on and off. You can also permanently delete layers using the Delete Layers tool when the import instance is selected. Explore *only* when you need to change the imported geometry, and start with a partial explode to minimize the number of new entities. The margin illustration shows the tools available in the Options
Good file maintenance is critical to keeping your files running smoothly and your file sizes small. Here are some best practices and workflows identified in other areas of the book but consolidated in this section as a quick reference:
Manage the amount of information shown in views. An overload of information in views not only will make them look cluttered but also will adversely affect project performance. Show only what you need to show in a view. Do this by minimizing the level of detail, view detail, view depth, and view content. Here are some simple tips to keep your individual views working smoothly:

**Minimize the level of detail.** Set your detail level, found in the View Control Bar, relative to your drawing scale. For example, if you’re working on a 1/32’ = 1'-0" (1:100) plan, you probably don’t need Detail Level set to Fine. Doing so will cause the view to have a higher level of detail than the printed sheet can show, and you’ll end up with black blobs on your sheets and views that are slow to open and print.

**Minimize view detail.** Make sure you’re not showing more detail than you need. For instance, if you have wall studs shown in a 1/16" (1:200) scale plan or the extruded aluminum window section shown in a building section, chances are it will not represent correctly when printed. Turning off those elements in your view will keep things moving more smoothly as well as printing more cleanly.

**Minimize view depth.** View depth and crop regions are great tools to enhance performance. As an example, a typical building section is shown in Figure 14.2. The default behavior causes a regeneration of all the model geometry to the full depth of that view every time you open the view. To reduce the amount of geometry that needs to be redrawn, drag the section’s far clip plane (the green dashed line when you highlight the section) in close to the cutting plane.

**Minimize view content.** Another best practice is to limit the amount of visible content to only what is necessary in a view. For example, in an exterior 3D view of an entire building, perhaps you can turn off complete categories of detailed interior content such as electrical fixtures, plumbing fixtures, and furniture.
**Model only what you need.** Although it is possible to model to a very small level of detail, don’t fall into the trap of over-modeling. Be smart about what you choose to model and how much detail you show. If it’s not conveying information about the project, maybe it’s not needed. The amount of information you do or do not model should be based on your project size and complexity, your timeframe, and your comfort level with the software.

When trying to decide how much detail to put into a model or even a family, you can use the following three very good rules of thumb to help you make the right decision for the element you’re looking to create:

- **Scale** At what scale will this detail be seen? If it’s a very small-scale detail, it might be simpler to just draw it in 2D in a drafting view.

- **Repetition** How many times will the element appear in the drawing set? If it will appear in only one location or only one time, it might be easier to draft it in 2D rather than try to model the element. If it will appear in several locations, modeling is probably the better solution. The more exposure an element has in the model (the more views it shows in), the more reason you have to model it. For example, doors are good to model; they show in elevations and plans all over the sheet set.

- **Quality** How good at modeling families in Revit Architecture are you, honestly? Don’t bite off more than you can chew. If you’re new to Revit Architecture, keep it simple and use 2D components. The more projects you complete, the better you’ll understand the BIM workflow.

**Don’t over-constrain.** Embedding user-defined constraints into families and the model helps keep important information constant. However, if you don’t need to lock a relationship, don’t do it. Over-constraining the model can cause problems later in the project process when you want to move or modify locked elements. Constrain only when necessary. Otherwise, let the model be free.

**Watch out for imported geometry.** Although you have the ability to use geometry from several other file sources, use caution when doing so. Remember that everything you link into your model takes up about 20 times the file size in your system’s RAM. So, linking a 60 MB NURBS-based ceiling design will equal 2 GB of RAM and more than likely slow down your model. Deleting unused CAD files, using linking rather than importing, and cleaning up the CAD geometry before insertion will help keep problems to a minimum.
Purge unused files. You won’t use every family and every group you create in your model. The Purge Unused tool lets you get rid of those unused elements to help keep your file sizes at a reasonable level. This too can be found on the Manage tab on the Settings panel. If a file is very large, the tool can take several minutes to run, but eventually you’ll be presented with a list (Figure 14.3) of all the unused elements in your file.

Using this tool is typically not recommended at the beginning of a project while you are still iterating various design solutions and file sizes tend to be fairly small.

Model correctly from the beginning. As you refine your design, it’s critical to model correctly from the beginning, not taking shortcuts, so you don’t have to fix things later. If you can begin by thinking about how your project
will be assembled, it will save you a lot of time later in the process. It’s good practice to plan ahead, but remember that you can make major changes at any stage in the process and still maintain coordination. If you are in the early phase of design and do not know an exact wall type, use generic walls to capture your design intent; changing them later is as simple as swapping the type.

**Manage workshared files.** When you’re employing worksharing on a project, you’ll want to follow these additional tools and tips:

- **Make a new local file daily.** In a workshared environment, your local file is probably out-of-date by the next morning you come in. Instead of using the same model and having to pull down all the changes since you last reloaded or synchronized with central, create a new local file each morning. This will give you the latest version of the model and help minimize opportunities for corruption if synchronizing out-of-date information with the central model. Instead, you will start with a fresh data set each morning.

- **Divide your model.** For larger projects or campus-style projects, you can break up the model into several models and link them back together. Dividing a model helps limit the amount of information you are loading into a project at one time, gives you control to selectively unload links, and reduces the number of users working in the same project (since some will be working directly in the linked models).

  If you decide to divide your project, make your cuts along lines that make sense from a holistic-building standpoint. Don’t think of the cuts as you would in CAD, but consider how the actual assemblies will interact in the building. For example, don’t cut between floors 2 and 3 on a multistory building unless you have a significant change in building form or program. Here are some good places to split a model:

  - At a significant change in building form or massing
  - At a significant change in building program
  - Between separate buildings on the site
  - At the building site

**Using Quick Tips and Shortcuts**

In addition to all the things you can do to hone your Revit Architecture skills, you will begin to learn tips and shortcuts as your experience grows using the software. Here are some good tips to get you started:
Filter your selection. Revit Architecture 2014 gives you control over which elements are available for selection. You can filter selection behavior by customizing any combination of links, underlay elements, pinned elements, the ability to select elements by face, and the ability to drag elements on selection. For example, on a large project, you may want to disable link selection to prevent accidental selection of linked models. These options can be toggled on the fly and are available in two locations: under the Modify arrow and on the lower-right corner of the status bar (Figure 14.4).

Customize your double-click behavior. Revit Architecture 2013 introduced some double-click behavior for entering edit mode, and Revit Architecture 2014 expands on the behavior (while also allowing customization). If you navigate to Application ➢ Options ➢ User Interface ➢ Double-Click Options, you can customize the action for the element types (Figure 14.5). The available actions will vary based on the element type; however, each type has a Do Nothing option. For example, if you find yourself accidentally double-clicking to edit families, you can now change the behavior.
Let Revit Architecture do the math. Revit Architecture is like a big calculator, and it’s very good at doing math correctly. Don’t want to spend the time figuring out what the room size is after you subtract a 3 5/8” and 5/8” piece of gypsum board from an 11’-2” room? Then don’t. If you need to modify a dimension, simply add an equal sign and a formula (Figure 14.6), and the value will be calculated for you.

<table>
<thead>
<tr>
<th>Dimensions</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Thickness</td>
<td>4” - 2 1/16”</td>
</tr>
<tr>
<td>Height</td>
<td>7’ 6”</td>
</tr>
<tr>
<td>Trim Projection Exit</td>
<td>1”</td>
</tr>
<tr>
<td>Trim Projection Int.</td>
<td>1”</td>
</tr>
</tbody>
</table>

**Figure 14.6** Performing calculations in Revit Architecture

Make elevators visible in your plans. Suppose you want to create a shaft that will penetrate all the floors of your building and put an elevator in it that will show in all your plans. You could do this with an elevator family and cut a series of holes in the floors by editing floor profiles, but sometimes those holes stop aligning on their own recognizance. Fortunately, you can do both things at once using the Shaft tool on the Opening panel of the Architecture tab. Here, not only can you cut a vertical hole through multiple floors as a single object, but also you can insert 2D linework (using the Symbolic Line tool when editing the shaft opening sketch) to represent the elevator in plan view (Figure 14.7). Every time the shaft is cut, you’re certain to see the elevator linework.

**Figure 14.7** Adding elevators to a shaft

Orient to view. Creating perspective views of isolated design elements can be quick and easy in plan view or in section view, but let’s say you want to see that same element in 3D to be able to work out the details.
1. Create a callout or section cut isolating the area in question. If you're using a section, make sure to set your view depth to something practical.

2. Open the default 3D view or any other 3D orthographic view of the project.

3. Right-click the ViewCube, select Orient To View, and select the callout or section from the context menu.

4. Your 3D view looks identical to your section or plan region, but by rotating the view, you can see that portion in 3D.

**Tune your shortcuts.** To edit your keyboard shortcuts, choose Application ➢ Options. Choose the User Interface tab, and then click the Customize button. You can also access this command on the View tab in the ribbon under the User Interface flyout button. The Keyboard Shortcuts dialog box (Figure 14.8) allows you to edit those shortcuts. Consider making common shortcuts the same letter. So, instead of pressing VG to get to your Visibility/Graphic Overrides dialog box, make the shortcut VV for quicker access.

![Keyboard Shortcuts](image)

**Figure 14.8** Editing your keyboard shortcuts

**Drag and drop families.** Suppose you need to load a family into a project, the Windows Explorer window is open, and you know where the family is, but you
don’t want to go through the laborious effort of navigating across your office’s server environment to get there. No problem. You can drag and drop families from Windows Explorer directly into the project file.

**Copy a 3D view.** Suppose you made the perfect 3D view in your last project, and you can’t figure out how to get it into your current project. Fortunately, there’s a way to copy views from one project to another. Open both files in the same instance of Revit Architecture, and then do the following:

1. In your perfect view, right-click the 3D view in the Project Browser, and choose Show Camera from the context menu.
2. Press Ctrl+C to copy the selected camera.
3. In your new model, press Ctrl+V to paste the camera. The view and all its settings are now there.

**Move your ribbon.** Did you know that you can reorganize the tabs on the ribbon and place them in any order you’d like? To do so, hold down the Ctrl key, and select a tab (such as Manage). You can drag it left or right to change the order in which it appears.

**Disallow joining for walls.** By default Revit Architecture will join walls that intersect; however, you will eventually run into a condition where you need to override this behavior. First select a wall and hover over the Drag Wall End grip. Then right-click and choose Disallow Join. This will unjoin the wall and give you additional control to drag the wall end without it automatically jumping and joining to the intersecting wall.

**Join geometry on parallel walls.** If you have two parallel walls and there is an opening hosted on one wall (such as a door or window), you may want to automatically cut an opening through the second wall as well. If the walls are close enough (around 1"-0’ of each other), you can use the Join Geometry tool between the two walls. After that, an opening will be cut in the other parallel wall and will move with the original family (Figure 14.9).
Prevent room numbers from shifting on cut/paste. By default when you cut and paste rooms in a project, the room numbers will shift to the next available numbers. There is a trick to maintain the room numbers when cutting and pasting. Select the rooms you will be cutting to the clipboard and create a group. Once the rooms are in a group, they can be cut and pasted without changing the room numbers. Then they can be ungrouped, and the group can be deleted from the Project Browser.

Copy objects from a Revit Architecture link. Need to copy an object from a Revit Architecture link and paste it into the host project? No problem; simply hover over the object in the link you want to copy and press the Tab key until the object is highlighted. Then click to select the object and use the standard copy and paste commands. The element will be copied from the link and pasted directly into the host project where it can be directly manipulated (Figure 14.10).

Show annotation from a Revit Architecture link. Some annotation objects can be displayed from a Revit Architecture link. If the link contains annotation (such as room tags, dimensions, and so on) and you want to display it in the host project, set the Visibility/Graphic Overrides properties for the Revit link to By Linked View or Custom. You can further customize which view is displayed by adjusting the Linked View name on the Basics tab.
Finding Additional Resources

A number of resources are available to help you along the way and improve your use of the software, help you solve problems, and assist you in creating new content. There is a wealth of information online to help you learn or communicate with users far and wide. So, before you spend hours trying to solve a particularly challenging problem on your own, you might check some of these tools:

**Revit Architecture WikiHelp**  Open the Revit Architecture WikiHelp by clicking the question-mark icon in the upper-right corner of the application. This tool will give you a basic synopsis of all the tools, buttons, and commands available in the application. It is available as a wiki at http://wikihelp.autodesk.com/Revit.

**Subscription Support**  If you have purchased Revit Architecture on subscription, Revit Subscription Support offers web-based support. Its responses are speedy, its advice is top-notch, and chances are the support staff has seen your problem before. You can access Subscription Support at http://subscription.autodesk.com.

**AUGI**  Autodesk User Group International (AUGI) is a source for tips and tricks as well as excellent user forums. The forums are free to participate in, and it’s a great place where you can ask questions, find answers, and discuss project workflows. AUGI is located at www.augi.com. Once you’re there, look for Revit Architecture.

**Revit Forum**  Revit Forum is an ever-growing resource with forums and collections of blog posts and has many experienced Revit users regularly participating. Registration is free, and the forums are an extremely valuable resource for common issues and workflow recommendations. Revit Forum is located at www.revitforum.org.

**YouTube**  Here’s a great reason to tell your IT department you need access to YouTube. Autodesk has its own channel with great free content: www.youtube.com/user/autodesk. It has hundreds of short videos showing how to perform specific tasks in Revit Architecture.

**AECbytes**  AECbytes is a website dedicated to following the trends in the AEC industry, with a strong focus on BIM, technology, and the direction of the industry. The site is put together by Lachmi Khemlani; see www.aecbytes.com.
Whew! You made it to the end of what would be three days of Revit Architecture training. You should know enough by this point to be valuable to your project teams and ready to start your first Revit Architecture project. In this chapter, you learned some of the tips and tricks that seasoned users employ every day. High-fives all around! While you bask in the glow of your new knowledge, you might be wondering, “Where do I go from here?” If you’re looking for additional resources beyond what we’ve listed, join the larger Revit Architecture community.

▶ Check out the Revit Forum and AUGI. Many a Revit Architecture user has found helpful hints there.

▶ If you truly learned from what you read here and want to take the next step, we recommend the Mastering Revit book series, which you can find at www.sybex.com/go/masteringrevit2014, www.amazon.com, or wherever fine Revit Architecture books are sold.
Autodesk certifications are industry-recognized credentials that can help you succeed in your design career, providing benefits to both you and your employer. Getting certified is a reliable validation of skills and knowledge, and it can lead to accelerated professional development, improved productivity, and enhanced credibility.

This Autodesk Official Press book can be an effective component of your exam preparation. Autodesk highly recommends (and we agree!) that you schedule regular time to prepare, review the most current exam preparation roadmap available at www.autodesk.com/certification, use Autodesk Official Press books, take a class at an Authorized Training Center (find one nearby here: www.autodesk.com/atc), and use a variety of resources to prepare for your certification—including plenty of actual hands-on experience.

To help you focus your studies on the skills you’ll need for these exams, the following tables show objectives that could potentially appear on an exam and in what chapter you can find information on that topic; when you go to that chapter, you’ll find certification icons like the one in the margin here.

Table A.1 is for the Autodesk Certified User Exam and lists the section, exam objectives, and chapter where the information is found. Table A.2 is for the Autodesk Certified Professional Exam. The sections and exam objectives listed in the table are from the Autodesk Certification Exam Guide.

These Autodesk exam objectives were accurate at press time; please refer to www.autodesk.com/certification for the most current exam roadmap and objectives.

Good luck preparing for your certification!
<table>
<thead>
<tr>
<th>Topic</th>
<th>Learning Objective</th>
<th>Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Interface: Definitions</td>
<td>Identify primary parts of the user interface (UI): tabs, application menu, InfoCenter, ribbon, Elevation tag, Status bar, View Control bar, Project Browser, context/right-click menus.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td>User Interface: UI Navigation/Interaction</td>
<td>Name the key features of the ribbon. Define how a split button works. Demonstrate the three ways the ribbon can be displayed: Full Ribbon, Min to Panel Tiles, Min to Tabs. Demonstrate how to detach a panel and move it on the screen.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Describe the hierarchy in the Project Browser for a new project.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Define what “context” means when right-clicking in the drawing window.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Name the tools found on the Application menu (Save, Plot, Export, Print).</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Demonstrate how to add items to the Quick Access toolbar.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Describe why the Options Bar changes.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Describe the function of the Status bar.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Describe what pressing the Escape key does.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td>User Interface: Drawing Window</td>
<td>Describe what double-clicking an elevation view marker does.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Demonstrate how to turn on/off the 3D Indicator.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Demonstrate how to change the view scale.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td>User Interface: Navigation Control</td>
<td>Describe the functionality of the ViewCube.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Describe what the ViewCube home icon does.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td>Topic</td>
<td>Learning Objective</td>
<td>Chapter</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>User Interface: Zoom</td>
<td>Describe how to zoom using the Navigation bar.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Describe the quickest way to zoom in or out.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Describe the quickest way to pan.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td>File Management: Definitions</td>
<td>Define the acronym BIM and why it is important to Revit users.</td>
<td>Introduction</td>
</tr>
<tr>
<td></td>
<td>Define a template file.</td>
<td>Chapter 13</td>
</tr>
<tr>
<td>File Management: Project Files</td>
<td>Identify the file extension of a project file (.rvt).</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Identify the file extension of a template file (.rte). Create a template file for later project use.</td>
<td>Chapter 13</td>
</tr>
<tr>
<td></td>
<td>Identify the file extension of a Revit family file (.rfa).</td>
<td>Chapter 5</td>
</tr>
<tr>
<td>File Management: Open Existing Revit Project</td>
<td>Locate the Recent File window.</td>
<td>Not Covered</td>
</tr>
<tr>
<td></td>
<td>Demonstrate how to open a Revit file through Projects ➢ Open and through Application menu ➢ Open Documents icon.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td>File Management: Create New Revit Project</td>
<td>Demonstrate how to create a new Revit project folder and file through Application menu ➢ New ➢ Project.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Change to a metric drawing.</td>
<td>Not Covered</td>
</tr>
<tr>
<td></td>
<td>Add project information to a new drawing set.</td>
<td>Chapter 12</td>
</tr>
<tr>
<td></td>
<td>Change system settings to create a new dimension style. Change arrows to architectural tick (obliques).</td>
<td>Chapter 11</td>
</tr>
<tr>
<td>Views: View Control and Properties</td>
<td>Navigate and change views using the View Control bar.</td>
<td>Chapter 2</td>
</tr>
</tbody>
</table>

(Continues)
<table>
<thead>
<tr>
<th>Topic</th>
<th>Learning Objective</th>
<th>Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Understand the view range of plan views and be able to change it.</td>
<td>Not Covered</td>
</tr>
<tr>
<td></td>
<td>Understand the purpose of view templates.</td>
<td>Not Covered</td>
</tr>
<tr>
<td></td>
<td>Change object visibility using temporary hide, hide category, and hide element.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td>Views: View Types</td>
<td>Create section views including segmented ones.</td>
<td>Chapter 9</td>
</tr>
<tr>
<td></td>
<td>Modify, crop, and place elevation views on a sheet.</td>
<td>Chapter 12</td>
</tr>
<tr>
<td></td>
<td>Create and navigate 3D views.</td>
<td>Chapter 2</td>
</tr>
<tr>
<td></td>
<td>Create callouts for details.</td>
<td>Chapter 11</td>
</tr>
<tr>
<td></td>
<td>Create and annotate a drafting view.</td>
<td>Chapter 11</td>
</tr>
<tr>
<td></td>
<td>Use the section box to create a cutaway 3D view.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td>Views: Cameras</td>
<td>Create a camera view, and modify its orientation.</td>
<td>Not Covered</td>
</tr>
<tr>
<td></td>
<td>Create and edit a walkthrough.</td>
<td>Not Covered</td>
</tr>
<tr>
<td>Levels: Definitions</td>
<td>Describe a level. Describe a use of a non-story level.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Understand how levels interact with intersecting views.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Create new levels.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Understand level properties and characteristics.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td>Walls: Home Tab ➔ Wall</td>
<td>Describe how to place walls.</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Walls: Options Bar</td>
<td>List options available when placing and modifying walls: Height, Location Line, Chain, Offset, Radius.</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Topic</td>
<td>Learning Objective</td>
<td>Chapter</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Walls: Openings</td>
<td>Create a floor-to-ceiling opening in given wall.</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Walls: Join</td>
<td>Demonstrate a join on crossing wall elements.</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Walls: Materials</td>
<td>Create a new wall style, and add given materials.</td>
<td>Chapter 2, 9</td>
</tr>
<tr>
<td>Doors: Home Tab → Door</td>
<td>Describe how to place doors.</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Doors: Options Bar</td>
<td>Describe door options: Vertical/Horizontal, Tag on Placement, Leader, Leader Attachment Distance.</td>
<td>Chapters 2, 5</td>
</tr>
<tr>
<td>Doors: Model in Place</td>
<td>Edit existing doors. Use Align to position a door.</td>
<td>Chapters 2, 5</td>
</tr>
<tr>
<td>Windows: Home Tab → Window</td>
<td>Describe how to place windows.</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Windows: Options Bar</td>
<td>Describe window options: Vertical/Horizontal, Tag on Placement, Leader, Leader Attachment Distance.</td>
<td>Chapters 2, 5</td>
</tr>
<tr>
<td>Windows: Model in Place</td>
<td>Edit existing windows.</td>
<td>Chapters 6</td>
</tr>
<tr>
<td>Component: Options Bar</td>
<td>List options available when placing a component.</td>
<td>Chapter 5</td>
</tr>
<tr>
<td>Component: Component Host</td>
<td>Describe how to move a component to a different host.</td>
<td>Chapter 5</td>
</tr>
<tr>
<td>Component: Families</td>
<td>Navigate to find component families and load them.</td>
<td>Chapter 5</td>
</tr>
<tr>
<td></td>
<td>Edit a family file and save.</td>
<td>Chapter 6</td>
</tr>
<tr>
<td>Columns and Grids: Definitions</td>
<td>Identify the uses of a grid.</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Columns and Grids: Home Tab → Grid</td>
<td>Create an equally spaced grid pattern.</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Topic</td>
<td>Learning Objective</td>
<td>Chapter</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Columns and Grids: Grid Properties</td>
<td>List the options available when placing and modifying grids.</td>
<td>Chapter 2</td>
</tr>
<tr>
<td>Columns and Grids: Home Tab → Column</td>
<td>Place columns on a grid.</td>
<td>Not Covered</td>
</tr>
<tr>
<td>Columns and Grids: Column Properties</td>
<td>List the options available when placing and modifying columns.</td>
<td>Not Covered</td>
</tr>
<tr>
<td>Columns and Grids: Modify</td>
<td>List the tools you can use to modify columns and grids.</td>
<td>Not Covered</td>
</tr>
<tr>
<td>Stairs and Railings: Stair Types and Properties</td>
<td>Set the stair type.</td>
<td>Chapter 4</td>
</tr>
<tr>
<td></td>
<td>Change the stair tread depth.</td>
<td></td>
</tr>
<tr>
<td>Stairs and Railings: Stair Placement Options</td>
<td>Add a stair.</td>
<td>Chapter 4</td>
</tr>
<tr>
<td>Stairs and Railings: Railing Types and Properties</td>
<td>Set the railing to rectangular.</td>
<td>Chapter 4</td>
</tr>
<tr>
<td></td>
<td>Set the railing properties.</td>
<td>Chapter 4</td>
</tr>
<tr>
<td>Stairs and Railings: Railing Placement Options</td>
<td>Add a railing.</td>
<td>Chapter 4</td>
</tr>
<tr>
<td>Roofs and Floors: Roof Types and Properties</td>
<td>Create a roof.</td>
<td>Chapter 3</td>
</tr>
<tr>
<td></td>
<td>Modify the roof properties.</td>
<td>Chapter 3</td>
</tr>
<tr>
<td>Roofs and Floors: Roof Elements</td>
<td>Create a fascia, a soffit, and a gutter.</td>
<td>Not Covered</td>
</tr>
<tr>
<td>Roofs and Floors: Floors Types and Properties</td>
<td>Set the floor type (Sloped and Tapered).</td>
<td>Chapter 3</td>
</tr>
<tr>
<td></td>
<td>Create a floor.</td>
<td></td>
</tr>
<tr>
<td>Sketching: Geometry</td>
<td>Sketch geometry and profiles using all sketching tools: Lines, Arcs, Polygons, Rectangles.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td>Sketching: Fillet, Trim</td>
<td>Fillet objects.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td></td>
<td>Trim objects.</td>
<td>Chapter 1</td>
</tr>
<tr>
<td>Topic</td>
<td>Learning Objective</td>
<td>Chapter</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Sketching: Snaps</td>
<td>Describe the benefits of using snaps.</td>
<td>Chapter 2</td>
</tr>
<tr>
<td></td>
<td>List the shortcuts to toggle osnap on and off.</td>
<td>Not Covered</td>
</tr>
<tr>
<td>Annotations: Text</td>
<td>Add model text to a floor plan.</td>
<td>Not Covered</td>
</tr>
<tr>
<td>Annotations: Dimensions</td>
<td>Add a dimension to a given floor plan. Create a wall section.</td>
<td>Chapter 11, 12</td>
</tr>
<tr>
<td></td>
<td>Add a spot slope to a roof on a given plan.</td>
<td>Not Covered</td>
</tr>
<tr>
<td>Annotations: Tags</td>
<td>Add tags.</td>
<td>Chapter 11</td>
</tr>
<tr>
<td></td>
<td>Tag untagged elements in a given floor plan.</td>
<td>Chapter 8</td>
</tr>
<tr>
<td>Schedules: Schedule Types</td>
<td>Create a door schedule.</td>
<td>Not Covered (while there is no specific coverage of a door schedule, creating schedules is in Chapter 12)</td>
</tr>
<tr>
<td></td>
<td>Create a window schedule.</td>
<td>Chapter 12</td>
</tr>
<tr>
<td></td>
<td>Create a room schedule.</td>
<td>Chapter 8, 12</td>
</tr>
<tr>
<td>Schedules: Legends</td>
<td>Create a legend</td>
<td>Chapter 11</td>
</tr>
<tr>
<td>Schedules: Keynotes</td>
<td>Add keynotes.</td>
<td>Chapter 12, 13</td>
</tr>
<tr>
<td>Construction Document Sets:</td>
<td>Create a title sheet with a sheet list.</td>
<td>Chapter 12</td>
</tr>
<tr>
<td>Sheet Setup</td>
<td>Create view/sheet sets for printing.</td>
<td>Chapter 12</td>
</tr>
<tr>
<td>Construction Document Sets:</td>
<td>Print in scale. Print with percentage.</td>
<td>Chapter 12</td>
</tr>
<tr>
<td>Printing</td>
<td>Render.</td>
<td>Chapter 9</td>
</tr>
<tr>
<td></td>
<td>Place generic lights.</td>
<td>Not Covered</td>
</tr>
<tr>
<td>Set the solar angle.</td>
<td></td>
<td>Not Covered</td>
</tr>
<tr>
<td>Topic</td>
<td>Learning Objective</td>
<td>Chapter</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Collaboration</td>
<td>Copy and monitor elements in a linked file.</td>
<td>Not Covered</td>
</tr>
<tr>
<td></td>
<td>Use worksharing.</td>
<td>Chapter 10</td>
</tr>
<tr>
<td></td>
<td>Import DWG files into Revit.</td>
<td>Chapter 13 (although the same process using PNG files is covered in Chapter 2)</td>
</tr>
<tr>
<td>Documentation</td>
<td>Create and modify filled regions.</td>
<td>Chapter 11</td>
</tr>
<tr>
<td></td>
<td>Place detail components and repeating details.</td>
<td>Chapter 11</td>
</tr>
<tr>
<td></td>
<td>Tag elements (doors, windows, and so on) by category.</td>
<td>Chapter 11</td>
</tr>
<tr>
<td></td>
<td>Use dimension strings.</td>
<td>Chapter 11</td>
</tr>
<tr>
<td></td>
<td>Set the colors used in a color-scheme legend.</td>
<td>Chapter 8</td>
</tr>
<tr>
<td>Elements</td>
<td>Change elements within a curtain wall: grids, panels, mullions.</td>
<td>Chapter 2</td>
</tr>
<tr>
<td></td>
<td>Create compound walls.</td>
<td>Chapter 2</td>
</tr>
<tr>
<td></td>
<td>Create a stacked wall.</td>
<td>Chapter 2</td>
</tr>
<tr>
<td></td>
<td>Differentiate system and component families.</td>
<td>Chapter 5</td>
</tr>
<tr>
<td></td>
<td>Create a new family type.</td>
<td>Chapter 6</td>
</tr>
<tr>
<td></td>
<td>Modify an element’s type parameters.</td>
<td>Chapter 2</td>
</tr>
<tr>
<td></td>
<td>Use Revit family templates.</td>
<td>Chapter 5</td>
</tr>
<tr>
<td>Modeling</td>
<td>Assess or review warnings in Revit.</td>
<td>Not Covered</td>
</tr>
<tr>
<td></td>
<td>Create a building pad.</td>
<td>Chapter 13</td>
</tr>
<tr>
<td>Topic</td>
<td>Learning Objective</td>
<td>Chapter</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Define floors for a mass.</td>
<td>Create a stair with a landing.</td>
<td>Chapter 7</td>
</tr>
<tr>
<td></td>
<td>Create elements such as floors, ceilings, or roofs.</td>
<td>Chapter 3</td>
</tr>
<tr>
<td>Generate a toposurface.</td>
<td>Create elements such as floors, ceilings, or roofs.</td>
<td>Chapter 3</td>
</tr>
<tr>
<td>Model railings.</td>
<td>Work with phases.</td>
<td>Not Covered</td>
</tr>
<tr>
<td></td>
<td>Edit a model element’s material: door, window, furniture.</td>
<td>Not Covered</td>
</tr>
<tr>
<td>Change a generic floor/ceiling/roof to a specific type.</td>
<td>Chapter 3</td>
<td></td>
</tr>
<tr>
<td>Attach walls to a roof or ceiling.</td>
<td>Chapter 3</td>
<td></td>
</tr>
<tr>
<td>Views</td>
<td>Define element properties in a schedule.</td>
<td>Chapter 12</td>
</tr>
<tr>
<td></td>
<td>Control visibility.</td>
<td>Chapter 12</td>
</tr>
<tr>
<td></td>
<td>Use levels.</td>
<td>Chapter 12</td>
</tr>
<tr>
<td></td>
<td>Create a duplicate view for a plan, section, elevation, drafting view, and so on.</td>
<td>Chapter 9</td>
</tr>
<tr>
<td></td>
<td>Create and manage legends.</td>
<td>Chapter 12</td>
</tr>
<tr>
<td></td>
<td>Manage the view position on sheets.</td>
<td>Chapter 12</td>
</tr>
<tr>
<td></td>
<td>Move the view title independently of the view.</td>
<td>Chapter 12</td>
</tr>
<tr>
<td></td>
<td>Organize and sort items in a schedule.</td>
<td>Chapter 12</td>
</tr>
</tbody>
</table>
Note to the Reader: Throughout this index **boldfaced** page numbers indicate primary discussions of a topic. *Italicized* page numbers indicate illustrations.

**A**
- accessories, 337, 337
- Activate View command, 318 activating
  - commands, 7
  - views, 318, 318
- active views
  - displaying, 7
  - properties, 3
  - visibility, 250
- active worksets, 264
- Add Edge tool, 199, 199
- Add Leader button, 291
- Add Parameter option, 170
- Add Points From Selected Layers dialog box, 340, 340
- Add/Remove Segments option, 60–61, 60
- Add Split Line option, 72
- Additional Settings menu, 216
- Adjust Exposure option, 239
- AECbytes website, 365
- Align tool
  - dimensions, 20, 22, 22
  - lights, 96
- Aligned Dimension tool, 174, 187
- Aligned To Selected Levels option, 28, 28, 77
- Aligned tool, 18, 283
- aligning
  - copying, 27–29, 28–29
  - dimensions, 18, 283
  - elements, 20–22, 20–23
  - lights, 96
  - shafts, 77
  - views on sheets, 314, 314
  - windows, 306
- Alignment setting, 306
- Ambient Light setting, 235
- Annotation Categories tab, 159
- annotations and Annotate tab, 282, 283
- blocking, 274
- color legends, 219, 224
- component families, 133
- dimensions, 18, 283–287, 283–287
- filled regions, 270–271
- groups, 281
- insulation, 280
- lines, 317–318
- from links, 364
- regions, 269
- repeating details, 167, 276, 278
- tags, 288–290, 288–290
- text, 291, 291–292
- Appearance tab
  - materials, 229, 229, 231
  - schedules, 304, 304
- Arc tool, 87
- architects role in BIM workflow, 333–334
- Architecture tab
  - ceilings, 90
  - datums, 11
  - doors, 23, 40
  - families, 154
  - floors, 67, 74
  - in-place families, 139
  - levels, 188
  - railings, 119
  - ramps, 114
  - reference planes, 186
  - roofs, 80, 86
  - room options, 209
  - room separation lines, 216
  - room tags, 211
  - shafts, 361
  - stairs, 103
- volume computation, 355
- walls, 7, 17, 32
- Architecture-Tech blog, 366
- Area & Volume Computations dialog box, 355, 355
- area computation, 209–210, 210
- Arrange panel, 276
- arranging elements, 276
- Array tool, 26, 190
- arrays
  - creating, 26, 27
  - options, 190, 190
- arrowheads for tags, 290, 290
- arrows, slope
  - building pads, 340
  - ceilings, 97, 97
  - floors, 70–72, 71–72
- assemblies, repeating, 351
- Assembly Views tool, 351
- Asset Browser window, 229–230, 230
- assigning
  - elements to worksets, 250–253, 251–253
  - materials, 93, 93
- Associate Family Parameter dialog box, 170
- associating linked files, 265
- Attach Top/Base option, 46, 47, 85
- attaching walls
  - to roof, 85–86, 85
  - top and base, 45–47, 46–47
- AUGI (Autodesk User Group International), 365
- Authorized Training Center, 367
- Autodesk Certification Exam Guide, 374–375
- Autodesk Certified Professional Exam, 374–375
- Autodesk Certified User Exam, 367–373
Autodesk Official Book, 367
Autodesk Seek resource, 140–141, 140
automatic ceilings, 90, 90–91
automatic snapping, 8

B
background images, 183–184, 183–184
Baluster Placement option, 102
Baluster-Square option, 151
balusters
editing, 102–103, 103, 159, 160
level of detail, 147, 151
Base Constraint parameter, 44
Base Is Attached parameter, 44
base masses, modeling, 193–194, 193–195
Base Offset setting, 44, 94
baseboards, 274
basement floor plans, 313–319, 314–319
Basic Wall Node, 293
basic walls, 32–34, 32–34
batt insulation, 280

Begins With filter condition, 310
best practices, 355–359, 356, 358
BIM (building information modeling)
approach, 1
overview, 329–332, 330–331
project roles, 332–336, 335
staffing, 332
teams members, 336
black color
levels, 12, 189
links, 324
ramp lines, 115
tables, 319
tags, 315–316
borrowed elements
central files, 254–255
displaying, 260–261, 261
boundaries
building pads, 340
ceilings, 94, 94
ing, 163–164, 164
filled regions, 271, 271
floors, 68–70, 69–70
ramps, 116–117, 117
rooms, 213–214, 214–215
schedules, 304
stairs, 108, 108
Boundary tool, 117
break lines, 163, 163
Break Up option, 35
breaking schedules, 320
Brick component, 276
Bring Forward option, 276
Bring To Front option, 276, 279
Building Elevation view, 11
building information modeling (BIM)
approach, 1
overview, 329–332, 330–331
project roles, 332–336, 335
staffing, 332
teams members, 336
building pads, 340–341, 341
bulkhead conditions, 94–95, 94–95
By Face tool, 74

C
CAD-based projects, 329, 330
CAD files
deleting and unloading, 354
exploding, 354–355
linking, 354
Calculate Totals option
mass floors, 205
schedules, 303
calculations
performing, 361, 361
volume, 209–210, 210, 355, 355
Callout tool, 270
case sensitivity of queries, 310
Cast Shadows option, 233, 235
categories
in model hierarchy, 125
schedules, 299–300
Ceiling tool, 90
ceilings, 89, 90
automatic, 90, 90–91
bulkhead conditions, 94–95, 94–95
changing, 97, 97
lights and grids, 96, 96
sketching, 91–93, 91–93
sloped, 97, 97
central files
avoiding, 265
copying, 244, 247
creating, 246, 246
preparing, 244–245, 244–245
saving to, 253–255, 253–255
certification exam, 367–375
CFD (computational fluid dynamics) model, 332
chain-select method, 14
chains of elements
lines, 39, 40
selecting, 5, 14
walls, 80, 80
chairs, placing, 25–26, 25–27, 258, 258–259
Checkout Status tab, 261, 262
Choose Space Type and Color Scheme dialog box, 220
circles for toposurfaces, 338
clipboard, copying to, 28
Clipboard panel, 28
Close Hidden Windows tool, 353
closing
hidden windows, 13, 353
worksets, 260, 269, 265
closure options, walls, 177, 177
CMU element, 167
Coarse detail level, 149
code requirements, architects for, 333
Collaborate tab
synchronization, 253
workset access, 244
collections. See groups
color
- cut symbols, 320
- dashed lines, 186
- dimensions, 19, 206, 284–286
- levels, 11–12, 189
- lines, 170
- links, 324
- ramp lines, 115
- schedules, 319
- separation lines, 216
- tags, 315–316

Color dialog box
- lines, 127
- materials, 229
- schemes, 221
- Color field, 221
- Color Fill Legend tool, 219, 224
- Color Fill panel, 224
- Color-fill plans, 219
- color schemes, 221–222, 221–222
- legends, 219–220, 220
- sections, 222–225, 222–225
- Color Scheme Location parameter, 225
- commands, activating, 7
- Component menu, 269
- Component tool, 23–24
- components
detail. See details and detail levels
- families. See families hosted. See hosted components
- inserting, 269–270
- Compress option, 345
- computational fluid dynamics (CFD) model, 332
- computations
- performing, 361, 361
- volume, 209–210, 210, 355, 355
- conflicts, errors and warnings for, 346
- Consistent Colors mode, 323
- Constrain option, 25
- constraints
- alignment, 22, 22
- overconstraining, 357
- walls, 14, 15, 44
- containers, worksets as, 264
- content
- component families, 139–141, 139–140
- team member additions for, 336
- contour polylines for toposurfaces, 338
- Copy To Clipboard tool, 28
- Copy tool for levels, 11–12, 189
- copying
- 3D views, 363
- aligned, 27–29, 28–29
- central files, 244, 247
- chairs, 25, 25
- groups, 256, 257
- levels, 12, 189
- local files, 359
- objects from links, 364, 364
- core worksets, 248
- corrupted files, 346
- Count field, 306
- Create Detail Group dialog box, 190, 190
- Create Form option, 194, 197
- Create From Import option, 340
- Create Group tool, 25, 280–281, 350
- Create New Local option, 247
- Create tab for masking regions, 273
crop regions
graphics display, 234–235
performance, 356
Crop tool, 5
crop windows and tags, 288, 288–289
crossing railing lines, 118, 118
Current Window option, 325
curtain-grid segments, 60–61, 60
Create Grid tool, 52, 52
curtain walls, 51
curtain-grid segments, 60–61, 60
elevation profiles, 56–57, 57
embedding, 55–56, 55
grids, 52, 52, 57–58, 58
masses for hosting, 208
mullions, 53, 53–54, 58–59, 59
panels, 61–62, 62
selecting, 16
types, 35, 36
curved curtain wall panels, 54
Customize Double-click Settings dialog box, 360, 360
- cut symbols, 320
cutting wall openings, 48–49, 48

D
dashed lines for planes, 186
datums, adjusting, 11–13, 12–13
daylighting, 330–332
Deactivate View command, 319
deactivating views, 319
deadlines, 336
Default 3D View icon, 198, 198
defaults
- 3D view, 7
- ceilings, 90
- handrails, 104
- lines, 282
- mullions, 53
- railings, 100
- stair runs, 146, 147
- templates, 53, 183
title blocks, 169
- wall placement, 17–18
- Defines Origin option, 155–156, 156
- Defines Slope option, 82, 85–86
- deleting
- CAD files, 354
- constraints, 44
- mullions, 59
- objects, 178
- rooms, 217–219, 218–219
- schedule rows, 304
tags, 210
- wall openings, 49
depth, views, 356
desks
- family level of detail, 149, 150
- placing, 23–27, 24–27
- Detach From Central option, 264
- detaching wall top and base, 45–47, 46–47
- Detail Component family, 278
- Detail Component option, 270, 274
detail components, 133
detail groups, 281
- Detail Level tool, 5, 356
- Detail Line tool, 268, 275, 317, 317
Detail Line toolset, 268, 268
Detail Rotation component, 167
Detail rotation option, 278
Detail View settings, 146
details and detail levels, 267–268
arranging elements in views, 276
creating, 270–275, 270–275
dimensions, 283–287, 283–287
editing, 163–166, 163–167
families
display, 148–151, 148–150
editing, 143–145, 144–145
groups, 280–281, 281
insulation, 280, 280
legends, 292–294, 293–294
linework
description, 268–269, 268
working with, 281–282, 282
minimizing, 356
regions, 269
repeating
creating, 276–280, 277–279
editing, 167–168, 168
rules of thumb, 357
tags, 288–290, 288–290
team member additions for, 336
text, 291, 291–292
diagonal crosshatch pattern, 32
dimensions
adding, 283–287, 283–287
aligning, 18, 20–22, 20–23, 283
curtain walls, 53
drafters for, 334
grid lines, 169, 170
hosted components, 173–174, 174
reference planes, 187, 187
walls, 16–20, 17–19, 284, 284
Disallow Join option, 363
Displace Elements feature, 237–238, 237–238
display filters
schedules
description, 302, 302
Sheet List, 310, 311
worksets, 251–252, 252
display modes for worksets, 260–262, 261–262
dividing lines, 317–318, 317
dividing models, 359
doors
curtain-grid segments, 60–61, 60
placing, 23
in walls, 40, 41
Doors And Windows setting, 20
double-click behavior, 360, 360
DPI setting, 239
drafters role in BIM workflow, 334–335, 335
drag and drop families, 362–363
draw panel, 7, 8
arcs, 87
Pick Lines icon, 17, 17
shapes, 269
slope arrows, 71
drawing sets
placing views, 313
floor plans, 313–319, 314–319
schedules, 319–320, 320
printing documents, 321–326, 322–323, 326
schedules. See schedules
duplicating
components, 256, 257
handrails, 100
materials, 229, 229
views, 231, 232
edges
ceilings, 94, 97
masses, 199
Edit Assembly dialog box
ceilings, 93
walls, 228
Edit Baluster Placement dialog box,
102–103, 103
Edit Boundary option
ceilings, 94, 97
detail components, 163
floors, 68
Edit Color Scheme dialog box,
220–221, 220
Edit Extrusion tool
glazing, 176
hosted components, 175
Do Not Save The Project option, 254,
254
Do Nothing options, 360
Door tool, 23
doors
drafters role in BIM workflow,
334–335, 335
drag and drop families, 362–363
draw panel, 7, 8
elements in views, 276
creating, 270–275, 270–275
dimensions, 283–287, 283–287
editing, 163–166, 163–167
groups, 280–281, 281
hosted components, 173–174, 174
reference planes, 187, 187
walls, 16–20, 17–19, 284, 284
Disallow Join option, 363
Displace Elements feature, 237–238, 237–238
display filters
schedules
description, 302, 302
Sheet List, 310, 311
worksets, 251–252, 252
display modes for worksets, 260–262, 261–262
dividing lines, 317–318, 317
dividing models, 359
doors
curtain-grid segments, 60–61, 60
placing, 23
in walls, 40, 41
Doors And Windows setting, 20
double-click behavior, 360, 360
DPI setting, 239
drafters role in BIM workflow, 334–335, 335
drag and drop families, 362–363
draw panel, 7, 8
arcs, 87
Pick Lines icon, 17, 17
shapes, 269
slope arrows, 71
drawing sets
placing views, 313
floor plans, 313–319, 314–319
schedules, 319–320, 320
printing documents, 321–326, 322–323, 326
schedules. See schedules
duplicating
components, 256, 257
handrails, 100
materials, 229, 229
views, 231, 232
elements in views, 276
creating, 270–275, 270–275
dimensions, 283–287, 283–287
editing, 163–166, 163–167
groups, 280–281, 281
hosted components, 173–174, 174
reference planes, 187, 187
walls, 16–20, 17–19, 284, 284
Disallow Join option, 363
Displace Elements feature, 237–238, 237–238
display filters
schedules
description, 302, 302
Sheet List, 310, 311
worksets, 251–252, 252
display modes for worksets, 260–262, 261–262
dividing lines, 317–318, 317
dividing models, 359
Do Not Save The Project option, 254,
254
Do Nothing options, 360
Door tool, 23
doors
curtain-grid segments, 60–61, 60
placing, 23
in walls, 40, 41
Doors And Windows setting, 20
double-click behavior, 360, 360
DPI setting, 239
drafters role in BIM workflow,
334–335, 335
drag and drop families, 362–363
draw panel, 7, 8
arcs, 87
Pick Lines icon, 17, 17
shapes, 269
slope arrows, 71
drawing sets
placing views, 313
floor plans, 313–319, 314–319
schedules, 319–320, 320
printing documents, 321–326, 322–323, 326
schedules. See schedules
duplicating
components, 256, 257
handrails, 100
materials, 229, 229
views, 231, 232
Editing Request Placed dialog box, 263, 263
Editing Request Received dialog box, 263, 263
elements
aligning, 20–22, 20–23
arranging, 276
assigning to worksets, 250–253, 252
borrowing, 254–255, 260–261, 261
chains of
lines, 39, 40
selecting, 5, 14
walls, 80, 80
creating, 255–259, 256–259
editing requests, 262–265
types, 13–16, 14–16
wall, 40–41, 41
elevations
BIM models, 330
curtain walls, 56–57, 57
datums for, 11–12
entering, 190
presentation drawing, 231–234, 232–234
scales, 145, 145
elevators, 361, 362
eccentric walls, 37
embedding curtain walls, 55–56, 55
enabling worksharing, 244, 244
EQ setting
dimensions, 19
grid lines, 169
profile lines, 160
reference planes, 174
equal signs (=) in formulas, 186
errors and warnings, 345–347, 345–346
Esc key, 18–19
exploded views, 237–238, 237–238
exploding imported CAD files, 354–355
Export feature, 346
exporting
errors and warnings, 346, 346
to gbXML, 355
exposure in rendering, 239–240
Exposure Value setting, 239–240
extensions, handrail, 113
Exterior - Brick And CMU on Mtl. Stud wall, 33
Exterior - Brick on Mtl. Stud wall, 33
Exterior Elevation view, 173
Exterior worksets, 248
extruded roofs, 86–89, 87–88
Extrusion End setting, 87
extrusions, 195
F
face-based families
ing, 152, 153
working with, 138, 138
faces
floor area, 202
in-place masses, 199–201, 201
walls, 62–63, 62
families, 125
categories
assigning, 127–129, 128–129
editing, 152–153, 152–153
component, 132–133, 133
content, 139–141, 139–140
detail, 163–166, 163–167
face-based, 138, 138
hosted, 134–137, 135–137, 172–176, 172–176
in-place, 139
loading, 133–134, 134
detail level
display, 148–151, 148–150
editing, 143–145, 144–145
repeating, 167–168, 168
drag and drop, 362–363
ing, 158–159, 158
insertion points, 153–157, 154–157
legends, 293
model hierarchy, 125–127, 126
origins, 155–156, 155–156
parameters
categories, 153, 153
locking, 178
profiles, 159–162, 159–162
purging, 343–344, 343
repeating, 350
system, 130–132
templates, 178
tips and best practices, 177–178
title blocks, 168–171, 169–171
view display, 143–148, 146–147
Family Category And Parameters
dialog box, 128, 129, 153, 153
Family Editor, 128
balusters, 151
break lines, 163
desks, 155–156
filled regions, 178
hosted components, 172, 172
profiles, 159
Family Element Visibility Settings
dialog box, 148–149, 148–149
family types, swapping out, 104
Family Types dialog box
details, 166, 166
viewing, 175
fields and Fields tab
mass floors, 204, 204
schedules
Sheet List, 309, 310
windows, 306, 306
working with, 301, 301
File Save Options dialog box, 246, 246
files
central
avoiding, 265
creating, 246, 246
preparing, 244–245, 244–245
saving to, 253–255, 253–255
corrupted, 346
deleting and unloading, 354
exploding, 354–355
local
creating, 247–248, 247–248
saving, 247, 248
purging, 358, 358
saving, 244, 245
size, 342–345, 343
Fill available Space mode, 277
fill color, 219
color schemes, 221–222, 221–222
legends, 219–220, 220
sections, 222–223, 223–225
filled regions
adding, 271–272
boundaries, 271, 271
description, 269
title blocks, 178
Fillet Arc option, 38
Filter dialog box
walls, 9, 9
worksets, 251–252, 252
Filter tab
purpose, 302, 302
Sheet List, 310, 311
Filter tool, 250
filters
rooms, 218
schedules
description, 302, 302
Sheet List, 310, 311
selection behavior, 360, 360
wall selections, 9, 9
worksets, 251–252, 252
Fine detail level, 149
Finish Edit Mode button, 341
Finish Face setting, 20
Finish Mass tool, 202
Finish Sketch Mode option, 45
finishes, walls, 308, 308
Fixed Distance mode, 277
Fixed Number mode, 277
flushing, 275, 275
flexing reference planes, 177
flexing window types, 175
Floor Area field, 205
Floor Plan option, 12
Floor tool, 68, 80
floors
boundaries, 68–70, 69–70
floor plans, 313–319, 314–319
mass
creating, 202, 203
scheduling, 203–206, 204–206
openings
with shafts, 76–78, 77–79
by sketching, 74–76, 75–76
sketching, 67–68, 68
sloped
creating, 119, 119
shape editing for, 72–73, 73
sloped arrows, 70–72, 71–72
walls for, 80–81, 80
fonts
schedules, 304
text, 291
Formatting tab
mass floors, 205, 205
schedules, 303, 303, 306–307
formulas
calculations, 361, 361
errors and warnings, 346
height, 185–186, 186
foundation walls, 341
Frame/Mullion Extrusion option, 175
frames, windows, 175, 175
Function parameter, 17
Furniture tag, 158, 158
G
G000 Cover Sheet, 319–320, 321
gaps
floors, 70
railings, 118, 118
window sill, 272
Generic - 12" floor type, 67
Generic elements
designing with, 230, 232
railings, 100–103, 101–103
wall material properties,
228–231, 228–230
Geographic information system
(GIS) data, 332
geometric contexts, 152
glazing
BIM models, 332
windows, 176, 176
Gradient option, 233
Grand Totals option, 302
Graphic Display Options (GDO) dialog box, 231, 233–235, 233–234, 239
Graphical Column schedules, 298–300
graphics, 231
3D exploded view, 237–238, 237–238
presentation 3D isometric
drawing, 235–236, 235–236
presentation elevation drawing,
231–234, 232–234
rendering, 238–240, 239–240
shading, 229, 231
Graphics tab, 229, 231
grayed out views, 319
green dashed lines, 186
Grid Visibility parameter, 170–171, 171
grids
ceilings, 96, 96
curtain walls, 52, 52, 57–58, 58
datums for, 11
rotating, 96, 96
schedules, 304
title blocks, 168–171, 170–171
gross floor area, 206, 206
Group And Associate option, 26
Group Parameter Under option, 170
Group tool, 190, 259
groups
chairs, 25–26, 25–27
copying, 256, 257
creating, 190–192, 190–192,
258–259, 259
defined, 190
details, 280–281, 281
editing, 27–29, 28–29
and images, 192
purging, 343–344, 343
repeating, 350–351
schedules, 302, 303
grout, 278, 278
GWB on Mtl. Stud Ceiling, 92, 92
gypsum board
ceilings, 93
dimensions, 284
Gypsum Wall Board material, 93
H
Handrail - Design setting, 104, 113
handrails
creating, 100–103
profiles, 159–162, 161–162
height
ceilings, 97
formulas, 185–186, 186
images, 185–186, 186
masses, 194, 196
railings, 119
roofs, 83–84
windows, 306
Height field
images, 185–186, 186
window schedules, 306
Height Offset At Head setting
ceilings, 97
railings, 119
roofs, 83
Height Offset At Tail setting
ceilings, 97
railings, 119
roofs, 84
help, resources for, 365–366
Hidden Line mode, 323
Hidden Line option, 231
hidden lines
views, 323
walls, 231
hidden windows, 13
Hide Crop Boundaries option, 324
Hide Crop Region option, 234
Hide In View option, 232, 232
Hide Ref/Work planes option, 324
Hide Scope Boxes option, 324
Hide Unreferenced View tags option, 324
hierarchy, models, 125–127, 126
Highlight Displacement Sets tool, 5
Highlight In Model feature, 305
Home tab for walls, 131
Host Length option, 293
hosted components
editing, 172–176, 172–176
families, 134–137, 135–137
geometric contexts, 152
legends, 293
railings, 112–114, 113–114, 120, 120
wall elements, 40–41, 41
I
Image Placement tool, 183
images
background, 183–184, 183–184
and groups, 192
managing, 344
scaling, 184–187, 185–186
Import Instance option, 340
Import Panel, 183
imported data
exploding, 354–355
graphics, 141, 357
importing background images, 183–184, 183–184
In-Place Editor panel, 202
In-Place Masses tool, 193
Include Elements In Linked Files option, 301
inserting and Insert tab blocking, 274, 274
CAD files, 354
components, 269–270
families, 139–140
images, 183–184, 183–184
lights, 96
links, 339
insertion points for families, 153–157, 154–157
Inside component for repeating details, 167, 277
instance parameters, 43–44, 43
instances in model hierarchy, 126
Insulation tool, 280
Insulation tool, 280
interface, 2
Options Bar, 6, 6
Project Browser, 4–5, 4
Properties palette, 2–4, 3–4
status bar, 5, 5
View Control Bar, 5, 5
ViewCube, 5–6, 5
workflow, 6–7
datums, 11–13, 12–13
layout, 7–8, 8
modifying tools, 8–10, 9–10
Interior - Partition walls, 17
interior worksets, 248, 260, 260
iPad, 181–182, 182
isolating walls, 252, 252
isometric drawing, 235–236, 225–236
Itemize Every Instance option, 302, 306, 310
J
Jag Depth setting, 166, 166
join geometry for parallel walls, 363, 363
Join tool, 201
Join Geometry tool, 363
Join/Unjoin Roof option, 88
joined roofs, 88, 88
joining masses, 202
K
keyboard shortcuts, 362, 362
Keyboard Shortcuts dialog box, 362, 362
keynote legends, 292
Keynote tool, 275
keynoting, drafters for, 334
Khemlani, Lachmi, 365
L
L Shaped Handrail profile family, 159–162
labeling, 291, 291–292
landings, 107–110, 107–110
layers for basic walls, 32
layouts
creating, 7–8, 8
repeating details, 167, 277
Leader Arrowhead property, 290, 290
leaders
tags, 289, 290
text, 291
Legend Components settings, 293, 293
Legend tool, 292
legends
adding, 292–294, 293–294
color, 219–220, 220
length hosts, 293
walls, 42, 42
level railings, 118–121, 118–121
Level tool
sketches, 189
stairs, 110
levels
building pads, 341
datums for, 11–12
detail. See details and detail levels
objects, 135–136, 135
sketches, 186–190, 187–190
stairs, 110, 110
Lighting settings
graphics display, 234–235, 235
rendering, 239
lights, ceilings, 96, 96
Line Color option, 169
Line Style option, 272
Line Style panel, 269
Line Styles option, 216
Line Styles Type Selector panel, 282
Line tool, 273
lines
blocking, 273
detail, 268–269, 268
grid. See grids
hidden, 323
railings, 118, 118
ramps, 115
split, 72, 73
title blocks, 170
views, 317–318, 317
walls, 39, 40
Lines tool, 273
linework
description, 268–269, 268
working with, 281–282, 282
Linework tool, 281–282
linked files, associating, 265
links
annotations from, 364
CAD files, 354
copying objects from, 364, 364
managing, 344
repeating, 351–352
toposurfaces, 339
view, 324
Load Family dialog box, 133, 134, 139–140, 139
Load Family option, 61, 96, 154, 270
Load From Library panel, 61
Load Into Project button, 274
loading
component families, 133–134, 134
system families, 130–131, 131
local copies
limiting, 359
saving, 248, 248
local files, 247–248, 247–248
Location Line parameter, 43
Location Line to Finish Face setting, 17
Lock 3D View tool, 5
lock symbol, 19
locking
alignment, 22
dimensions, 19, 19
family parameters, 178
M
Make Plan View option, 11
Manage Images option, 344
Manage Links option, 344
Manage Project panel, 344
Manage tab
aligning elements, 20
errors and warnings, 345
printing, 323
purges, 343, 358
room separation lines, 216
title blocks, 170
views, 145
Masking Region tool, 272–273
masking regions, 178, 269, 272–273, 273
masonry, 32, 32, 276
mass floors
creating, 202, 203
scheduling, 203–206, 204–206
Mass Floors tool, 202
masses, 181
in-place, 193, 206–207
3D, 198–202, 199–201
base, 193–194, 193–195
middle, 195–197, 196–197
upper, 197–198, 198
joining, 202
massing studies, 206–207, 206–207
sketching, 195
Massing & Site tab, 193, 340–341
Material Editor, 229
Material Tag button, 288–289
Material tags, 289–290, 290
materials, 228
editing properties, 228–231, 228–230
takeoff schedules, 299
math, 361, 361
Maximum Spacing mode, 277
Measure tool, 184
measuring imported images, 184, 186
Medium detail level, 149
memory requirements
determining, 353
imported geometry, 357
metal decking, 276
middle mass modeling, 195–197, 196–197
Mirror - Pick Axis tool, 9
mirroring, 9–10, 10
mode, worksets, 260–262, 261–262
model groups, 281
Model In-Place option, 139
Model Site panel, 342
Model Updates option, 261
modelers in BIM workflow, 334
modeling
in-place masses, 193, 206–207
3D, 198–202, 199–201
base, 193–194, 193–195
middle, 195–197, 196–197
upper, 197–198, 198
sites, 337, 337
building pads, 340–341, 341
models
dividing, 359
hierarchy, 125–127, 126
Modify Create Roof Footprint tab, 81
Modify panel, 269
Modify Place Ceiling tab, 91
Modify tab, 3
aligning elements, 22
elevations, 11–12
groups, 280
levels, 190
linework, 282
mirroring, 9
railings, 112
splitting walls, 50
modifying tools, 8–10, 9–10, 16
aligned copying and group editing, 27–29, 28–29
aligning elements, 20–22, 20–23
dimensions, 16–20, 17–19
rotating, grouping, and arraying, 23–27, 24–27
walls, 41–42, 42
mouse, zooming and panning with, 11
moving
grid lines, 53, 54
ribbon, 363
tags, 224, 316, 316
walls, 214, 214
Mullion tool, 53, 53
mullions
adding, 53, 53–54, 57–58, 58
unpinning and toggling, 58–59, 59
Multi-Category schedules, 300
Multiple option, 25
multistory shafts, 76–78, 77–79
multistory stair runs, 110–112, 110–112
Multistory Top Level setting, 111
multiuser workflow. See worksharing

N
Name dialog box, 193, 193
names
handrails, 100
in-place masses, 193, 193
levels, 11
materials, 229
reference planes, 177
types, 257, 257
Navigation bar, 13, 144
New Family - Select Template File
dialog box, 127–128, 128
New Legend View dialog box, 292–293, 293
New Schedule dialog box
categories, 299, 300
mass floors, 204
settings, 305, 307
New Sheet dialog box, 311–312, 312
New Sheet option, 313
New Subcategory dialog box, 170
Note Block schedules, 299
number of views reductions, 344–345
numbering rooms, 213

O
object levels, 135–136, 135
Object Styles dialog box, 126–127,
126, 170, 170
objects
copying from links, 364, 364
deleting, 178
repeating, 349–352
Opaque/Transparent setting, 285
opening
projects, 7
worksets, 259–260, 260, 265
openings
floors
with shafts, 76–78, 77–79
by sketching, 74–76, 75–76
walls, 48–49, 48
operating systems, 352
optimizing performance, 352–355,
355
Options Bar, 6, 6
Options pane for printing, 324
Orient To View option, 361–362
orientation of families, 143
origin of families, 155–156, 155–156
Output Settings options, 239
overconstraining, problems from,
357
overlapping lines for railings, 118,
118
overlapping masses, 202
Override Graphics In View option,
236
Overwrite The Existing Version
option, 155
Owners tab, 262, 262
ownership status, 262, 262

P
panels
curtain-grid segments, 60–61, 60
curtain walls, 61–62, 62
panning with mouse, 11
parallel walls, join geometry for,
363, 363
Parameter Properties dialog box,
170, 170
parameters
families
categories, 153, 153
locking, 178
reference planes, 174
title blocks, 170–171, 170
walls, 43–44, 43
parametric models, 329
parking spaces, 337
Paste command, 28, 28
Paste tool, 76
performance, optimizing, 352–355,
355
perspectives in BIM models, 330
Phillips Place model, 346–347, 346
Pick Lines mode, 17, 17
Pick Lines tool, 17, 39
Pick New Host tool, 112–114, 120
Pick Wall tool, 80
Pick Walls option, 81
picking walls, 39, 40
pinned mullions, 58–59
Place A Component option, 154
Place Component menu, 154
Place Detail Component tab, 270
Place Detail Group button, 281
Place Detail Lines menu, 317
Place Request button, 263
placing
blocking, 274, 274
desks and chairs, 23–27, 24–27,
258–259, 258–259
system families, 131–132
views on sheets, 313
floor plans, 313–319, 314–319
schedules, 319–320, 320
Plan Views option, 12
plans in BIM models, 330
polylines for toposurfaces, 338
predictability in BIM models, 333
presentation drawings
3D isometric, 235–236, 235–236
elevation, 231–234, 222–234
Print command, 321
Print dialog box, 321–322
hidden lines, 323
Options pane, 324
Print Range, 325–326
zooming, 324
Print Range setting, 322
Print Setup dialog box, 322–325, 323
Printer control panel, 322
profiles
elevation, 56–57, 57
families
component, 133, 133
editing, 159–162, 159–162
walls, 44–45, 46–47
Project Browser, 4–5, 4
project roles in BIM workflow, 332–336, 335
projects
in model hierarchy, 125
opening, 7
Properties palette, 2–4, 3–4
building pads, 341
constraints, 15
crop windows, 288
dimensions, 70, 185–186, 285
grids, 170
groups, 281
levels, 11
offsets, 17
railings, 162, 162
regions, 271
repeated detail, 278
selected walls, 14, 14
slopes, 86
stairs, 111
tags, 290
Type Selector, 7, 16
View Control Bar, 5
wall material properties, 228–229
walls, 13–14, 14, 50, 82
windows, 176
worksets, 251
Purge Unused dialog box, 343, 343, 358
Purge Unused tool, 343–344, 358
purging
families and groups, 343–344, 343
files, 358, 358
Q
quality settings, rendering, 239
Quick Access toolbar (QAT), 7
3D views, 198
dimensions, 283
hidden windows, 13
measurements, 184
R
Rail Structure option, 161
Railing tool, 100
railings
editing, 121, 121
generic, 100–103, 101–103
host function, 112–114, 113–114, 120, 120
level and sloped conditions, 118–121, 118–121
profiles, 159–162, 161–162
Railings Type option, 104
RAM requirements
determining, 353
imported geometry, 357
Ramp tool, 114
ramps, 114
boundary conditions, 116–117, 117
straight runs, 115–116, 115–116
raster processing, 323
Realistic mode, 323
Rectangle tool, 193
Rectangular Handrail family, 159
Ref Plane tool, 186
reference planes
creating, 191–192, 191–192
datums for, 11
hosted components, 173–174, 174
names, 177
sketches, 186–190, 187–190
regions, 269
filled, 178
adding, 271–272
boundaries, 271, 271
description, 269
masking, 178, 272–273, 273
Relinquish All Mine option, 254
relinquishing elements and worksets,
254–255, 254–255
Reload Latest option, 254
renaming
materials, 229
types, 257, 257
Rendering dialog box, 239
rendering graphics, 238–240,
239–240
rendering Show/Hide tool, 5
Repeating Detail command, 279
Repeating Detail Component tool,
276, 279
repeating details
creating, 276–280, 277–279
editing, 167–168, 168
rules of thumb, 357
repeating objects, 349–352
repetition in families, 141
replacing rooms, 218
Reset Profile option, 47
resetting wall profiles, 47
resolution in rendering, 239
resources, Revit, 365–366
Restore Excluded Group Member
option, 351
Reveal Hidden Elements tool,
5, 232
Review Warnings dialog box,
345–346, 345
Revit Architecture links
annotations from, 364
copying objects from, 364, 364
repeating, 351–352
Revit Architecture WikiHelp, 365
Revit Autodesk Products heading,
352
Revit Forum, 365
ribbon, 2
moving, 363
schedule commands, 304–305,
305
Roof By Extrusion option, 81, 86
Roof By Footprint option, 81
Roof tool, 81
roofs
extruded, 86–89, 87–88
masses for hosting, 208
sloped arrows, 82–86, 83–86
walls for, 81–82, 82
Room & Area panel
  calculations, 209
  room tags, 211
  separation lines, 216
Room Bounding parameter, 44, 213
Room Separator option, 216
Room Tag option, 223
Room Tag With Area option, 212, 212
Room tool, 211
  rooms
    boundaries, 213–214, 214–215
color fill plans, 219
color schemes, 221–222, 221–222
  legends, 219–220, 220
sections, 222–225, 223–225
defining, 209–210
deleting, 217–219, 218–219
numbering, 213, 364
replacing, 218
  schedules, 307–309, 308–309
separation lines, 215–216, 215–217
tags, 210–212, 211–212
Rotate tool, 23, 26, 26, 29, 29, 96
  rotating elements, 23–27, 24–27
grids, 96, 96

S
saving
to central file, 253–255, 253–255
files, 244, 245
local copies, 247, 248
print settings, 326
Scale tool, 5
  scales and scaling
elevation, 145, 145
families, 143
images, 184–187, 185–186
rules of thumb, 357
stairs runs, 146, 147
views, 145–148
Schedule Properties dialog box
  Appearance tab, 304, 304
  Fields tab, 300–301, 301
  Filter tab, 302, 302
  Formatting tab, 303, 303
mass floors, 204–206, 204–205
rooms, 307–308
  Sorting/Grouping tab, 302, 303
  windows, 306–307
Schedule/Quantity button, 305
Schedule/Quantity schedules, 298–300
  Schedule tab, 305, 305
schedules, 297
  adding to sheets, 319–320, 320
BIM models, 330
  breaking, 320
categories, 299–300
drafters for, 334
elements, 302
errors and warnings, 346
mass floors, 203–206, 204–206
  ribbon command, 304–305, 305
rooms, 307–309, 308–309
  sheet list, 309–312, 310–312
types, 300
windows, 305–307, 306
  schematic design, 181
drafters for, 335
in-place masses, 193
  3D, 198–202, 199–201
base, 193–194, 193–195
middle, 195–197, 196–197
upper, 197–198, 198
mass floors, 202–206, 203–206
massing studies, 206–207, 206–207
  sketches. See sketches
schemes, color, 221–222, 221–222
section boxes, 28, 28
  Section tool, 222
sections
  BIM models, 330
  fill color and tags, 222–225, 223–225
segments, curtain-grid, 60–61, 60
Select All Instances option, 354
Select Items To Copy dialog box, 131, 131
Select Levels dialog box, 28, 28
Select Pinned Elements option, 187
Selected Views/Sheets option, 325
selections, filtering, 360, 360
Send Backward option, 276
Send To Back option, 276
  separation lines, 215–216, 215–217
Set Host function, 116
Shaded mode, 323
Shading property, 229, 231
shadows in graphics display, 233–235, 234
Shadows tool, 5
  shafts
    elevators, 361
  floor openings with, 76–78, 77–79
  shape editing for sloped floors, 72–73, 73
Shape Editing tools, 72
  shape handles
    editing, 73, 73
    walls, 42, 42
Sheet List Properties dialog box, 309–311, 310–311
Sheet List schedules, 299, 309–312, 310–312
  Sheet Name, sorting by, 302
  Sheet Number, sorting by, 302
  sheetrock, 271
  sheets
    drafters for, 334–335
    placing views on, 313
    floor plans, 313–319, 314–319
    schedules, 319–320, 320
shifting room numbers, 364
shortcuts, keyboard, 362, 362
  Show Ambient Shadows option, 233, 235
Show Analytical Model tool, 5
  Show Camera option, 363
  Show/Hide Crop tool, 5
  Show Mass option, 193
  shrubs, 337, 337
  Simplify Surface button, 340
site modeling, 330, 337
  building pads, 340–341, 341
Site Settings dialog box, 342, 342
  64-bit OS, 352
  size
    files, 342–345, 343
    schedule text, 304
Sketch mode for roofs, 83–84
Sketch Path tool, 113, 120
SketchBook Pro tool, 181–182, 182
sketches, 181–182, 182
background images, 183–184, 183–184
ceilings, 91–93, 91–93
floors
creating, 67–68, 68
openings, 74–76, 75–76
groups, 190–192, 190–192
masses, 195
reference planes and levels, 186–190, 187–190
scaling images, 184–187, 185–186
walls, 37–38, 39
Slope Arrow tool, 71, 71, 119
slope arrows
building pads, 340
ceilings, 97, 97
floors, 70–72, 71–72, 119
roofs, 82–86, 83–86
sloped ceilings, 97, 97
sloped floors
creating, 119, 119
shape editing for, 72–73, 73
sloped railings, 118–121, 118–121
sloped roofs
adding to walls, 81–82, 82
sloped arrows, 82–86, 83–86
snapping, 8
solar gain in BIM models, 332
Sort By setting, 204
Sorting/Grouping tab
mass floors, 204
schedules
creating, 306
settings, 302, 303
Sheet List, 310
Sound Transmission Class (STC), 292
Spacing component, repeating
details, 167
Spacing option, 278
spacing repeated details, 278
Specialty Equipment option, 153
Split Element tool, 50, 50
split lines, 72, 73
splitting walls, 49–50, 50
stacked walls, 34–35, 35
staffing BIM projects, 332
Stair by Component tool, 103, 105–106, 106, 109
Stair by Sketch tool, 103–104, 106–107
stairs, 99
balusters
ing, 102–103, 103, 159, 160
level of detail, 147, 151
level of detail, 151
multistory runs, 110–112, 110–112
railings
generic, 100–103, 101–103
host function, 112–114, 113–114
scaling, 146, 147
straight run, 104–107, 104–107
straight run with landing, 107–110, 107–110
status, ownership, 262, 262
status bar, 5, 5
Storefront curtain walls, 55
straight run ramps, 115–116, 115–116
straight run stairs, 104–107, 104–107
straight run with landing stairs, 107–110, 107–110
strings, dimension, 283–285
subscription support, 365
Sun Path tool, 5
Sun setting, 235
Sun Settings dialog, 239, 239
Surface Pattern setting, 236, 236
Surface Transparency setting, 236, 236
swapping out family types, 104
swapping walls, 50, 51
Switch Windows command, 12–13, 13
symbols for component families, 133
Synchronize And Modify Settings option, 253
Synchronize Now option, 254
Synchronize panel, 253
Synchronize With Central dialog box, 253, 253
system families, 129–130
loading, 130–131, 131
placing, 131–132
System Requirements option, 352
T
Tab key for wall references, 18, 18
tables, placing, 257, 258
Tag All Not Tagged dialog box, 223, 224
Tag All Not Tagged option, 223
Tag All option, 223
Tag By Category option, 288
Tag On Placement button, 41
tags
adding, 288–290, 288–290
component families, 132
moving, 224
rooms, 210–212, 211–212
sections, 222–225, 223–225
text in, 315
Tangent Arc tool, 117
tangent arcs
creating, 38, 39
ramps, 117
teams, BIM, 336
templates, families, 178
Temporary Dimension Properties, 20, 20
temporary dimensions
curtain walls, 53
setting, 20, 20–22
Temporary Hide/Isolate tool, 5
Temporary View Templates tool, 5
text
adding, 291, 291–292
dimensions, 283–287, 283–287
schedules, 304
tags, 315
Text panel, 291
Text tab, 291
Text tool, 291
thickness of building pads, 340
30 Degree Arrow option, 290
3D Cover Shot option, 239
3D isometric drawing, 235–236, 233–236
3D views, 7
3D Cutaway, 28, 28
copying, 363
exploded, 237–238, 237–238
in-place masses, 198–202, 199–201
3D Views node, 239
tiled windows, 13–15, 14–15
title blocks, 168–171, 169–171
toggling mullions, 58–59, 59
top and base of walls, 45–47, 46–47
Top Constraint parameter
roof, 82
walls, 15, 15, 44
Top Is Attached parameter, 44
Top Offset setting
shafts, 78
walls, 44
Transfer Project Standards command, 130, 323
transparent backgrounds for dimensions, 285
trees, 337, 337
Trim tool, 8–9
Trim/Extend To Corner tool, 10, 10
Trimble SketchUp tool, 333–334
Type field, 306
Type Mark field, 306
Type Properties dialog box
ceilings, 93
dimensions, 285
elements, 257–258, 257
grids, 171, 171
railings, 100–101, 101, 161
regions, 271
repeating details, 167, 168, 276–278, 277
walls, 32–33, 32–33, 228
Type Selector, 3, 7
blocking, 274
ceiling, 97
desks, 154
details, 270
groups, 281
lights, 96
linework, 282
walls, 16
types
model hierarchy, 126
schedules, 298–300
U
Unconnected Height parameter, 44, 94
Unjoin Walls option, 16
unloading unused CAD files, 354
unpinning mullions, 58–59, 59
unreferenced view tags, 324
unused families and groups, 343–344, 343
unused files, 358, 358
updating massing studies, 206–207, 206–207
upper mass modeling, 197–198, 198
Use Render Appearance option, 231
User Interface tab, 362
V
vector processing, 323
vehicles, 337
vertices for in-place masses, 200, 201
View Control Bar icons, 5, 5
walls, 231
View Links in Blue option, 324
View List schedules, 299
View option, 293
View/Sheet Set dialog box, 325–326, 326
ViewCube, 5–6, 6
floor plans, 95
Orient To View, 362
rotating, 200
views and View tab, 2, 2
activating, 318, 318
arranging elements in, 276
deactivating, 319
depth, 356
displaying, 7
drafters for, 334–335
duplicating, 231, 222
families, 143–148, 144–147
hidden views, 353
hidden windows, 13
legends, 292–294
limiting, 344–345
lines, 317–318, 317
managing, 353–354
mass floors, 204
placing on sheets, 313
floor plans, 313–319, 314–319
schedules, 319–320, 320
Plan Views, 12
properties, 3
vs. reference levels, 189, 189
schedules, 298, 305, 308
sections, 222
tags, 316–317, 316
tiled windows, 13–14
visibility, 250
visibility and Visibility/Graphic Overrides dialog box
balusters, 151
elevators, 361, 362
family profiles, 159, 159
grids, 170
hosted components, 172, 173
layers, 354
links, 364
print ranges, 326
Revit links, 352
room properties, 213, 213
room separation lines, 216
shortcuts, 362
worksets, 249–250, 250, 252, 253, 262, 262
Visibility/Graphics dialog box, 126–127
Visibility Setting column, 250
Visible portion Of Current Window option, 326
Visual Style tool, 5
volume computation, 209–210, 210, 355, 355
W
Wall Centerlines setting, 18
Wall Opening option, 48
wall studs, 276
Wall tool, 7–8, 17, 20, 37
walls
basic, 32–34, 32–34
chain-select method, 13–14
closure options, 177, 177
constraints, 15, 15, 44
curtain. See curtain walls
dimensions, 16–20, 17–19, 284, 264
editing material properties, 228–231, 228–230
eccentric, 37
faces for, 62–63, 62
finishes, 308, 308
for floors, 80–81, 80
walls (continued)
   foundation, 341
graphics. See graphics
   height, 82, 82
hosting elements, 40–41, 41
   instance parameters, 43–44, 43
isolating, 252, 252
join geometry, 363, 363
   legends, 292–294, 294
masses for hosting, 208
   modifying, 41–42, 42
moving, 214, 214
openings, 48–49, 48
   overview, 31
picking, 39, 40
placing, 7–8, 9, 17
profiles, 44–45, 46–47
   for roofs, 81–82, 82
shape handles, 42, 42
sketching, 37–38, 39
splitting, 49–50, 50
stacked, 34–35, 35
swapping, 50, 51
top and base, 45–47, 46–47
type changes, 16, 16
Walls tab
   openings, 48
   profiles, 47
warnings
   ceilings, 90
   finding, 345–347, 345–346
tags, 288, 288
Warnings tool, 345
Wide Lines option, 317
width settings
   family profiles, 160
   insulation, 280, 280
   window schedules, 306
window sill
   creating, 270–275, 270–275
dimensions, 284–286, 286
   repeating details, 279, 279
Window tags, 288, 288
windows
   frames, 175, 175
glazing, 176, 176
   schedules
      adding to sheets, 319–320, 320
      creating, 305–307, 306
tiled, 13–15, 14–15
   in walls, 40, 41
Wireframe button, 196
Wireframe mode, 323
wireframes, 196, 196
witness lines, 283–284
work plane editing, 177
Work Plane panel, 186, 186
workflow
   BIM, 329
      overview, 329–332, 330–331
      project roles, 332–336, 335
      staffing, 332
      team members, 336
   interface, 6–7
      datums, 11–13, 12–13
      layout, 7–8, 8
      modifying tools, 8–10, 9–10
   working views, 344–345
worksets and Worksets dialog box
   adding, 248–249, 249–250
   assigning elements to, 250–253, 251–253
   borrowed elements, 261, 261
   as containers, 264
   display modes, 260–262, 261–262
   opening and closing, 259–260, 260, 265
ownership status, 262, 262
   settings, 244, 245
   visibility, 249–250, 250
Worksets option, 261
Worksets palette, 244
workshared files, 359
worksharing, 243
   best practices, 264–265
   central files
      avoiding, 265
      creating, 246, 246
      saving to, 253–255, 253–255
   display modes, 260–262, 261–262
   editing requests, 263–264, 263–264
   elements, 255–259, 256–259
   enabling, 244, 244
   local files
      creating, 247–248, 247–248
      saving, 247, 248
worksets. See worksets and
   Worksets dialog box
   Worksharing dialog box, 245, 245
   Worksharing Display Off option, 261
   Worksharing Display Settings dialog box, 261, 261

Y
   YouTube, 365

Z
   zero error requirements, 347
   Zoom All To Fit option, 13, 14
   Zoom Sheet Size option, 144, 144
   Zoom To Fit option, 144, 144
   zooming
      with mouse, 11
      printing, 324